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Chapter 1
Using this Guide
Who Should Read this Guide
This guide is written for all those who are attending Blackboard Collaborate web conferencing
sessions – Participants.
Blackboard CollaborateParticipants need not be computer experts, however, some functions do
require basic computer skills such as working knowledge of your operating system, ability to
navigate between and within applications, or basic text editing.
Note: Users who make use of the accessibility features in Blackboard
Collaborate web conferencing should refer to the Accessibility Guide for
Participants.

How to Use this Guide
It is highly recommend that you read the first three chapters of this guide prior to attending a
Blackboard Collaborate web conferencing session.
1. Read Conventions Used in this Guide on page 3 of this chapter to familiarize yourself with
the various presentation, formatting and typographical conventions used in this guide.
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2. Follow the instructions in Getting Started on page 7 to ensure you have the proper hardware and software to run Blackboard Collaborate and to set up your Blackboard Collaborate environment.
3. Read The Blackboard Collaborate Web Conferencing Room on page 25 to familiarize
yourself with the Blackboard Collaborate user interface.
Refer to the remaining chapters in any order to become familiar with the available tools and
features of Blackboard Collaborate.
Note: For a discussion of the accessibility features in Blackboard
Collaborate web conferencing, including Closed-Captioning and the
Activity Window, see the Accessibility Guide for Participants.

Getting Help
Documentation and Learning Resources
Documentation and learning resources (for all Blackboard Collaborate products) are available on
the On-Demand Learning Center, which can be reached as follows:
o

In your browser, enter the following address:
http://www.blackboard.com/Platforms/Collaborate/Services/On-Demand-Learning-Center.aspx

o

From within Blackboard Collaborate web conferencing, select Additional Documentation
from the Help menu.

You can directly open the following documents from within Blackboard Collaborate web
conferencing by selecting them from the Help menu:

2

n

Keyboard Shortcuts

n

Accessibility Guide for Participants

n

Blackboard Collaborate Essentials for Participants

Using this Guide

Technical Support
Blackboard Collaborate technical support and the support Knowledge Base are available through
the Support Portal:
http://support.blackboardcollaborate.com

Community
We encourage Blackboard Collaborate users of all levels (administrators, instructors and
students) to submit questions to Ask the Doctors, a free question-and-answer forum
moderated by an expert team of your fellow Blackboard Collaborate users. Their goal is to
provide quality answers to your questions in a highly responsive manner, while building a global
knowledge base for online teaching and learning.
You can find Ask the Doctors at the link below:
http://discussions.blackboard.com/forums/default.aspx?GroupID=9
Messages posted in the Ask the Doctors forum do not go to our Support Team. If you require
technical support assistance to resolve a problem, please contact Technical Support (see the
headingTechnical Support in this section).

Blackboard Collaborate Product Feedback
Blackboard Collaborate welcomes your comments and suggestions. If you have an idea for a new
feature or enhancement, or would like to send other feedback, please send an email to
BBCollaborateFeedback@blackboard.com.
Your feedback will be sent directly to our Product Management Team.

Conventions Used in this Guide
Variables
There are a few places in Blackboard Collaborate web conferencing that are populated with data
specific to the session. Because we do not know in advance what those data (e.g., words or
names) will be, in this guide they are represented by variables enclosed in angle brackets. For
example, the variable <Panel Name> is used in the discussion of Restoring Default Preference
Settings to represent the name of the currently selected panel.

Using this Guide
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Notes
Six types of notes may be used in this guide to highlight information:
Note: Notes are used to highlight important information or to present
asides relevant to the topic at hand.

Tip: Tips provide helpful information on how to most effectively use a
particular feature of the product.

Caution: Cautions alert you to potentially confusing terminology or
difficulties that may occur when using the product.

Warning: Warnings alert you to potentially serious problems.

Notes of this format are used to highlight Linux-specific information.

Notes of this format are used to highlight Mac-specific information.

Notes of this format are used to highlight information specific to mobile
devices (mobile phones and tablets).

Typographical Conventions
Convention

Description

1. Number

Indicates a step in a task.

o

Hollow bullets

Indicates that there are several options available for completing a task, but
only one is necessary.

Bold

Represents clickable elements in the user interface (e.g., text links, buttons, tabs, etc.). Also used to give emphasis to words.

Italics

Represents menu items, options and parameters. Also used for cross references and names of documents.

Monospace

Indicates pathnames, filenames, folders and command lines.

<brackets>

Indicates variables.
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Operating System Differences
This guide is written for Blackboard Collaborate web conferencing users on all supported
operating systems: Windows, Mac OS X, and Linux.

Keystrokes and Mouse Clicks

The same keystrokes and mouse clicks are used on Windows and Linux platforms. Those used
on Mac OS X are different. This guide gives instructions for users of all supported operating
systems. The Windows/Linux keystrokes or mouse clicks are given first, followed by those for
Mac OS X (in parentheses):
Mouse Click Example
Select the object and then right-click (Control-Click on Mac) anywhere on the Whiteboard to
display the context menu.
Keystroke Example
Select the object(s) in the Whiteboard or in the Object Explorer and then enter Ctrl+X
(Command-X on Mac) to cut the object(s).

Screen Captures

Most screen captures shown in this guide were taken in a Windows environment. If you are
running Blackboard Collaborate web conferencing on a Mac OS X or Linux platform, the
appearance of windows, dialog boxes, etc. will differ slightly from those shown in this guide.

Using this Guide
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Chapter 2
Getting Started
There are a few things you should do before you participate in a session:
1. Ensure your computer meets the minimum system requirements recommended for running a Blackboard Collaborate web conferencing session on your computer. See Minimum
Client System Requirements on page 8.
2. Launch into a private Blackboard Collaborate web conferencing session where you can
familiarize yourself with the Whiteboard tools or create or review presentations and/or
quizzes prior to joining your scheduled session. (For instructions on launching a private
session, see Launching an Offline Blackboard Collaborate Web Conferencing Session on
page 21.)
3. Join a Blackboard Collaborate web conferencing session. You may join a session either
through an email link sent to you by your organization or via a link on a web page. The
method by which you join a session will vary depending on your organization. See Joining
a Blackboard Collaborate Web Conferencing Session on page 8.
4. Once you have successfully launched into a Blackboard Collaborate web conferencing session, run the Audio Setup Wizard (see Using the Audio Setup Wizard on page 97) and set
your proxy settings (see Setting Your Proxy Configuration on page 14). You may also want
to set other preferences, such as your connection speed (see Setting Your Preferences on
page 8).

Page 7

Minimum Client System Requirements
Before you can get started in a Blackboard Collaborate web conferencing session, you should
ensure that your computer is able to support the needs of the collaboration environment.
Tip: For Linux and Mac OS X 10.4 and earlier users, we strongly
recommend that you use a headset (or at least headphones or an echo
canceling microphone) rather than speakers when using simultaneous
talkers. This will eliminate potential echoing and feedback and improve
your audio experience.
Please read the minimum system requirements listed on the Support website:
support.blackboardcollaborate.com/ics/support/default.asp?deptID=8336&task=knowledge&questionID=1443

Joining a Blackboard Collaborate Web Conferencing Session
How you join a Blackboard Collaborate web conferencing session varies depending on the
organization hosting the Blackboard Collaborate web conferencing session. Follow the
instructions provided by the organization hosting your session.
Your System Administrator or Moderator should provide you with the following information:
l

How to access your Blackboard Collaborate web conferencing sessions.

l

Your username and password (if applicable).

l

How to access your recordings.

l

Who to contact for help and where to access the user guides and other resource material
for your system.

Setting Your Preferences
Although it is not necessary, you may want to set some of your application preferences before
you begin your session. You can do so through the Preferences dialog. Preferences are set for
each user account on a computer. Once set, they are used for all sessions connected to by that
user from that computer.
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Open the Preferences dialog in one of the following ways:
o

From the Edit menu, select Preferences… (Windows & Linux)
From the Blackboard Collaborate web conferencing menu, select Preferences
(Mac OS X)

o

Enter Ctrl+Comma (Windows & Linux)
Enter Command-Comma (Mac OS X)

Instructions for setting preferences are dispersed throughout this guide:
Preference(s)

Location in Guide

Connection Speed

Setting Your Connection Speed on page 12

Proxy Configuration Setting Your Proxy Configuration on page 14
Notifications

Setting Notification Preferences on page 17

Hot Keys

Configuring Hot Keys on page 41

User Profile

User Profiles on page 60

Application Sharing Advanced Application Sharing Options on page 183
Audio

Advanced Audio Configuration on page 101

Video

Selecting your Video Camera on page 74

Preferences Dialog Components
The Preferences dialog is organized into two main areas: the Preferences list on the left and the
Preferences panels on the right. The Preferences list contains a list of modules and their
associated panels organized into a tree structure (in alphabetical order). The panel that is
selected in the Preferences list will be displayed in the Preferences panels area on the right.

Getting Started
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1 Preferences list

3 Modules

2 Preference panels

4 Panels

Note: If you select a module (rather than one of the panels beneath it),
the topmost panel associated with that module will be displayed in the
Preferences panels area.
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Navigating Within the Preferences List
You can move between modules and panels in the Preferences list using the arrow keys or by
simply clicking on a desired module or panel.
You also can collapse and expand the list of panels beneath a module by clicking on the
disclosure buttons.

1 Expand disclosure button
2 Collapse disclosure button

Restoring Default Preference Settings
If you are unsure about the preferences you set and want to start over, you can revert back to
the default (factory) settings. The restoration can be done at an application level, module level or
panel level by selecting an option from the Restore Defaults menu.
l

l

l

To restore defaults for the entire Blackboard Collaborate
web conferencing application, select Restore All Modules.
To restore defaults for all panels within a specific module,
select the module in the Preferences list and then select
Restore Module <Module Name> from the Restore Defaults
menu.
To restore defaults for a single panel only, select the panel in the Preferences list and then
select Restore Panel <Panel Name> from the Restore Defaults menu.

Resizing and Moving the Preferences Dialog
You can move the Preferences dialog by dragging its title bar. You also can resize it. If the
Preferences panel is too large to fit in the right side of the Preferences dialog, scroll bars will
appear so you can move within the panel.
The next time you open the Preferences dialog, it will be located in the same place and be of the
same size as when you last opened it. The panel you last worked in will be displayed.

Getting Started
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Setting Your Connection Speed
Blackboard Collaborate is designed to ensure that you are always experiencing a session
synchronized with all participants, live in real time. To do this, Blackboard Collaborate matches
the rate at which the server sends information to you with the setting you chose for connection
speed. (See the Knowledge Base article 1551 to learn more about the importance of setting the
correct connection speed.)
The first time you join a session, the Select Connection Speed dialog appears, prompting you to
select the connection speed that you will be using. After you exit the session, the connection
speed is automatically saved with the preferences.
Note: You can quickly see what your current connection speed is by
viewing it under the Information menu. See Getting Session Connection
Information on page 43.
Another way to set your connection speed is through the Preferences dialog. You may do this in
an offline session (see Launching an Offline Blackboard Collaborate Web Conferencing Session
on page 21) or anytime within a live session.
Configure your connection speed in the Preferences dialog.
1. Open the Preferences dialog in one of the following ways:
o

From the Edit menu, select Preferences… (Windows & Linux)
From the Blackboard Collaborate web conferencing menu, select Preferences
(Mac OS X)

o

Enter Ctrl+Comma (Windows & Linux)
Enter Command-Comma (Mac OS X)

2. In the left pane of the Preferences dialog, select Connection under Session. The
Connection preferences panel appears.

12
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3. From the list of Connection Speed options, select the modem or line speed that your
computer is using to connect to the Blackboard Collaborate web conferencing Server. In
most cases, this means your Internet connection speed.
Warning: Setting the incorrect connection speed (either higher or
lower) may result in poor performance.

Select

If your connection is …

28.8K Dialup 28.8K modem
33.6K Dialup 33.6K modem
56K Dialup

56K modem

ISDN

High-speed dedicated telephone connection

Wireless

Wireless connection

Cable/DSL

High-speed cable connection or Digital Subscriber Line

LAN

Local Area Network

4. Click on OK to save your preferences and close the Preferences dialog, Apply to save
your preferences and leave the Preferences dialog open or Cancel to close the Preference
dialog without saving any of your changes.
When you configure preferences, Blackboard Collaborate web conferencing will remember the
settings each time you join another session on the same computer.
Note: You can restore your preference settings to the default. For details
on restoring default preferences, see Restoring Default Preference
Settings on page 11.

Prompting for the Connection Speed
Because your connection speed settings are saved for the next time you log in, you may find the
appearance of the Select connection speed dialog box to be unnecessary. We have provided an
option where you can decide whether you would like this dialog box to appear, never appear, or
appear only when the location changes (that is, your IP Address changes).
Configure your connection speed prompt in the Preferences dialog.
1. Open the Preferences dialog in one of the following ways:
o

From the Edit menu, select Preferences… (Windows & Linux)
From the Blackboard Collaborate web conferencing menu, select Preferences
(Mac OS X)

Getting Started
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o

Enter Ctrl+Comma (Windows & Linux)
Enter Command-Comma (Mac OS X)

2. In the left pane of the Preferences dialog, select Connection under Session. The
Connection preferences panel appears.

3. From the list of Prompt for speed options, select your desired option.
4. Click on OK to save your preferences and close the Preferences dialog, Apply to save
your preferences and leave the Preferences dialog open or Cancel to close the Preference
dialog without saving any of your changes.
When you configure preferences, Blackboard Collaborate web conferencing will remember the
settings each time you join another session on the same computer.
Note: You can restore your preference settings to the default. For details
on restoring default preferences, see Restoring Default Preference
Settings on page 11.

Setting Your Proxy Configuration
If you are connecting through an Internet firewall, which is set up to block both outbound and
inbound connections and web browsing that is done through an HTTP or HTTPS proxy server,
you may have to change the Proxy Settings preference in Blackboard Collaborate web
conferencing
By default, Blackboard Collaborate inherits the same proxy settings as the browser it was
launched through. If Blackboard Collaborate is unable to automatically detect the proxy settings
it will be unable to connect to the Session. In this case, you may be able to start Blackboard
Collaborate web conferencing but not be able to join a session.
If Blackboard Collaborate encounters a proxy configuration error, it will return a Connection
failed error message similar to the one below.
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If this happens, you may have to change your Proxy Settings to enable Blackboard Collaborate
web conferencing to communicate with your proxy server.
Note: Ask your System Administrator to provide you with the necessary
proxy server information.
To Configure your Proxy Settings in the Preferences:
1. Open the Preferences dialog in one of the following ways:
o

From the Edit menu, select Preferences… (Windows & Linux)
From the Blackboard Collaborate web conferencing menu, select Preferences
(Mac OS X)

o

Enter Ctrl+Comma (Windows & Linux)
Enter Command-Comma (Mac OS X)

Getting Started

15

2. In the left pane of the Preferences dialog, select Proxy Settings under General. The Proxy
Settings preferences panel appears.

3. Select the desired Method option from the Method drop-down list. The choices are the
following:
n

Proxy Settings From Launcher (<proxy setting>) – Blackboard Collaborate uses the
connection settings from Java Web Start. If manual proxy settings are not provided
to Java Web Start, it will attempt to detect these settings on its own and then pass
the results to Blackboard Collaborate This is the default proxy setting and should be
changed only if you are unable to establish a reliable connection.
Note: <proxy setting> will be whichever type of proxy setting
is detected by the launcher.

n

n

SOCKS V4/V5 Proxy Server – Specifies that a version 4 SOCKS proxy server is to be
used.

n

HTTPS Proxy Server – Specifies that a secure HTTPS proxy server is to be used.

n

HTTP Proxy Server – Specifies that an HTTP proxy server is to be used.

n
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Direct Connection – Specifies that no proxy server is to be used. Blackboard Collaborate web conferencing will connect directly to the appropriate server.

HTTP Proxy Server (Half-Duplex) – Specifies that an HTTP proxy server is to be
used in reduced bandwidth half duplex mode. Use this option only if you have an
HTTP proxy server and you are unable to establish a reliable connection with the
previous setting.

Getting Started

n

n

HTTP Direct – Specifies that Blackboard Collaborate web conferencing is to connect directly to the server with the HTTP protocol. While this is similar to a direct
connection, the use of the HTTP protocol may reduce performance and should be
used only if a normal direct connection is not possible.
HTTP Direct (Half-Duplex) – Specifies that Blackboard Collaborate web conferencing is to connect directly to the server with the HTTP protocol in a reduced
bandwidth half duplex mode. Use this option only if you require an HTTP direct connection and are unable to establish a reliable connection with the previous setting.

4. Enter your proxy server IP address in the Server field and enter your proxy serverport
number in the Port field. (You may have to ask your System Administrator to provide you
with this information.)
Note: For more information on proxy configuration, visit the
Knowledge Base (http://support.blackboardcollaborate.com) and
search for "proxy".
5. Click on OK to save your preferences and close the Preferences dialog, Apply to save
your preferences and leave the Preferences dialog open or Cancel to close the Preference
dialog without saving any of your changes.
When you configure preferences, Blackboard Collaborate web conferencing will remember the
settings each time you join another session on the same computer.
Note: You can restore your preference settings to the default. For details
on restoring default preferences, see Restoring Default Preference
Settings on page 11.

Setting Notification Preferences
Audible Notifications
Audible notifications are system messages sent by Blackboard Collaborate web conferencing to
notify users when certain important events occur within the session. These notifications are
presented as sounds.
Note: The implementation of audible notifications on mobile devices is
different than what is described here. For a list of features supported on
mobile devices, see Attending Sessions on Mobile Devices on page 23.
In the Preference dialog, you can listen to what each notification sounds like as well as enable or
disable the notifications. There are two built-in sets of notifications: Basic and All.

Getting Started
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1. Open the Preferences dialog in one of the following ways:
o

From the Edit menu, select Preferences… (Windows & Linux)
From the Blackboard Collaborate web conferencing menu, select Preferences
(Mac OS X)

o

Enter Ctrl+Comma (Windows & Linux)
Enter Command-Comma (Mac OS X)

2. In the left pane of the Preferences dialog, under General select Audible Notifications. The
Audible Notifications preferences panel appears on the right side of the main Preferences
dialog.

3. To hear the sound used for a notification, click on its Preview icon
of the panel.

in the right column

4. Enable and disable the notifications for the various events in the following ways.
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o

To create a custom set of notifications, click on the Enabled checkbox (middle column) associated with the desired individual events.

o

Click on the Basic button at the bottom of the panel to select the Hand Raised
Alarm, Recording in Progress, Start Recording, Stop Recording and Timer Alarm
events. This is the default setting.

o

Click on the All button at the bottom of the panel to select all events.

Getting Started

5. Click on OK to save your preferences and close the Preferences dialog, Apply to save
your preferences and leave the Preferences dialog open or Cancel to close the Preference
dialog without saving any of your changes.
When you configure preferences, Blackboard Collaborate web conferencing will remember the
settings each time you join another session on the same computer.
Note: You can restore your preference settings to the default. For details
on restoring default preferences, see Restoring Default Preference
Settings on page 11.

Visual Notifications
Visual notifications are system messages sent by Blackboard Collaborate web conferencing to
alert users when certain important events occur within a session. These notifications are
presented in a floating window. Multiple notifications get queued: the first one is displayed until
it times out or you dismiss it (by clicking on the Dismiss button in the bottom right corner of
the notification), then the next one is displayed, and so on. When there is more than one
notification, the window will have a Dismiss All button beside the Dismiss button and
display the number of notifications in the queue in the bottom left corner of the notification.
Note: The implementation of visual notifications on mobile devices is
different than what is described here. For a list of features supported on
mobile devices, see Attending Sessions on Mobile Devices on page 23.
You can judge how long the message will remain open by looking at the Timeout Indicator. You
either can dismiss a notification manually (by clicking on the Dismiss button) or wait for it to
close itself automatically (when the Timeout Indicator runs its course).

1 Timeout Indicator
2 Number of notifications in the queue
3 Dismissal buttons
In the Preference dialog, you can enable or disable the notifications. By default, all notifications
are enabled.
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1. Open the Preferences dialog in one of the following ways:
o

From the Edit menu, select Preferences… (Windows & Linux)
From the Blackboard Collaborate web conferencing menu, select Preferences
(Mac OS X)

o

Enter Ctrl+Comma (Windows & Linux)
Enter Command-Comma (Mac OS X)

2. In the left pane of the Preferences dialog, select Visual Notifications under General. The
Visual Notifications preferences panel appears on the right side of the main Preferences
dialog.

3. Enable and disable the notifications for the various events as desired by
selecting/deselecting the checkboxes in the Enabled column on the right side of the panel.

Note: The changes you make in the Visual Notifications
Preferences panel will not affect what is displayed in the Event
panel of the Activity Window.
4. Click on OK to save your preferences and close the Preferences dialog, Apply to save
your preferences and leave the Preferences dialog open or Cancel to close the Preference
dialog without saving any of your changes.
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When you configure preferences, Blackboard Collaborate web conferencing will remember the
settings each time you join another session on the same computer.
Note: You can restore your preference settings to the default. For details
on restoring default preferences, see Restoring Default Preference
Settings on page 11.

Leaving and Rejoining a Session
To leave a session while keeping the current Blackboard Collaborate web conferencing
application window open, open the Help menu and select Leave Session.
Note: When all Moderators have left the session, individual permissions
set by a Moderator will be reversed (will go back to their defaults) and the
current set of global permissions will remain as is.
To rejoin the session if you have left or been removed, open the Help menu and select Join
Session.

Launching an Offline Blackboard Collaborate Web
Conferencing Session
To familiarize yourself with the Whiteboard tools or to configure your Audio, you can use an
offline Blackboard Collaborate web conferencing session. An offline Blackboard Collaborate
session can be accessed at any time. You also can create or review presentations and/or quizzes.
Note: The Participants panel, Chat, Audio, Application Sharing and Web
Tour do not function in an offline Blackboard Collaborate session.

Note: To load a Whiteboard presentation into an offline Blackboard
Collaborate session, you must be in your private work area.
There are two ways to launch an offline session:
n

Leave a live session without closing the Blackboard Collaborate application. (See Leaving
and Rejoining a Session above.) All Chat messages and Whiteboard pages that were visible
in the session remain so you can review, print or save them.

Getting Started
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n

Use the configuration room available through the Support Portal:
1. Open http://support.blackboardcollaborate.com .
2. Browse to First Time Users and then to Step 2 under Blackboard Collaborate Web
Conferencing.
3. Click on the link Configuration Room.
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Chapter 3
Attending Sessions on Mobile
Devices
Important Note: Do not attempt to moderate a session from a mobile
device. Moderator-only functions (such as loading content and
session permissions) are not supported on mobile devices.
Moderators should join the session from a desktop or laptop computer.

Note: Accessing and participating in web conferencing sessions on
mobile devices is not supported for all user login groups. Contact your
Blackboard Collaborate system administrator for details.
The following Blackboard Collaborate web conferencing functionality is supported on mobile
devices (mobile phones and tablets):
n

use Audio to communicate

n

interact with others via the Participants panel

n

l

use Raised Hand and Stepped Away indicators

l

enter polling responses

l

see who is in your current room (either Main room or Breakout Room)

enter and read Chat messages

Page 23

n

view Application Sharing

n

view Whiteboard

n

attend Breakout Rooms
Note: For a discussion of attending sessions on mobile devices, refer to
the Mobile User's Guide for your device (iOS or Android) on the OnDemand Learning Center:
http://www.blackboard.com/Platforms/Collaborate/Services/On-DemandLearning-Center/Web-Conferencing.aspx#documentation
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Chapter 4
The Blackboard Collaborate Web
Conferencing Room
The Blackboard Collaborate web conferencing room consists of six main components:
Note: For mobile device users, the Web Conferencing room will not be
exactly as described in this chapter. For a discussion of attending sessions
on mobile devices, refer to the Mobile User's Guide for your device (iOS or
Android) on the On-Demand Learning Center:
http://www.blackboard.com/Platforms/Collaborate/Services/On-DemandLearning-Center/Web-Conferencing.aspx#documentation
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Term

Meaning

Menu bar

The Menu bar contains the File, Edit, View, Tools, Windows and
Help menus.

Audio & Video panel

The Audio & Video panel enables you to participate in conversations
using either a microphone and speakers (or headset) or via a teleconference. You also can transmit and receive Video during the session and preview your video before transmitting it.

Participants panel

The Participants panel provides a list of all Participants and Moderators in the session and information about their current activities,
such as talking (Audio), transmitting Video, sending a Chat message,
using the Whiteboard drawing tools and conducting an Application
Sharing session. Above the Participants list is a small toolbar containing buttons for raising your hand and stepping away from the
session and menus for selecting polling responses and feedback
options.

Chat panel

The Chat panel enables you to send Chat messages to everyone in
the room or to Moderators only. By selecting names in the Participants list, you can send private Chat messages to individuals. Messages can be printed and saved to track session communication.

Collaboration toolbar

The Collaboration toolbar (at the top of the Content area) contains
three buttons for switching between the three content modes
(Whiteboard, Application Sharing and Web Tour) in the Content
area; an Information menu for obtaining session information (e.g.,
connection type) and starting the Timer; a Load Content button for
loading content into the session; and the Record button.

Content area

The Content area is the main presentation window. Moderators use
this region to load presentations. Everyone can use the tools on the
Whiteboard to draw or write. All the objects and images on the
Whiteboard are dynamic and can be modified. Everyone can print
the Whiteboard pages or save them to a file to review later (unless
the Whiteboard has been protected).
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1 Title bar

6 Minimize button

2 Menu bar

7 Maximize button

3 Audio & Video panel

8 Close button

4 Participants panel

9 Collaboration toolbar

5 Chat panel

10 Content area

This chapter describes the Blackboard Collaborate menus and Content area modes, and
discusses how to use mnemonics and keyboard shortcuts, manage your panels and windows and
exit the session. The Audio & Video, Participants, Chat and Audio, panels and the three content
modes (the Whiteboard, Application Sharing and Web Tour) are described in detail in their
respective chapters.
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The Content Area Modes
The content area on the right side of your Blackboard Collaborate web conferencing interface,
enables you to exchange information and ideas with others through three different features:
n

the Whiteboard, for sharing presentations and drawings;

n

Application Sharing, for sharing individual applications or your entire desktop; and

n

Web Tour, for sharing web pages.

These features share space in the content area, with each representing a "mode" in the content
area, so you will be able to see the content of only one mode at a time. The Whiteboard content
is persistent so will be there when you move to another mode and then return to the
Whiteboard. Application Sharing content is persistent but you need to Resume Sharing when
you return to Application Sharing in order to see it. Web Tour content will always have to be
reloaded (URL entered again) when you switch modes and return to Web Tour.
Only certain users can switch between modes:
n
n

n

Moderators can switch between all modes.
Participants with Application Sharing permission can switch to Application Sharing mode
and back to Whiteboard mode.
Participants with Web Tour permission can switch to Web Tour mode and back to Whiteboard mode.
Note: Participants who have Whiteboard permission but not Application
Sharing or Web Tour permission are not able to switch to Whiteboard
mode from either of the other two modes. This safeguards against
Participants switching modes during someone else's Web Tour or
Application Sharing presentation.

When someone switches modes, everyone in the session will follow them to the new mode.
Caution: Be careful not to inadvertently switch modes on someone else
who is presenting content. Everyone in the session will follow you to the
new mode.
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To switch modes, do one of the following:
o

Click on the button in the Collaboration toolbar associated with the desired mode.

o

Select the desired mode from the View menu.

o

Use the keyboard shortcut associated with the desired mode:
Whiteboard mode: Ctrl+Alt+W (Command-Option-W on Mac)
Application Sharing mode: Ctrl+Alt+A (Command-Option-S on Mac)
Web Tour mode: Ctrl+Alt+U (Command-Option-U on Mac)

You can easily see which mode is selected by noting which button in the Collaboration toolbar is
colored. In the Collaboration toolbar below, the current mode is Whiteboard mode.

1 Whiteboard mode button

3 Web Tour mode button

2 Application Sharing mode button

Managing Panels and Windows
The Blackboard Collaborate web conferencing interface consists of panels and windows. Panels
can be collapsed, expanded, detached and reattached, resized and, in their detached state, can be
moved. The side panels (Audio & Video, Participants and Chat) also can be hidden. For details,
see Working with Panels below.
The main application window can be minimized, maximized, moved, resized and closed. Other
windows can be opened, moved, resized and closed. For details, see Working with Windows on
page 31.

Working with Panels
The default when you first join a Blackboard Collaborate web conferencing session is for the
Participants and Chat panels to be expanded and attached and the Audio & Video panel to be
collapsed and attached. Blackboard Collaborate will remember the state in which you left your
panels (expanded or collapsed and attached or detached) from one session to the next (but only
if you are logged in to the same computer).
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Below are the ways you can manage your panels:
n

Collapse and expand a panel: By default, the panels are expanded. If you want to
make more room for one of the panels, you can collapse the others.
To collapse a panel, click on the Collapse button in the panel's title bar:

To expand the panel back to its former state, click on the Expand button in the panel's
title bar:

n

n

Move a panel: Grab the panel (either attached or detached) by its title bar and, while
holding down your mouse, drag it to the desired location and then drop it by releasing the
mouse.

Detach and reattach a panel: Panels can be detached so you can move them to a
more convenient location.
To detach a panel, do one of the following:
o

From the Options menu, select Detach Panel.

o

Drag and drop the panel out of the main application window. (See Move a panel
above.)

To reattach a panel, do one of the following:

n
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o

From the Options menu, select Attach Panel.

o

Drag and drop the panel back into the main application window. (See Move a
panel above.)

o

From the View menu, select Restore Default Layout.

o

Click on the panel's Close button:

Reorder an attached panel: Drag and drop the panel up or down within the side bar
area (left side) of the main application window. (See Move a panel above.)
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n

n

n

Hide attached side panels: You can make the Content area larger by hiding the side
bar area (left side) of the main application window. To do so, in the View menu, unselect
(uncheck) Show Side Bar. To restrore the side bar, reselect it. Alternatively, you can grab
the border of any one of the panels and drag it all the way to the left. To bring the side bar
back, grab it again and move to the right.

Resize a panel: Grab a panel border and drag it. Hold your mouse over any side (either
attached or detached) or a corner (detached only) and, when the cursor changes to a twoheaded arrow, click and drag the border of the panel to contract or expand it.

Un-obscure detached panels: If part of the panel is obscured by another panel or window, click anywhere on the panel to bring it to the front of the other panel or window.

Working with Windows
There are a number of different kinds of windows in Blackboard Collaborate web conferencing:
the main application window, module windows (such as the Notes window and the Multimedia
Library), dialog boxes (such as the Preferences dialog and Create Breakout Rooms dialog) and
utility windows (such as the Object Explorer and Page Explorer).
Below are the ways you can manage your windows:
n

n

Open the main application window: To open the window you need to join the session by clicking on a link. For details, see Joining a Blackboard Collaborate Web Conferencing Session on page 8.
Open a main module window: To open the window of one of the main modules,
select it from the Window menu or, if available, open it using its associated keyboard
shortcut (see Keyboard Shortcuts on page 35.)
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n

n

n

n

Move a window: Grab the window by its title bar and, while holding down your mouse,
drag it to the desired location and then drop it by releasing the mouse.

To resize a window: Grab a window border and drag it. Hold your mouse over any side
or a corner and, when the cursor changes to a two-headed arrow, click and drag the
border of the window to contract or expand it.

Minimize or maximize the main application window: Use the standard
conventions of your operating system for minimizing and maximizing windows. For
example, on Windows, use the Minimize and Maximize buttons in the window's title bar:

Un-obscure a window: If part of a window is obscured by another window or panel,
click on the window itself to bring it to the front of the other window or panel.
Tip: If you can't find a window because it is hidden beneath other
windows, an easy way to find it is to select Restore Default Layout
from the View menu and then open your window again.

n

n

Close a main module window: To close a main module window, do one of the following:
o

Click on the window’s Close button in the title bar of the window.

o

Enter Ctrl+W (Command-W on Mac)

o

Enter Alt+F4 (Windows and Linux only)

Close the main application window: If you close the main application window you
will leave the session. For details, see Closing the Application on page 44.

The Menus
Most of the functionality of Blackboard Collaborate web conferencing can be accessed through
the menus. In addition to selecting menu options with your mouse, you can use mnemonics
and, for some functions, keyboard shortcuts (see Using Mnemonic and Keyboard Shortcuts on
page 34).
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Menus in the Main Menu Bar
The following menus are available in Blackboard Collaborate in the main menu bar:
n

n

n

n

n

n

File menu: Contains file-related commands (New, Open, Save and Print) for Whiteboard
files, Multimedia files, quizzes, session plans, Chat conversations and the Participants list.
It is also where you will find the Exit command for closing Blackboard Collaborate web
conferencing.
Edit menu: Contains standard editing commands (Cut, Copy, Paste and Select All) and
enables you to open the Preferences dialog.
View menu: Contains commands for changing your window layout and changing content modes (Whiteboard, Application Sharing and Web Tour).
Tools menu: Contains sub-menus for using the various tools in Blackboard Collaborate:
Application Sharing, Audio, Chat, Interaction, Profile, Video and Whiteboard.
Window menu: Enables you to open the following windows: Activity, Graphing Calculator, Notes and File Transfer Library.
Help menu: Gives you access to documentation (a table of Keyboard Shortcuts, the
Accessibility Guide, the Blackboard Collaborate Essentials Guide and the On-Demand
Learning Center web site), provides diagnostic tools (that Support personnel may ask you
to use to help troubleshoot an issue), enables you to leave the session without closing the
application (and then rejoin it) and provides general information about the Blackboard Collaborate web conferencing software.

Drop-Down Menus
In addition to the menus in the main menu bar, Blackboard Collaborate has a number of dropdown menus throughout the interface. Two types of drop-down menus are noteworthy:
n

Options menus: Most of the main modules in the interface have their own
Options
menus to give you quick access to commands specific to those modules. (These commands
also can be found in the main menus.)
To open an Options menu, either click on it with your mouse or use the keyboard shortcut
Ctrl+Shift+O (Command-Shift-O on Mac).
Tip: The keyboard shortcut will open the Options menu of
whichever module currently has keyboard focus. Be sure to move
focus to the desired module before using the keyboard shortcut.
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n

Participant interaction menus: There are two drop-down menus in the Participants
panel that enable you to enter your feedback and responses in the Participants list: the
Feedback menu containing emoticons (see Entering Feedback on page 55) and the
Polling Response menu (seePolling on page 58). By default, whatever you select from one
of these menus will be displayed in the Participants list (next to your name) for everyone
to see. (A Moderator may turn off the display of polling responses.)
Tip: You do not need to click on these menus to open them. They
will open up automatically when you hover your mouse over them.

Using Mnemonic and Keyboard Shortcuts
Instead of using your mouse to select a menu option, you can use your keyboard. Using
mnemonic or Keyboard Shortcuts saves time because you do not have to complete multiple steps
(e.g., clicking on a menu and then clicking on an option), nor do you have to take your hand off
the keyboard to issue the command.
Note: Mnemonic and standard Keyboard Shortcuts are enabled only
when you have input focus on the Blackboard Collaborate web
conferencing window. Focus is not required for Hot Keys.

Mnemonics
A mnemonic is an underlined letter or number that appears in a menu title or menu option that,
when pressed in conjunction with the ALT key, activates a command or navigates to an element
in the user interface.
Mac Note: Keyboard mnemonics are not supported on the Mac.

Note: On Windows, depending upon your configuration, you may have to
toggle ALT the key before the options in the menus will display the
underlined character or number.
To choose a menu option with mnemonics, do the following:
1. Press the ALT key, note which letter or number (mnemonic) is underlined in the desired
menu name and enter it on your keyboard. The menu options for that main menu will
appear. For example, if you press ALT+F, the File menu will appear.
2. Again, note the mnemonic for the desired option in the menu and enter it, with or without the ALT key.
To select a menu option from a sub-menu, repeat step 2.
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Keyboard Shortcuts
You can quickly accomplish tasks you perform frequently by using keyboard shortcuts (both
standard keyboard shortcuts and hot keys). Keyboard shortcuts are one or more keys you press
in combination to perform a function within Blackboard Collaborate web conferencing. For
example, instead of clicking the Raise Hand button in the Participants panel or selecting Raise
Hand from the Interaction menu, you can press Ctrl+R (Command-R on Mac OS X) to raise
your hand.
Hot keys differ from standard keyboard shortcuts in some important ways. For details, and a
discussion of hot keys, see Hot Keys on page 40.
Note: The keyboard shortcuts were defined with an extended (full)
keyboard layout in mind. If your keyboard does not have a key used in a
keyboard shortcut, you will need to use the menu item or toolbar button
to perform the desired function.

Caution: If you are sharing an application that has a keyboard shortcut
identical to one in Blackboard Collaborate, and focus is on Application
Sharing, the shortcut will activate its associated command in the shared
application, not in Blackboard Collaborate.
The following table lists the keyboard shortcuts (both standard and hot keys) present in
Blackboard Collaborate to quickly perform a number of common functions.The first column
describes the function to be performed, the second column lists the Windows and Linux
keyboard shortcuts and the third column gives the Mac keyboard shortcuts. Keys are grouped
into sections based on the Blackboard Collaborate module being used.
Note: To access the list of keyboard shortcuts while in a session, select
Keyboard Shortcuts from the Help menu.

The Blackboard Collaborate Web Conferencing Room

35

Function

Windows, etc. keys

Mac keys

Application, Window and File Functions
Quit Blackboard Collaborate

Alt+F4

Command-Q

Ctrl+Q
Hide Blackboard Collaborate

N/A

Command-H

Hide other applications

N/A

Option-Command-H

Close window (Notes, Activity, ClosedCaptioning, Calculator)

Alt+F4

Command-W

Switch to Whiteboard Mode

Ctrl+Alt+W

Command-Option-W

Switch to Application Sharing Mode

Ctrl+Alt+A

Command-Option-A

Switch to Web Tour Mode

Ctrl+Alt+U

Command-Option-U

Open Preferences dialog box

Ctrl+Comma

Command-Comma

Save Participants list, Chat conversation or
Whiteboard

Ctrl+S

Command-S

Print Participants list or Whiteboard

Ctrl+P

Command-P

Move to the next main module in the user
interface. The default order is Participants
panel, Chat panel, Collaboration toolbar,
Action bar and Audio& Video panel. (If you
change the order of the panels, the order
will change.)

F6

F6

Open the Action bars of Whiteboard Mode
and Web Tour mode

F6

F6

Move to the previous main module in the
user interface. (See F6 above for the order
of modules.)

Shift+F6

Shift-F6

Ctrl+W

Keyboard Navigation Functions
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Function

Windows, etc. keys

Mac keys

Move to the next user interface element
Tab
(e.g., button, field, option) in a main
module or UI element. For example, if
focus is in the Collaboration toolbar, Tab
and Shift-Tab can be used to move between
the three modes (Whiteboard, Application
Sharing and Web Tour), the Information
menu, the Load Content button and the
Record button.

Tab

Move to the previous user interface
element (e.g., button, field, option) in a
main module (see example for Tab above)

Shift+Tab

Shift-Tab

Activate the currently selected function

Space

Space

Enable tabbing in toolbars of secondary
Alt+F8
windows (Closed Captioning, Notes, Activity
Window, File Transfer)

Option-F8

Move keyboard focus between open
windows (Notes, File Transfer, Activity,
Closed-Captioning, Calculator)

Alt+F6
Command-`
(Windows XP and Linux
only)

Open Options menu of the panel or toolbar
in focus (Audio & Video, Chat, Participants,
Whiteboard action bar, Whiteboard
navigation bar or Web Tour)

Ctrl+Shift+O

Command-Shift-O

Open Activity Window

Ctrl+/

Command-/

Close Activity Window

Ctrl+/

Command-W

Activity Window Functions

Alt+F4
Ctrl+W
Audio Functions
Press the Talk button

Ctrl+F2

Control-F2

Ctrl+F2

Control-F2

(Note: this is a Hot Key ─ see Hot Keys on
page 40.)
Release the Talk button
(Note: this is a Hot Key ─ see Hot Keys on
page 40.)
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Function

Windows, etc. keys

Mac keys

Adjust microphone level down

Ctrl+Shift+Down Arrow Command-ShiftDown Arrow

Adjust microphone level up

Ctrl+Shift+Up Arrow

Command-Shift-Up
Arrow

Adjust speaker level down

Ctrl+Alt+Down Arrow

Command-OptionDown Arrow

Adjust speaker level up

Ctrl+Alt+Up Arrow

Command-Option-Up
Arrow

Start Video transmission
(Note: this is a Hot Key ─ see Hot Keys on
page 40.)

Ctrl+F3

Control-F3

Stop Video transmission
(Note: this is a Hot Key ─ see Hot Keys on
page 40.)

Ctrl+F3

Control-F3

Select all objects in Whiteboard

Ctrl+A

Command-A

Open Page Explorer window

Ctrl+Shift+P

Command-Shift-P

Open Object Explorer window

Ctrl+Shift+T

Command-Shift-T

Copy selected object(s) or text in
Whiteboard

Ctrl+C

Command-C

Cut selected object(s) or text in Whiteboard

Ctrl+X

Command-X

Paste copied or cut object(s) or text to
Whiteboard

Ctrl+V

Command-V

Group selected objects

Ctrl+G

Command-G

Ungroup selected objects

Ctrl+U

Command-U

Delete selected object(s) or text in
Whiteboard

Delete

Delete

Backspace

Backspace

Go to next page

Alt+Page Down

Option-Page Down

Go to previous page

Alt+Page Up

Option-Page Up

Move to first page at this topic level

Alt+Home

Option-Home

Video Functions

Whiteboard Functions
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Function
Move to last page at this topic level

Windows, etc. keys

Mac keys

Alt+End

Option-End

Take back control of Application Sharing
(Note: this is a Hot Key ─ see Hot Keys on
next page.)

Ctrl+Space

Control-Space

Stop Application Sharing
(Note: this is a Hot Key ─ see Hot Keys on
next page.)

Ctrl+Shift+S

Control-Shift-S

Move cursor to the Message text box of the
Chat panel

Ctrl+M

Command-M

Select all Chat text in conversation pane

Ctrl+A

Command-A

Copy selected Chat text in conversation
pane

Ctrl+C

Command-C

Paste copied Chat text to Chat Message text
box, Whiteboard or external application

Ctrl+V

Command-V

Raise or lower your hand

Ctrl+R

Command-R

Show that you have stepped away or come
back

Ctrl+Shift+A

Command-Shift-A

Show smiley face

Alt+1

Option-1

Show LOL

Alt+2

Option-2

Show applause

Alt+3

Option-3

Show confusion

Alt+4

Option-4

Show approval

Alt+5

Option-5

Show disapproval

Alt+6

Option-6

Show Slower (when you want the presenter Alt+7
to slow down)

Option-7

Show Faster (when you want the presenter
to speed up)

Alt+8

Option-8

Show None (when you want to clear all
displayed emoticons)

Alt+0

Option-0

Application Sharing Functions

Chat Functions

Participant Panel Functions
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Function

Windows, etc. keys

Mac keys

Notes Functions
Open Notes window

Ctrl+E

Command-E

Close Notes window

Alt+F4

Command-W

Ctrl+W
Closed-Captioning Functions
Open Closed-Captioning window

Ctrl+F8

Command-F8

Close Closed-Captioning window

Alt+F4

Command-W

Ctrl+W
Polling Functions
Yes - polling response

Ctrl+1

Command-1

No - polling response

Ctrl+2

Command-2

A - polling response

Ctrl+1

Command-1

B - polling response

Ctrl+2

Command-2

C - polling response

Ctrl+3

Command-3

D - polling response

Ctrl+4

Command-4

E - polling response

Ctrl+5

Command-5

None

Ctrl+0

Command-0

Hot Keys

Hot keys are a type of keyboard shortcut but differ from standard keyboard shortcuts two ways:
n
n

You can modify the definition of these keys.
You do not need to have input focus on the Blackboard Collaborate web conferencing window to use them (they are available system-wide).

By default, seven hot keys have been defined for the commonly used features in Blackboard
Collaborate. You can use these default hot keys (listed in the following table) or define your own
in the Preferences dialog. For instructions, see Configuring Hot Keys on the facing page.
Linux Note: Num Lock and Caps Lock must be turned off for Hot Keys
to work in a Blackboard Collaborate session running on Linux.
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The default values for the two Talk hot keys are the same and the default values for the two
Video hot keys are the same. If you keep the default values for the Talk keys, you can use
Ctrl+F2 (Control-F2 on Mac) to toggle the Talk button on and off. If you keep the default values
for the Video keys, you can use Ctrl+F3 (Control-F3 on Mac) to start and stop Video.
The default hot keys are listed in the following table where the first column describes the
function to be performed, the second column lists the Windows and Linux hot key and the third
column gives the Mac hot key.
Function

Windows & Linux Key

Mac Key

Press the Talk button

Ctrl+F2

Control-F2

Release the Talk button

Ctrl+F2

Control-F2

Take back control of Application Sharing

Ctrl+Space

Control-Space

Stop Application Sharing

Ctrl+Shift+S

Control-Shift+S

Start Video transmission

Ctrl+F3

Control-F3

Stop Video transmission

Ctrl+F3

Control-F3

Configuring Hot Keys

Exercise caution when changing the default definitions of hot keys. Ensure you do not change a
hot key definition to that of a hot key used by another application. You also should avoid key
combinations that conflict with standard keyboard shortcut operations.
Note: On Windows and Linux, the hot key is restricted to one character.
You may include one or more modifier keys (Shift, Control or ALT on
Windows).

Mac Note: Mac OS X users must include at least one modifier key in the
keystroke: ⇧Shift, ^ Control, ⌥ Option or ⌘ Command) .
Configure your hot keys in the Preferences dialog.
1. Open the Preferences dialog in one of the following ways:
o

From the Edit menu, select Preferences… (Windows & Linux)
From the Blackboard Collaborate web conferencing menu, select Preferences
(Mac OS X)

o

Enter Ctrl+Comma (Windows & Linux)
Enter Command-Comma (Mac OS X)
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2. In the left pane of the Preferences dialog, select Hot Keys under General. The Hot Keys
preferences panel appears.

Note: If you see an X under the Valid column, this indicates that
the hot key is not available. It is likely being used by another open
application. Either redefine the hot key to something valid or close
the other application.
3. From the Hot key preferences panel, select the hot key you wish to revise and click
Modify…. The Edit Hot Key dialog opens.

4. Assign the keystrokes. Click on the down arrow to select a key from the key option list
and then select the desired modifier keys by clicking on their check boxes. For example,
the keystroke in the screen capture above is Ctrl+F2.
5. Click on OK to save the hot key configuration and close the Edit Hot Key dialog, or
Cancel to close the Edit Hot Key dialog without saving your changes.
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6. Click on OK to save your preferences and close the Preferences dialog, Apply to save
your preferences and leave the Preferences dialog open or Cancel to close the Preference
dialog without saving any of your changes.
When you configure preferences, Blackboard Collaborate web conferencing will remember the
settings each time you join another session on the same computer.
Note: You can restore your preference settings to the default. For details
on restoring default preferences, see Restoring Default Preference
Settings on page 11.

Getting Session Connection Information
You can get information about your session connection through the Information menu in the
Collaboration toolbar. (This menu also gives you access to the Timer dialog. See The Timer on
page 241.)

n

n

n

n

Connection Speed: This the speed you set, either when you first joined the session or
later through the Session Connection preferences panel (see Setting Your Connection
Speed on page 12).
Signal Strength: This represents the response time of the Blackboard Collaborate
server. The possible values are Excellent, Good, Fair, Low and — (which means Disconnected).
Encryption: This indicates whether or not your communication with the Blackboard Collaborate server is encrypted. The possible values are SSL (which means encrypted) and —
(which means not encrypted).
Session Time: This is the length of time that the session has been in progress, including
the time before you joined the session.
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Closing the Application
To close the Blackboard Collaborate web conferencing application, do one of the following:
o

From the File menu, select Exit (Windows and Linux) or from the Blackboard Collaborate
web conferencing menu, select Quit (Mac OS X).

o

Click on the window’s Close button.

o

Enter Ctrl+Q (Command-Q on Mac)

o

Enter Alt+F4 (Windows and Linux only)

By default, a confirmation dialog will prompt you to confirm whether or not you want to leave
the session. For instructions on how to hide this dialog in the future, see The Confirmation
Dialog.
Note: When you leave a session, you may be directed to a web page
defined by the session creator. Your default web browser will launch
automatically.

The Confirmation Dialog
By default, you will be prompted to confirm whether or not you want to leave the session. Click
on OK to leave the session or Cancel to stay in the session.

To turn this confirmation off for future sessions, select the option Don’t remind me again and
click on OK. You can turn the reminder back on for future session, using the Preferences
dialog:
1. Open the Preferences dialog in one of the following ways:
o

From the Edit menu, select Preferences… (Windows & Linux)
From the Blackboard Collaborate web conferencing menu, select Preferences
(Mac OS X)

o

Enter Ctrl+Comma (Windows & Linux)
Enter Command-Comma (Mac OS X)
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2. In the left pane of the Preferences dialog, select Leaving under Session. The Session
Leaving preferences panel appears.

3. Unselect the option Ask for confirmation before leaving a session.
4. Click on OK to save your preferences and close the Preferences dialog, Apply to save
your preferences and leave the Preferences dialog open or Cancel to close the Preference
dialog without saving any of your changes.
When you configure preferences, Blackboard Collaborate web conferencing will remember the
settings each time you join another session on the same computer.
Note: You can restore your preference settings to the default. For details
on restoring default preferences, see Restoring Default Preference
Settings on page 11.
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Chapter 5
The Participants Panel
The Participants panel provides you with information about yourself and others in the
session. You can view the user profiles of others and edit your own, see what features others are
currently using and see what permissions you and others have. The Participants panel also gives
you tools for interacting with others in the session: you can enter emoticons, raise your hand,
indicate that you have stepped away from the session, send a private Chat message and respond
to polls conducted by a Moderator.
Note: Not all features of the Participants panel are supported on mobile
devices. For a list of features that are supported, see Attending Sessions
on Mobile Devices on page 23.
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The Participants panel has the following components:

1 Expand/Collapse button

7 Global options menu

2 Feedback menu

8 Status area

3 Step Away button

9 Toolbar

4 Raise Hand button

10 Activity indicators

5 Polling Response menu

11 Participant options menu

6 Participants list
Your name appears at the top of the Participants panel in the Status area as well as in the
Participants list below it. In both places you will see information about your permissions (see
Understanding Permissions below), your current activity (see Status Indicators on page 57) and
your profile (see Editing Your User Profile on page 61). In the Participants list, all the
Moderators in the session are displayed in alphabetical order at the top of the list (above the
horizontal rule), followed by all the Participants, who are also listed in alphabetical order.
Note: For information on working with panels, see Working with Panels
on page 29

Understanding Permissions
Your access to Blackboard Collaborate web conferencing features is managed by permissions.
Moderators can change your permissions, either by changing the global permissions (those that
apply to all Participants) or by changing your permissions only.
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For information on how permission information is presented in the
Participants panel, see Permission Indicators in the Participants List on
next page.
The following table shows the icons associated with each permission and describes what the
permissions entail.
Icon

Permissions

The Audio permission allows Participants to talk in the session.
If the permission is not granted, they can still listen to others.
The Video permission allows Participants to transmit video in the session.
If the permission is not granted, they can still preview their own video and view the
video transmissions of others.
The Chat permission allows Participants to enter chat messages in the session.
If the permission is not granted, they can still send private chat messages to
Moderators and read the Chat messages of others.
The Whiteboard permission allows Participants to use the drawing tools in the
Whiteboard. It doesn't allow them to load content (e.g., presentations) into the
Whiteboard, which requires Moderator privileges, nor to switch to Whiteboard
mode from another mode (see The Content Area Modes on page 28). Neither does
it allow them to navigate between pages in the Main room, which requires the
Moderator to turn off the Follow option .
If the permission is not granted, Participants can still view the Whiteboard content
entered by Moderators.
The Application Sharing permission allows Participants to host an Application
Sharing session, including switching to Application Sharing mode (see The Content
Area Modes on page 28) and back to the Whiteboard. It also enables them to
request remote control of anyone's Application Sharing session or the desktop of
Moderators or other Participants who also have the Application Sharing
permission; in both cases, the request can be denied by the host.
If the Application Sharing permission is not granted, Participants can still view
others' shared applications or desktops.
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Icon

Permissions

The Web Tour permission allows Participants to host Web Tours and Web Pushes,
including switching to Web Tour mode (see The Content Area Modes on page 28)
and back to the Whiteboard.
If the Web Tour permission is not granted, Participants can still view others' Web
Tours.
The Closed-Captioning permission allows Participants to enter text into the ClosedCaptioning window.
If this permission is not granted, Participants can still read the Closed-Captioning
text of others. (Note: this permission can be set only from the Participant option
menu – i.e, it cannot be set globally for all Participants.)

Permission Indicators in the Participants List
Only those individual permissions (granted or revoked) that represent exceptions to the global
permissions are displayed in the Participants list.
Note: You can view all your permissions – not just the exceptions – in
your Participants panel Status Area. See Viewing all of your Permissions
on the facing page.
When a Moderator removes your permission to use a globally permitted feature, the icon
representing that feature is stamped with a red X and appears next to your name in the
Participants list.
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In the example below, the global permissions (shown to the right of the room name) are set to
the default (permission to use Audio, Video, Chat and Whiteboard but not Application Sharing
and Web Tour) and the exceptions to these are indicated by the icons next to the session
attendee names in the Participants list.
n

n

n

The Moderator has granted Charlie the ClosedCaptioning permission and revoked his
permission to transmit video .
Lucy has been granted the Application Sharing
permission.
Ricky has been granted the Web Tour permission
and his Audio permission has been revoked: .

Viewing all of your Permissions

If you would like to see a complete list of all your permissions, not just the exceptions to the
global permissions, select Show My Permissions from the Global Options menu of the
Participants panel. Your permissions will be displayed in the Status area at the top of the
Participants panel. (Your activity and status indictors are also displayed in the Status area.)
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Note: All the individual permissions (granted or revoked) that represent
exceptions to the global permissions are still displayed in the Participants
list.

Knowing When Someone has Joined or Left a Session
There are five ways to tell when someone has joined or left a session:
n

The person’s name will appear in the Participants list when they join the session and will
be removed when they leave the session.

n

An Audible Notification may be played when someone joins or leaves a session.

n

A Visual Notification may be displayed when someone joins a session.

n

A message will be displayed in the Chat conversation area.

n

A message may be displayed in the Activity Window.
Tip: You can turn Audible and Visual Notifications on and off. For
details, see Setting Notification Preferences

Raising and Lowering Your Hand
Moderators and Participants can raise their hands at any time during the session. The
Participants list will indicate who has raised their hand and in what order. When a Participant
raises their hand, their name goes to the top of the participant list, just under the Moderators.
There are two ways to raise your hand:
o

Participants panel
Click the

o

button.

Keyboard shortcut
Enter Ctrl+R (Command-R on Mac).

There are three ways to lower your hand:
o

Participants panel
Click the

o

button.

Participant Options menu
Select Lower Hand.
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o

Keyboard Shortcut
Enter Ctrl+R (Command-R on Mac).

Raised Hand Notification
Each time someone raises their hand, you may be notified in one or both of the following ways:
n

n

A red hand icon will appear over the profile picture (or avatar) of the person who raised their hand. A number will
appear under their name indicating where they are in the
queue of those who have raised their hands (the order in
which hands were raised).
An Audible Notification may be played. You can configure
your Audible Notification preferences to play one sound
when you raise your own hand and another when someone
else raises theirs – or you can turn the sound off altogether.
Tip: For details on turning your Audible
Notifications on and off, see Setting
Notification Preferences on page 17.

Stepping Away
The Step Away feature enables you to indicate to the others in the session that you are
temporarily unavailable. You are still connected to the session and can see and hear everything
that is going on – others just won't expect you to be available for interaction.
There are three ways to show that you have stepped away:
o

Click on the

button in the Participants panel.

o

From the Tools menu, select Interaction and then select Step Away.

o

Enter Ctrl+Shift+A (Shift-Command-A on Mac).

The Step Away indicator (clock icon and the word "Away") will appear next to your name in the
Participants list for everyone to see. You will also see the indicator next to your name in the
Status area (top) of the Participants panel.

The Participants Panel

53

Stepping Back
There are three ways to show that you have stepped back into the session:
o

Click on the

button in the Participants panel.

o

From the Tools menu, select Interaction and then unselect Step Away.

o

Press Ctrl+Shift+A (Shift-Command-A on Mac).

The Step Away indicator will be removed from the Participants list so others will know you are
back in the session.
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Entering Feedback
Moderators and Participants can select feedback options from the Feedback menu or via
keyboard shortcuts. These options express common reactions to a presentation. An indicator
associated with each option appears for a short time to the right of the name of the person who
selected it.
There are three ways to select one of the feedback options:
o

Participants panel Feedback menu
Select the desired option.

o

Interaction Sub-menu of Tools Menu
From the Tools menu, select Interaction followed by Show Emotion and select the
desired option from the submenu. This menu is identical to the menu in the Participants
panel.
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o

Keyboard Shortcuts
Enter the appropriate keyboard shortcut for the desired option.
Emotion

Windows and Linux Keyboard Shortcuts

Mac Keyboard Shortcuts

Show Smiley Face

Alt+1

Option-1

Show LOL

Alt+2

Option-2

Show Applause

Alt+3

Option-3

Show Confusion

Alt+4

Option-4

Show Approval

Alt+5

Option-5

Show Disapproval

Alt+6

Option-6

Show Slower (when Alt+7
you want the presenter to slow
down)

Option-7

Show Faster (when
you want the presenter to speed up)

Alt+8

Option-8

(blank Show None (clears
squar- all displayed feede)
back icons)

Alt+0

Option-0

Icon

Activity Indicators
The Participants list presents information about user activity through activity indicators. These
indicators display information about what feature a user is currently using, show if a user is
using the Audio Setup Wizard or indicate if a user has stepped away from the session.
Note: Alongside the activity indicators, you may see other icons in the
Participants list. There may be permission icons (see Understanding
Permissions on page 48) or status indicators showing that users are
experiencing delays (see Status Indicators on the facing page
Activity
Indicator

Meaning

User has turned on his/her microphone. (Using VoIP for Audio.)
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Activity
Indicator

Meaning

The Teleconference Bridge participant is connected and the telephone
conference is available to users.
User is using Telephony mode for audio communications. (Using the phone for
Audio.)
User is running the Audio Setup Wizard.
User is transmitting Video.
User is entering a Chat message.
User is entering content into the Whiteboard with one of the Whiteboard drawing tools or, if the user is a Moderator, may be loading content into the Whiteboard.
User is hosting an Application Sharing session.
User is conducting a Web Tour or Web Push.
User has stepped away from the session.
In the example to the right,
n

Charlie is entering a Chat message and is also using
the Audio Setup Wizard;

n

Ethel has the Talk button pressed;

n

Lucy is entering Closed-Captioning text;

n

Ricky has stepped away from the session; and

n

Vivian is transmitting Video.

Status Indicators
Status indicators are amber and red lights that appear on
the activity indicators in the Participants list when there is
a delay in the sending and/or receipt of Audio, Video and
Application Sharing data. An amber status indicator
denotes a moderate delay whereas a red status indicator
denotes a significant delay.
The status indicators are dynamic and are updated and visible throughout the session. By
keeping an eye on these indicators, you can see when it might be appropriate to adjust your pace
(e.g., temporarily stop talking, turn off your Video camera or pause your Application Sharing
session) so others can catch up.
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In the example to the right,
n
n

n

n

Charlie is talking,
Ricky is experiencing a moderate delay in
receiving Audio,
Vivian is experiencing a significant delay in
receiving Audio, and
Ethel is not having any problems receiving
Audio.
Note: For details about the various status indicators, refer to the chapters
on Application Sharing, Audio and Video.

Polling
A Moderator may ask you to participate in an poll. There are four poll types:
n

Yes/No Options (the default)

n

Multiple-Choice Responses A – C

n

Multiple-Choice Responses A – D

n

Multiple-Choice Responses A – E

People can respond to questions by selecting response options from the Polling Response menu
in the Participants panel or by entering keyboard shortcuts (listed in the following table).

When the Moderator selects a different type of poll, the available response buttons will change
accordingly.
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Type of Poll

Response
Buttons

Yes/No

Multiple Choice with
three answer choices

Multiple Choice with
four answer choices

Multiple Choice with five
answer choices

None (clears all displayed blank square
polling responses)

Windows and Linux
Shortcuts

Mac Shortcuts

Yes: Ctrl+1

Yes: Command-1

No: Ctrl+2

No: Command-2

A: Ctrl+1

A: Command-1

B: Ctrl+2

B: Command-2

C: Ctrl+3

C: Command-3

A: Ctrl+1

A: Command-1

B: Ctrl+2

B: Command-2

C: Ctrl+3

C: Command-3

D: Ctrl+4

D: Command-4

A: Ctrl+1

A: Command-1

B: Ctrl+2

B: Command-2

C: Ctrl+3

C: Command-3

D: Ctrl+4

D: Command-4

E: Ctrl+5

E: Command-5

Ctrl+0

Command-0

Moderators can determine whether polling responses are visible to both Moderators and
Participants or Moderators only. For details about viewing the polling results, see Viewing
Polling Results below.

Viewing Polling Results
If a Moderator has enabled it, Participants can see the responses of others displayed next to
their names in the Participants list. Your own response is also shown in the button of the
Polling Response menu.
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User Profiles
User Profiles are a means for users to publish information about themselves and to view
information provided by others.

Viewing a User’s Profile
A user’s profile appears in a floating display beside the Participants list.
To view a user’s profile, hover your mouse over their name in the Participants list. The content
displayed in the user’s profile varies depending on how completely the user has filled in his or
her profile.

If a user does not have a profile, the display will simply contain the same name that is already
listed in the Participants list.
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To dismiss the profile, click on it or move your cursor off of the Participants list.

Editing Your User Profile
Create or edit your Profile in the Preferences dialog.
Note: All fields in the My Profile preferences dialog are optional.
1. Open the Preferences dialog in one of the following ways:
o

From the Edit menu, select Preferences… (Windows & Linux)
From the Blackboard Collaborate web conferencing menu, select Preferences
(Mac OS X)

o

Enter Ctrl+Comma (Windows & Linux)
Enter Command-Comma (Mac OS X)

The Participants Panel

61

2. (Skip this step if you selected Edit Profile from your Participants Option menu in the
Participants list.) In the left pane of the Preferences dialog, select the My Profile
preferences panel under Profile.

3. Enter your information in the desired fields under the Identity tab.
To insert a photo, click the Change button and browse to select your photo. To remove
the photo, click on the Clear button.
Tip: Only .gif and .jpg or .jpeg files can be used for your User
Profile photo. If your photo is larger than 96 x 96 pixels, it will be
automatically scaled to fit the available space.
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4. Click on the Contact tab and enter information in the desired fields.
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5. Click on the Addresses tab and enter information in the desired fields.

6. Click on OK to save your preferences and close the Preferences dialog, Apply to save
your preferences and leave the Preferences dialog open or Cancel to close the Preference
dialog without saving any of your changes.
When you configure preferences, Blackboard Collaborate web conferencing will remember the
settings each time you join another session on the same computer.
Note: You can restore your preference settings to the default. For details
on restoring default preferences, see Restoring Default Preference
Settings.

Importing a vCard file

Instead of creating a new user profile for a Blackboard Collaboratesession from scratch, you can
import an existing vCard (*.vcf file).
1. Open the My Profile preferences dialog box. (See steps 1 and 2 under Editing Your User
Profile.)
2. Click on the Import button. The Open dialog box will open.
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3. Navigate to the directory containing your vCard, select the .vcf file you wish to import and
then click on Open.
4. Click on OK to save your new profile and close the Preferences dialog, Apply to save your
new profile and leave the Preferences dialog open or Cancel to close the Preference
dialog without saving any of your changes.

Exporting a vCard file

You can export your Blackboard Collaborate profile as a .vcf file and import it into other
applications (such as Outlook).
1. Open the My Profile preferences dialog box. (See steps 1 and 2 under Editing Your User
Profile.)
2. Click on the Export button. The Save dialog will open.
3. Navigate to the location in which you want to save the *.vcf file and then click on Save.
4. Click on OK to complete the export and close the Preferences dialog, Apply to complete
the export and leave the Preferences dialog open or Cancel to close the Preference dialog
without completing the export.

Mobile Device Indicators
The Participants list displays indicator icons next to people's names when they are connected to
a session using mobile devices: a mobile phone or tablet. This information is important because
mobile users are somewhat limited in the Blackboard Collaborate features they can use and you
may want to tailor your session activity to accommodate them.
For a list of features supported on mobile devices, see Attending Sessions on Mobile Devices on
page 23.
Important Note: Do not attempt to moderate a session from a mobile
device. Moderator-only functions (such as loading content and
session permissions) are not supported on mobile devices.
Moderators should join the session from a desktop or laptop computer.

Note: Accessing and participating in web conferencing sessions on
mobile devices is not supported for all user login groups. Contact your
Blackboard Collaborate system administrator for details.

Note: No device icon is displayed for users connected to the session using
a desktop, laptop or notebook computer.
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Device
Indicator

Meaning

User is connected to the session using a mobile phone.
User is connected to the session using a tablet.
In the following example, Vivian and Charlie are connected to the session using desktop
computers, Lucy is connected using a mobile phone and Ethel is connected using a tablet. (Ricky
has stepped away from the session.)

Printing the Participants List
You can print the current Participants list to review at a later time. The
printed list will have the session name as its header. The names in the list
will be appended by the session attendees’ roles.
1. Open the Print dialog by doing one of the following:
o

From the File menu, select Print and then Participants List…

o

Enter Ctrl+P (Command-P on Mac).

2. In the Print dialog, specify your preferences and click OK.
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Saving the Participants List to a File
You can save the current Participants list to a text file to review at a later
time. The saved file will have the session name as its header. The names
in the list will be appended by the session attendees’ roles.
1. Open the Save Participants List dialog by doing one of the
following:
o

From the File menu, select Save and then Participants List… .

o

Enter Ctrl+S (Command-S on Mac).

2. Enter a file name and select the location to which you want to save the file.
3. Click Save. The suffix .txt is added to the filename.
Note: All Participants list files will be saved as text (.txt) files. There are
no other file types supported.
You can use Notepad, WordPad, Text Edit (OS X) or any word processing application to read the
text file.
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Chapter 6
Video
The Video feature of Blackboard Collaborate web conferencing enables you to transmit and
receive video broadcasts with others in a session. A video broadcast is video you send live via a
video camera (e.g., web cam) – not to be confused with a pre-recorded video (movie) that
Moderators can play using the Multimedia feature.
Note: This feature is not supported on mobile devices. For a list of
features that are supported, see Attending Sessions on Mobile Devices on
page 23.
The Video feature can display up to six simultaneous camera transmissions. For details, see
Multiple Simultaneous Cameras on page 78
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The Audio & Video window has the following Video components:

1 Expand/Collapse button

4 Preview Video button

2 Options menu

5 Transmit Video button

3 Primary video display
You will know someone is transmitting video (has their Transmit Video button turned on) when
the blue Video activity indicator ( ) appears next to their name in the Participants list. (For
details on activity indicators, see Video Activity, Permission and Status Indicators below). In
the example below, Vivian and Lisa are transmitting video.

If the Video button is disabled (grayed out) in your Audio & Video panel, it means you do not
have permission to use Video. You can always view another's video transmission, change your
video display, preview your own Video and set your camera preferences but you need the Video
permission in order to transmit. (For information on permissions, see Understanding
Permissions on page 48.)

Video Activity, Permission and Status Indicators
You can monitor the state of Video activity and permissions through indicators displayed in the
Participants list of the Participants panel.
For details about permissions, see Understanding Permissions on page 48.
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Video

Activity and Permission Indicators
The following table describes the icons displayed in the Participant list to indicate Moderator
and Participant permissions and activity while using Video.

Activity
Indicator

Meaning

User has turned on his/her video camera.
Video permission is set globally to "on" but the Moderator has revoked Video permission from this user.
Video permission is set globally to "off" but the Moderator has granted Video permission to this user.

Status Indicators
Status indicators appear on the Video activity indicator icons of Video users in the Participants
list if there are delays in the transmission or receipt of Video. When there are delays, the server
begins to drop frames. You will experience delays as a drop in video quality. The degree of delay
is indicated by color:
l

l

Amber Indicator: Appears when a person's receipt or transmission of video is moderately delayed.
Red Indicator: Appears when a person's receipt or transmission of video is significantly
delayed. This may indicate a problem with the network connection and often will be followed by the user getting disconnected from the session.
Note: Video transmitters see status indicators for themselves and video
viewers. Video viewers see status indicators for video transmitters only –
not for themselves. (There is one exception: if using multiple cameras, a
person can be a viewer and transmitter at the same time, so “viewers” may
see status indicator for themselves – but only because they are also
“transmitters”.)
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In the example to the right,
n
n

n

n

Vivian is transmitting video,
Lisa is experiencing a moderate delay in receiving
Video,
Lucy is experiencing a significant delay in receiving
Video, and
Charlie is not having any problems receiving Video.

Previewing and Transmitting Video
Before you transmit video to everyone in the session, it is a good idea to preview it first to check
the quality of the image. If it is not satisfactory, you may want to adjust your camera settings
(refer to the documentation for your camera) or change the Video Frame Rate (see Setting the
Video Frame Rate).
Tip: If your Video button is inaccessible (grayed out) it may be because a
Moderator has removed your Video permission or the maximum number
of simultaneous cameras has been reached.

Note: If your Audio & Video panel is in its collapsed state, it will
automatically be expanded when you preview or transmit video.
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Previewing Video
To preview video, click on the Preview button. Notice that, when activated, your Preview button
turns blue. The images captured by your camera will be displayed in your primary video display,
along with the word "Preview". No one else will be able to see your preview.

1 Preview image
2 Preview button
Note: If you get an error when you click on the Preview button (such as
"Cannot connect to the video source"), your camera may be in use by
another application or you don't have the correct camera selected under
Preferences (see Selecting your Video Camera on next page).

Transmitting Video
To transmit video to everyone in the room, do one of the following:
o

Click on the Transmit Video button in the Audio & Video panel.

o

Enter the keyboard shortcut Ctrl+F3 (Command-F3 on Mac).
Tip: This keyboard shortcut is a "hot key", meaning you can redefine it.
You are actually able to configure two hot keys for the Video button: one
to turn it on and one to turn it off. For details, see Hot Keys on page 40.

Note: If you get an error when you click on the Preview button (such as
"Cannot connect to the video source"), your camera may be in use by
another application or you don't have the correct camera selected under
Preferences (see Selecting your Video Camera on next page).
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Notice that, when activated, your Video button displays a red camera.

1 Video button off
2 Video button on

Stopping Video Transmission

To stop video transmission, turn your camera off in the same way you turned it on:
o

Click on the Video button in the Audio & Video panel.

o

Enter the keyboard shortcut Ctrl+F3 (Command-F3 on Mac).

o

Click on the Preview button. You will continue to see video images, but others in the session will not.
Tip:This keyboard shortcut is a "hot key", meaning you can redefine it.
You are actually able to configure two hot keys for the Video button: one
to turn it on and one to turn it off. For details, see Hot Keys on page 40.

Selecting your Video Camera
If you have only one video camera installed on your computer, that device is automatically used
by Blackboard Collaborate web conferencing to preview and transmit video. However, if you
have more than one video input device on your computer, you can select which device you want
to use through the Preferences dialog.
Note: When a connection is established to a video camera device, that
connection is maintained until a different device is connected or the
session is terminated. While a connection exists to a video device, that
device is not available for use by other applications.
1. Open the Preferences dialog in one of the following ways:
o

From the Edit menu, select Preferences… (Windows & Linux)
From the Blackboard Collaborate web conferencing menu, select Preferences
(Mac OS X)

o

Enter Ctrl+Comma (Windows & Linux)
Enter Command-Comma (Mac OS X)
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2. In the left pane of the Preferences dialog, select Camera Settings under Audio/Video.

3. Select the desired camera from the Select the camera to use drop-down list.
4. Click on OK to save your preferences and close the Preferences dialog, Apply to save
your preferences and leave the Preferences dialog open or Cancel to close the Preference
dialog without saving any of your changes.
When you configure preferences, Blackboard Collaborate web conferencing will remember the
settings each time you join another session on the same computer.
Note: You can restore your preference settings to the default. For details
on restoring default preferences, see Restoring Default Preference
Settings on page 11.
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Viewing Video
To view the video being transmitted by others, your primary video display must be open. If it is
collapsed, click on the Expand button (in the top left corner of the panel) to open it.

Tip: Alternatively, if you want to preview your Video, click on the Preview
Video button to expand the panel. If you want to transmit Video, click on
the Video button to expand the panel.
If you do not wish to view another's video transmission, collapse the primary video display by
clicking on the Collapse button.
Tip: When you collapse your primary video display when viewing video,
incoming video is not transmitted to you. This will reduce the bandwidth
used and will improve the overall responsiveness of Blackboard
Collaborate. (If you are transmitting video, collapsing the video display
will not affect bandwidth – video will still be transmitted.)

Note: For information on working with panels, see Working with Panels
on page 29.
In the primary video display, you may see either someone's profile picture (or default profile
icon) or Video transmission. The display will also show their name.
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1 Collapse button
2 Primary Video display
3 Name of transmitter

The Default Views
By default, the option Make Video Follow Speaker is turned on and the Moderator-only option,
Make Video Follow Moderator Focus, is turned off. These options affect what is shown in the
primary video display. (For information on these options and how to change what is presented
in the primary video display, see Controlling the Primary Video Display on page 79.)
If the default options are maintained (and you are not previewing your own video), the following
happens in the primary video display as people join the session, transmit video or speak:
n

n

n

If you are the first person in the session, your primary video display will be blank. If you
click on the Transmit Video button, you will see your own transmission in the primary
video display.
When a second person joins the session, you will see their video transmission or, if they
are not transmitting video, their profile picture. It is assumed you will want to look at that
person, not yourself, regardless of who is speaking. (This happens even if neither of you
has spoken.)
As subsequent people transmit video or speak, their video transmissions or profile pictures
are added as thumbnails.
Note: There is one exception: if neither of the first two parties is
transmitting video, when a third person joins the session, the
primary video display will go blank until someone transmits video or
speaks.

n

Video

When someone speaks, your primary video display will always show either the profile picture or the video transmission of the person currently speaking or, if no one is speaking,
the last person to speak (even if that speaker has left the room).
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Note: When someone is transmitting video while you are previewing your
own video, the received video will be displayed in a thumbnail and the
video from your camera will be displayed in your primary video display.
In the example below, Lisa is speaking (she doesn't have her video camera turned on so you just
see her profile picture) and Vivian has her video camera turned on. Vivian's video is shown in a
thumbnail below the primary video display.
Tip: Hover your mouse over a thumbnail to display a "tool tip" containing
the transmitter’s name.

Multiple Simultaneous Cameras
Sessions can be enhanced by having the video streams of multiple people displayed at once.
Blackboard Collaborate web conferencing has the capacity to show the transmissions of up to six
video cameras simultaneously. Moderators can disable multiple simultaneous cameras (by setting
the maximum allowed to one) or enable from two to six simultaneous cameras.
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When there is more than one simultaneous camera enabled, the video stream of one person will
appear in the primary video display. Everyone else's transmission will appear below the primary
display in thumbnails, up to a maximum of five thumbnails.

1 Primary Video Display
2 Thumbnails
For a discussion of what you will see (by default) in the primary video display as more people
transmit video, see The Default Views on page 77. For a discussion of how you can change that
display, see Controlling the Primary Video Display below.

Controlling the Primary Video Display
The primary video display can be controlled in three ways:
n

setting the Make Video Follow Moderator Focus option,

n

setting the Make Video Follow Speaker option, and

n

by manually selecting what to display.

The Make Video Follow Moderator Focus option is set by Moderators only and overrides an
individual's Make Video Follow Speaker option. Both options override a person's ability to
manually select what video stream to show in the primary video display.
Note: When images change in the primary video display, they may be a
bit fuzzy for a few seconds while the server changes the resolution of the
new image from low (which is what is used for thumbnails) to a higher
resolution (which is used in the primary display).
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Make Video Follow Moderator Focus

Moderators can use the Make Video Follow Moderator Focus option to force everyone in the
room to see the same thing in their primary video display as what the Moderator is seeing in his
or her primary video display. This option overrides all other methods of controlling the primary
video display.

Make Video Follow Speaker

By default, the option to Make Video Follow Speaker is turned on. When it is turned on (and a
Moderator has not turned on Make Video Follow Moderator Focus), the primary video display
will always display either the profile picture or the video transmission (and the name) of the
person currently speaking or, if no one is speaking, the last person to speak (even if that person
has left the room). The Moderator option Make Video Follow Moderator Focus always
overrides this option.
If you want to manually select the image to be shown in the primary video display, turn off
Make Video Follow Speaker. You can do so in two ways (provided the Moderator doesn't have
Make Video Follow Moderator Focus turned on):
o

From the Tools menu, select Video and then Make Video Follow Speaker.

o

From the Audio & Video Options menu, select Make Video Follow Speaker.

To turn the option back on, just repeat the process.

Manually Selecting What to Display

If Make Video Follow Moderator Focus and Make Video Follow Speaker are turned off, you
can manually control what is displayed in your primary video display. To move a thumbnail
image into the primary video display, simply click on the thumbnail.
The image that was originally in the primary display will move to the thumbnail in which the
moved image previously resided – the images swap places.
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Multi-Camera Video in Recordings
If a session with multiple simultaneous cameras is recorded, you cannot choose who’s video
stream to display in the primary video display as you would in a live session. By default, the video
stream of the current speaker is displayed in the primary video display unless, in the live session,
a Moderator had turned on the option Make Video Follow Moderator Focus, in which case the
video stream of the Moderator is displayed in the primary video display.

Sending a Video Image to the Whiteboard
If you want to take a snapshot of an image in your primary video display, you can do so in one of
the following ways:
o

From the Tools menu, select Video and then Send Camera Snapshot to Whiteboard.

o

From the Audio & Video Options menu, select Send Camera Snapshot to Whiteboard.

The image you “snap” is placed in the foreground of the current page of the Whiteboard. You
can manipulate it like you would any other Whiteboard image.
Note: For Participants to use this feature, they must have Whiteboard
permissions.

Tip: If you want to take a snapshot of an image in a thumbnail
(simultaneous cameras), you must move the thumbnail image into the
primary video display and then take a snapshot. (For details, see
Controlling the Primary Video Display on page 79.)
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Stopping Video Transmission
To stop transmitting video, do one of the following:
o

Click on the Video button in the Audio & Video panel.

o

Enter the keyboard shortcut Ctrl+F3 (Command-F3 on Mac).
Tip: This keyboard shortcut is a "hot key", meaning you can
redefine it. You are actually able to configure two hot keys for the
Video button: one to turn it on and one to turn it off. For details,
see Hot Keys on page 40.

o

Click on the Preview button. You will continue to see video images, but others in the session will not.

To stop previewing video, click on the Preview button in the Audio & Video panel.
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Chapter 7
Chat
The Chat panel enables you to exchange text messages with others in the session. It has the
following components:

1 Expand/Collapse button

4 Options menu

2 Message text box

5 Conversation pane

3 Conversation tabs

6 Emoticon menu
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You will know someone is entering a Chat message when the blue Chat activity indicator ( )
appears next to their name in the Participants list. In the example below, Ethel and Lisa are
entering Chat messages. (For details about activity indicators, see Chat Activity and Permission
Indicators below.)

If the message text box in your Chat panel, says "Send a chat to the Moderator", the menu
option Send a Private Chat in a selected person's Option menu is disabled or the Chat
permission "off" indicator is displayed next to your name in the Participants list (see Chat
Activity and Permission Indicators below), it means you do not have permission to use Chat.
You will, however, always be able to read Chat messages and send a message to the Moderators.
For instructions, see the Participant's Guide.
Note: For information on working with panels, see Working with Panels
on page 29

Chat Activity and Permission Indicators
You can monitor the state of Chat activity and permissions through indicators displayed in the
Participants list of the Participants panel. These indicators are described in the following table.
For details about permissions, see Understanding Permissions on page 48.

Activity
Indicator

Meaning

User is typing a Chat message.
Chat permission is set globally to "on" but Moderator has revoked Chat permission from this user.
Chat permission is set globally to "off" but Moderator has granted Chat
permission to this user.
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Viewing Chat Messages
New Chat messages appear at the bottom of the conversation pane of the Chat panel. You can
scroll back and forth to read messages in the conversation pane.
1 Vertical scroll bar
2 Scroll thumb
3 Horizontal scroll bar

When a new message arrives,
l

l

if the scroll thumb is at the bottom of the scroll bar (the last Chat message is visible), the
conversation pane will scroll as new messages are received; but
if you had scrolled back to review earlier messages, the conversation pane will not scroll
when new messages are received – you must manually scroll to the bottom to see the new
message.
You have the option of turning off event messaging in the Chat
conversation pane. For details, see Turning Off Event Messages on next
page.

New Messages in Other Conversation Tabs
If you are not in a conversation when a message arrives, you will see a New Message Indicator
(Chat bubble) in the tab of that conversation. Simply click on the tab to read your message. (For
details on conversation tabs, see Conversation Tabs on next page.)

Also, if you have the Chat Message Received audible notification turned on, you will hear an
alert sound.
Tip: You can turn audible notifications off. For details, see Setting
Notification Preferences.
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Turning Off Event Messages
The Chat conversation pane, by default, gives you event information about who has entered or
left the Main room and breakout rooms. If you do not want to view this information, you can
turn it off. To do so, unselect Show Event Messages in the Chat Options menu.

Conversation Tabs
When chatting in Blackboard Collaborate, you can participate in more than one Chat
conversation at a time. These conversations take place in conversation tabs at the bottom of the
Chat panel. When a session begins, there are no conversation tabs.

When a new private conversation is initiated (by you or by someone else with you), a new
conversation tab is added to the bottom of the Chat panel for that conversation and a Room
conversation tab added for the room you are in (Main room or breakout room).
Note: In some sessions, private chatting between Participants may be
disabled. You will always be able to sent private Chat messages to
Moderators.

Note: Sending and receiving private chat messages is not supported on
mobile devices.
As more private chat conversations are initiated, more tabs are opened. When you run out of
space for more tabs, new conversation tabs are added to a list on the right side of the Chat panel.
Just click on the double arrow icon to open the list of hidden conversation tabs.

1 Click to read new messages
2 Click to open hidden tabs
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Note that, when there is a new Chat message in a conversation (one in which you are currently
not participating), a New Message Indicator (Chat bubble) is displayed in its tab. In the example
above, there is a new message in the conversation with Lucy.

Moving Between Conversations

You can move freely between conversations simply by clicking on the conversation tabs or, for
private conversations, double-clicking on the name of the person with whom you are
conversing. You will be able to catch up on all the messages others entered while you were away.

Closing Conversation Tabs

To close a conversation tab, hover your mouse over the people/person icon in the tab until it
changes to an X. Click on the X to close the conversation tab.

Changing the Text Size in the Conversation Pane
You can set the font size of the text in the conversation pane anywhere from 7 points to 109
points, in increments of 2 points. The default value is 13 points, which may be influenced by
your system-wide font defaults.
To increase the font size, do one of the following
o

From the Tools menu, select Chat and then Increase Font Size.

o

From the Chat Options menu, select Increase Font Size.

To decrease the font size, do one of the following
o

From the Tools menu, select Chat and then Decrease Font Size.

o

From the Chat Options menu, select Decrease Font Size.

Sending Chat Messages
With Chat, you can send the following types of messages:
l

l

Chat

public messages to everyone in your current room (Main room or breakout room). For
details, see Sending Messages to Everyone in a Room or Existing Group Conversation on
next page
private messages to one or more selected individuals. This will initiate a new conversation in its own tab. For details, see Sending Messages to Selected Individuals on next
page
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Note: Sending and receiving private chat messages is not supported on
mobile devices.

Sending Messages to Everyone in a Room or Existing Group Conversation
1. If the desired room tab or existing group conversation tab is not in focus, move to it. (For
details, see Moving Between Conversations on previous page.) Go directly to step 3 since
your cursor will already by in the message text field.
Note: To start a new group conversation, see Sending Messages to
Selected Individuals below.
2. If it isn't already there, place your cursor in the message text field by doing one of the
following:
o

Click anywhere in the message text field.

o

Press Ctrl+M (Command-M on Mac).

3. Enter your text in the message text field. (You can type it or copy and paste from an
external source.)
4. Press Enter to send your message. The message will appear in the conversation pane and,
if session attendees have the Chat Message Received audible notification turned on, they
will hear a ding.
Tip: You can turn audible notifications off. For details, see Setting
Notification Preferences.

Sending Messages to Selected Individuals
You can send private Chat messages to a specific person or group of people by selecting their
names in the Participants list. These messages will appear to only yourself and those you selected
from the Participants list. There is one notable exception: when a session is supervised,
Moderators will be able to see the private messages of everyone.
Note: In some sessions, private chatting between Participants may be
disabled. You will always be able to sent private Chat messages to
Moderators.

Note: Sending and receiving private chat messages is not supported on
mobile devices.
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A note on Supervised sessions: Some sessions are supervised, meaning that Moderators
will be able to see the activity of everyone in the session. You will know a session is supervised
by the presence of the word "Supervised" in the title of the Chat panel.

When you are entering a "private" message, keep in mind that all Moderators can read it in
supervised sessions.
1. Initiate the message in one of the following ways:
o

(If sending to one person) Double-click on the name of the person in the Participants list.

o

(If sending to one person) Select the person's name in the Participants list and then
select Send a Private Chat from their Participant Option menu.

o

(If sending to multiple people) Select the names of the people in the Participants list
(using the standard Shift or Control methods), right-click (Control-click on Mac) on
the highlighted names to open the Participants Option menu and then select Send a
Private Chat.
Tip: Do not click on the Participant Option menu of any
individual – that will unselect all the others you've selected in
the Participants list.

2. Enter your text in the message text field. (You can type it or copy and paste from an
external source.)
3. Press Enter to send your message.
A new conversation tab will open in your Chat panel and the recipient's Chat panel. The
recipient will see a New Message Indicator (Chat bubble) in the tab and will need to click
on the new tab to read your message.

If the intended recipient has the Chat Message Received audible notification turned on,
they also will hear a ding.
Tip: You can turn audible notifications off. For details, see Setting
Notification Preferences.

Sending Chat Messages to Moderators
When you have Chat permissions, you can send messages to selected Moderators just as you
would to Participants. For details, see Sending Messages to Selected Individuals on page 88.
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When you do not have the Chat permission, you will not be able to send messages to anyone
except Moderators. These messages will be sent to all Moderators in the room. (You can't send
messages to individual Moderators by selecting them in the Participants list.)
You can tell if you do not have the Chat permission in three ways: the message text box in your
Chat panel will contain the text "Send a chat to the Moderator", the menu option Send a Private
Chat in a selected person's Option menu will be disabled and the Chat permission "off" indicator
may be displayed next to your name in the Participants list.
To send a message to all Moderators, do the following:
1. Enter your text in the message text field. (You can type it or copy and paste from an
external source.)

2. Press Enter to send your message.
A new conversation tab, containing your message, will open in your Chat panel and the Chat
panels of all Moderators. The Moderators can reply to you by opening that conversation tab.

Adding Emoticons to your Chat Message
Emoticons are special graphical icons that you can insert into any text-based chat to make your
conversations more expressive and fun.
You can add emoticons to your Chat messages by selecting them from the Chat Emoticon menu
or by entering text strings in the Chat message text field. The text string equivalent of the
emoticon selected in the Emoticon menu is displayed in the bottom left corner of the menu.
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Note: If you do not see the Chat Emoticon menu, it means a Moderator
has disabled Chat emoticons. You can still type the text string equivalents
of emoticons in the message text box but they won't be converted to
icons. For example, when you type ;-), others in the session will see ;-)
rather than .
The following table lists a few of the most popular emoticons and their respective text strings. (A
full list of the text strings used for entering emoticons is available in Appendix A, Chat Emoticon
Text Strings.)
Note: The emoticon text strings are not case sensitive, so you can use
either upper case or lower case letters to enter your emoticons.

Emotions

Icons

Text strings

Smiley

:) or :-)

Wink

;) or ;-)

Sad

:( or :-(

Surprised

:-o or :-O

Confused

:/ or :-/

Grin

:D or :-D

Angry

:@ or :-@

Thumbs up

(y)

Thumbs down

(n)

Adding External Links to your Chat Message
You can include HTTP links in your Chat messages either by typing them in directly, copying
and pasting them or dragging and dropping them from a browser or email message. Recipients
of your messages will be able to click on the links to open web sites in their default browsers.
Link Type

Syntax

Example

HTTP web site

http://

http://www.blackboard.com

Secure HTTP web site

https://

https://addons.mozilla.org/
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Saving Chat Conversations to a File
You can save a Chat conversation to a text file to review at a later time. If you made the
date/time stamps visible, these will be saved to the text file as well.
1. Move to conversation you want to save. (For details, see Moving Between Conversations
on page 87.)
2. Open the Save Chat Conversation dialog by doing one of the following:
o

From the File menu, select Save and then Chat Conversation….

o

Enter Ctrl+S (Control-S on Mac). The Save dialog appears. Select Chat Conversation
and click on Save.

3. Enter a file name and select the location to which you want to save the file.
4. Click Save.
All Chat files are saved as text (.txt) files. There are no other file types supported. You can use
Notepad, WordPad or any word processing application to read the text file.
Note: You cannot load the file back into the Blackboard Collaborate web
conferencing Chat panel.
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Chapter 8
Audio
The Audio feature enables you to participate in conversations during a Blackboard Collaborate
web conferencing session using a microphone and speakers (or headset) via Voice over Internet
Protocol (VoIP). If your organization offers teleconferencing services with Blackboard
Collaborate, you can use the Telephony (telephone conferencing integration) feature for your insession communications. For details, see Chapter 9, Teleconferencing.
Note: Mobile device users cannot use a teleconference for Audio
communications in a session. For a list of features supported on mobile
devices, see Attending Sessions on Mobile Devices on page 23.
Audio shares a panel with Video in the Blackboard Collaborate interface. The panel has the
following components relevant to Audio:
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1 Expand/Collapse button

5 Options menu

2 Microphone Level indicator and slider

6 Primary video display

3 Talk button

7 Speaker Level indicator and slider

4 Audio Setup Wizard button
You will know someone has their microphone turned on (has activated the Talk button) when
the blue Audio activity indicator ( ) appears next to their name in the Participants list. (For
details on activity indicators, see Audio Activity, Permission and Status Indicators on page 95.)
In the example below, Vivian and Lisa have their microphones turned on.

You may see the Video transmission or the profile picture (or default profile icon) of the person
currently speaking in the primary Video display. The display will also show their name. Whether
or not you see this depends on the configuration of the Video display. For details, see Viewing
Video on page 76.
Note: For information on working with panels, see Working with Panels
on page 29.
If the Talk button is disabled (grayed out) in your Audio & Video panel, it means you do not have
permission to use Audio. You can always receive audio and adjust your microphone and speaker
levels, but you need the Audio permission in order to send audio. (For information on
permissions, see Understanding Permissions on page 48.)

94

Audio

Audio Activity, Permission and Status Indicators
You can monitor the state of Audio activity and permissions through indicators displayed in the
Participants list of the Participants panel.

Activity and Permission Indicators
The following table describes the icons displayed in the Participant list to indicate Moderator
and Participant permissions and activity while using Audio or Telephony. (For details on
Telephony, see Chapter 9, Teleconferencing.)
For details about permissions, see Understanding Permissions on page 48.
Activity
Indicator

Meaning

User has turned on his/her microphone. (Using VoIP for Audio.)
Audio permission is set globally to "on" but the Moderator has revoked Audio permission from this user.
Audio permission is set globally to "off" but the Moderator has granted Audio permission to this user.
User is running the Audio Setup Wizard.
The Teleconference Bridge participant is connected and the telephone
conference is available to users.
The Teleconference Bridge participant is connected but has had its Audio permission removed and, therefore, the teleconference is muted.
User is using Telephony mode for audio communications. (Using the phone for
Audio.)
User is using Telephony mode for audio communications (using the phone for
Audio) but the teleconference is muted.

Audio
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Status Indicators
Status indicators appear on the Audio activity indicator icons of Audio users in the Participants
list if there are delays in the receipt of Audio or if the talker or listener is not responding to the
Audio service.
Note: All Talkers see status indicators for all listeners, Moderator
listeners see status indicators for all listeners (including themselves) and
Participant listeners see status indicators for themselves only. There are
no status indicators shown next to Talkers. (There is one exception: if
there are multiple simultaneous talkers, a person can be a talker and
listener at the same time, so “talkers” may see status indicator for
themselves – but only because they are also “listeners”.)
n
n

Amber Indicator: Appears when a listener's receipt of audio is delayed.
Red Indicator: Appears when a talker or listener is experiencing a significant delay (is
non-responsive) and may be offline from the session. This may indicate a problem with
the network connection and often will be followed by the user getting disconnected from
the session.

In the example to the right,
n
n

n

n

Charlie is talking,
Ricky is experiencing a moderate delay in
receiving Audio,
Vivian is experiencing a significant delay in
receiving Audio, and
Ethel is not having any problems receiving
Audio.

Basic Audio Configuration
Generally speaking, it is recommended that you configure your Audio before the session begins.
There are a number of Audio settings that you can configure but you will likely only need to set
your microphone and speaker levels (see Using the Audio Setup Wizard on page 97).
The other available configuration items are advanced and, in most cases, you probably won’t
need to modify them. However, if you wish to modify the advanced Audio settings, you can do
so in the Preferences dialog. (For details, see Advanced Audio Configuration on page 101.)
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Using the Audio Setup Wizard
The Audio Setup Wizard is a tool you can use to verify that your Audio is set up correctly. It is
comprised of a series of panels that guide you through selecting Audio input (microphone) and
output (speaker) devices and setting your speaker and microphone volumes. We encourage
everyone to run the wizard prior to the start of the session.
Tip: To run the Audio Setup Wizard before your session begins, either join your session early
or open the Configuration Room on the Blackboard Collaborate Support Portal:
http://support.blackboardcollaborate.com
To open the Configuration Room, browse to First Time Users and then to Step 2 under
Blackboard Collaborate Web Conferencing.
You can run the Audio Setup Wizard again at any time within your session.
Note: When you are using the Audio Setup Wizard during a session, you
will not be able to hear any of the session Audio. Others will know you
can't hear them because the Audio Setup Wizard icon
will appear next
to your name in the Participants list.
To open the Audio Setup Wizard, do one of the following:
o

Click on the Audio Setup Wizard button at the top of the Audio & Video panel.

o

From the Tools menu select Audio and then Audio Setup Wizard.

o

From the Audio & Video Options menu, select Audio Setup Wizard.

On Windows or Linux

1. Select your audio output device (speakers), following the instructions given in the dialog
box. (For further details on selecting an audio output device, see Selecting a Speaker
Device on page 110.)
2. Play the recorded audio message provided and adjust your speaker volume to a suitable
level. (Follow the instructions given in the dialog box.)
3. Confirm whether or not your speaker was set to an appropriate level.
n
n
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If you clicked on Yes, go to step 4.
If you clicked on No, you are prompted to try again or cancel. Click on Try Again
to go back to step 1.
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4. Select an audio input device (microphone), following the instructions given in the dialog
box. (For further details on selecting an audio input device, see Selecting a Microphone
Device on page 102.)
Note: Whichever microphone you select here will become the
selected microphone in the Microphone Settings Preferences
dialog.
5. (Linux only) Select your microphone type to get the best results when testing your
microphone.
n

n

Single Talker: Select this option if using a headset or a microphone just for yourself.
Multiple Talkers: Select this option if using a single microphone to pick up multiple
talkers, such as when you are in meeting room sharing the microphone with others.
This is the default.

6. Press Record and adjust your microphone recording level as you speak into the microphone (audio input device). (Follow the instructions given in the dialog box.) Press Stop
when you are done.
7. Press Play to listen to the recording you just made and, based on the loudness and clarity
of the recording, determine if your microphone was set to an appropriate level.
8. Confirm whether or not your microphone was set to an appropriate level.
n
n

If you clicked on Yes, go to step 8.
If you clicked on No, you are prompted to try again or cancel. Click on Try Again
to go back to step 4.

9. Read the message in the dialog box and click on OK to complete Audio setup and exit the
Audio Setup Wizard.

On Mac OS X

1. Mac users cannot change their audio output (speaker) devices directly in Blackboard Collaborate web conferencing – Blackboard Collaborate uses the system default device. To
change your output device, click on the speaker icon in the Select Audio Output Device
dialog of the Audio Setup Wizard and make your changes in the System Preferences
Sound Output panel. (For further details on selecting an audio output device, see Selecting
a Speaker Device on page 110). When done, click on OK to advance to the next panel of
the wizard.
2. Play the recorded audio message provided and adjust your speaker (audio output device)
volume to a suitable level. (Follow the instructions given in the dialog box.)
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3. Confirm whether or not your speaker was set to an appropriate level.
n
n

If you clicked on Yes, go to the next step.
If you clicked on No, you are prompted to try again or cancel. Click on Try Again
to go back to step 1.

4. Select an audio input (microphone) device from the list or select the option Use System
Default Device. Follow the instructions given in the dialog box. (For further details on
selecting an audio input device, see Selecting a Microphone Device on page 102.)
5. (Mac OS X 10.5 and earlier only) Select your microphone type to get the best results when
testing your microphone.
n

n

Single Talker: Select this option if using a headset or a microphone just for yourself.
Multiple Talkers: Select this option if using a single microphone to pick up multiple
talkers, such as when you are in meeting room sharing the microphone with others.
This is the default.
Note: Whichever microphone you select here will become the
selected microphone under Microphone Settings Preferences
dialog.

6. Press Record and adjust your microphone recording level as you speak into the microphone (audio input device). (Follow the instructions given in the dialog box.) Press Stop
when you are done.
7. Press Play to listen to the recording you just made and, based on the loudness and clarity
of the recording, determine if your microphone was set to an appropriate level.
8. Confirm whether or not your microphone was set to an appropriate level.
n
n

If you clicked on Yes, go to the next step.
If you clicked on No, you are prompted to try again or cancel. Click on Try Again
to go back to step 3.

9. Read the message in the dialog box and click on OK to complete Audio setup and exit the
Audio Setup Wizard.

Using Your Microphone
You can turn on your microphone in one of two ways:
o

Click on the Talk button in the Audio & Video panel.

o

Enter the keyboard shortcut Ctrl+F2 (Command-F2 on Mac).

Audio
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Tip: This keyboard shortcut is a "hot key", meaning you can redefine it.
You are actually able to configure two hot keys for the Talk button: one to
turn it on and one to turn it off. For details, see Hot Keys on page 40
To turn your microphone off, again click on the Talk button or use the keyboard shortcut.
Notice that, when off, your Talk button contains the word Talk only but, when activated, also
displays a blue microphone.

1 Talk button off
2 Talk button on
You also may hear an audible notification when you activate or release your microphone.
Tip: You can turn audible notifications off. For details, see Setting
Notification Preferences.

Tip: If your Talk button is inaccessible (grayed out) it may be because a
Moderator has removed your Audio permission, the maximum number of
simultaneous talkers has been reached or you are using the Telephony
feature for audio communications.

Adjusting Microphone and Speaker Levels
The microphone level indicator (microphone icon) shows the volume levels when you are
speaking and the speaker level indicator (speaker icon) shows the volume levels when someone
else is speaking.
Tip: If all talkers have their microphones set properly, listeners won’t
need to keep adjusting their speakers to accommodate changes in volume.
The best way to ensure proper microphone and speaker levels is to run
the Audio Setup Wizard at the beginning of the session. See Using the
Audio Setup Wizard on page 97.
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Microphone Level
There are four ways to adjust your microphone level:
o

Audio & Video panel: Grab the microphone level slider in the Audio & Video panel and
drag it to the right to increase the volume and to the left to decrease the volume.

o

Options menu: From Audio & Video Options menu, select either Adjust Microphone
Level Up (to increase the volume) or Adjust Microphone Level Down (to decrease the volume).

o

Tools menu: From the Tools menu, select Audio and then select either Adjust Microphone Level Up (to increase the volume) or Adjust Microphone Level Down (to decrease
the volume).

o

Keyboard Shortcuts: Enter Ctrl+Shift+Up Arrow (Shift-Command-Up Arrow on Mac)
to increase the volume or Ctrl+Shift+Down Arrow (Shift-Command-Down Arrow on Mac)
to decrease the volume.

Speaker Level
There are four ways to adjust your speaker level:
o

Audio & Video panel: Grab the speaker level slider in the Audio & Video panel and
drag it to the right to increase the volume and to the left to decrease the volume.

o

Options menu: From Audio & Video Options menu, select either Adjust Speaker Level
Up (to increase the volume) or Adjust Speaker Level Down (to decrease the volume).

o

Tools menu: From the Tools menu, select Audio and then select either Adjust Speaker
Level Up (to increase the volume) or Adjust Microphone Speaker Down (to decrease the
volume).

o

Keyboard Shortcuts: Enter Ctrl+Up Arrow (Command-Up Arrow on Mac) to increase
the volume or Ctrl+Down Arrow (Command-Down Arrow on Mac) to decrease the volume.

Advanced Audio Configuration
In most cases, you probably won’t need to modify the advanced Audio configuration settings
(the default settings should be adequate). However, if you wish to modify them, you can do so in
the Preferences dialog.

Audio
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For information on modifying the advanced Audio settings, refer to the following sections:
n

Selecting a Microphone Device below

n

Selecting a Speaker Device on page 110

n

Setting Level Controls on page 108

n

Suppressing Transmission of Silence on page 109

n

Muting Speakers When Talking on page 114

n

Setting the Sample Rate on page 110
Note: When you configure the Audio preferences, Blackboard Collaborate
web conferencing will remember these settings each time you join
another session.

Selecting a Microphone Device
The first time you use Blackboard Collaborate web conferencing, it will use the microphone
(audio input) device that is the system default at the time your session is launched. You can
select a different device through the Audio Setup Wizard or the Microphone Settings
Preferences dialog.
Tip: A headset with microphone works well for most Blackboard
Collaborate users as both their speaker device and microphone device.

Selecting a Microphone on Windows or Linux

You can change the microphone device in one of two places:
o

Audio Setup Wizard (see Using the Audio Setup Wizard on page 97)

o

Microphone Settings Preferences dialog (see Microphone Configuration on the facing
page)

The device you select will be used in all future sessions (provided it is available when you launch
Blackboard Collaborate) until you explicitly select a different device. Changing your system
default microphone device will not affect which device Blackboard Collaborate will use.
Tip: If you join a Blackboard Collaborate session when no microphone
device is connected, you don’t have to run the Audio Setup Wizard or use
the Microphone Settings Preferences dialog. Just connect your device
and, after the system recognizes the new device, click on the Talk button
– Blackboard Collaborate will automatically connect to the device. You
may need to adjust your microphone level.
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Selecting a Microphone on Mac OS X

You can change the microphone device in one of two places:
o

Audio Setup Wizard (see Using the Audio Setup Wizard on page 97)

o

Microphone Settings Preferences dialog (see Microphone Configuration below)

You can make a change at any time during a session, except while you are talking. If you try to
select the input device from within Blackboard Collaborate when talking, you will get an error
message.
Tip: If you are talking, release the microphone, change the microphone
device and then re-engage the Talk button.
If you select the option Use System Default Device (selected by default), your Blackboard
Collaborate input device will change every time you change your system default. You can change
the system default any time during a Blackboard Collaborate session under System Preferences,
Sound panel, Input tab.
If you do not select the option Use System Default Device, the device you select will be used in
all future sessions (provided it is available when you launch Blackboard Collaborate) until you
explicitly select a different device or select the option Use System Default Device.

Microphone Configuration
The microphone configuration preferences vary slightly depending on which operating system
you are on. Read the section below appropriate to your operating system.

Windows and Mac OS X 10.6 and Later

Set the microphone configuration preferences as follows:
1. Open the Preferences dialog in one of the following ways:
o

From the Edit menu, select Preferences… (Windows)
From the Blackboard Collaborate web conferencing menu, select Preferences
(Mac OS X)

o

Enter Ctrl+Comma (Windows)
Enter Command-Comma (Mac OS X)

Audio
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2. In the left pane of the Preferences dialog, select Microphone Settings under Audio/Video.
The Microphone Settings preferences panel appears.
Note: The available audio input line options will vary depending on
your sound card.

3. Select your Microphone device from the input devices listed in the box. For a complete
discussion about microphone devices, see Selecting a Microphone Device on page 102.

104

Audio

4. Select the desired options:
n

n

n

(Mac only) Use System Default Device – Select this option if you want to use your
system's default input device. Each time you change the system default it will
change the microphone used by Blackboard Collaborate.
Cancel echo between microphone and speakers – Select this option if others are
reporting an echo from your audio transmission. (Echoes occur when the sound
from your speakers is being picked up by your microphone and retransmitted.) By
default, this option is enabled.
Adjust microphone volume automatically (up and down) – Select this option to enable Audio to automatically increase the microphone signal level when the volume is
too low and decrease the microphone signal level when the volume is too high. By
default, this option is enabled.
For further details, see Microphone Configuration on page 103.

n

Transmit all sound, even when it appears to be silence – Select this option if you
want audio transmission to continue in times of silence. By default, this option is disabled.
For further details, see Microphone Configuration on page 103.

n

Microphone Sample Rate – Select a sample rate from the option menu if your
microphone is being shared with other applications.
For further details, see Microphone Configuration on page 103.

5. Click on OK to save your preferences and close the Preferences dialog, Apply to save
your preferences and leave the Preferences dialog open or Cancel to close the Preference
dialog without saving any of your changes.
When you configure preferences, Blackboard Collaborate web conferencing will remember the
settings each time you join another session on the same computer.
Note: You can restore your preference settings to the default. For details
on restoring default preferences, see Restoring Default Preference
Settings on page 11.

Linux and Mac OS X 10.5 and Earlier

Set the microphone configuration preferences as follows.
1. Open the Preferences dialog in one of the following ways:
o

From the Edit menu, select Preferences… (Linux)
From the Blackboard Collaborate web conferencing menu, select Preferences
(Mac OS X)

o

Enter Ctrl+Comma (Linux)
Enter Command-Comma (Mac OS X)
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2. In the left pane of the Preferences dialog, select Microphone Settings under Audio/Video.
The Microphone Settings preferences panel appears.
Note: The available audio input line options will vary depending on
your sound card.

3. Select your Microphone device from the input devices listed in the box. For a complete
discussion about microphone devices, see Selecting a Microphone Device on page 102.
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4. Select the desired options:
n

n

(Mac only) Use System Default Device – Select this option if you want to use your
system's default input device. Each time you change the system default it will
change the microphone used by Blackboard Collaborate.
Amplify quiet sounds from microphone dynamically – Select this option to enable
Audio to automatically increase the microphone signal level when the volume is too
low. By default, this option is enabled.
For further details, see Microphone Configuration on page 103.

n

Adjust volume automatically to limit distortion – Select this option to enable Audio
to automatically reduce the microphone signal level when the signal peaks are excessive (volume is too high). By default, this option is enabled.
For further details, see Microphone Configuration on page 103.

n

To optimize the Adjust volume automatically to limit distortion control, select the
type of microphone you are using.
n

n

Microphone used by a single person: Select this option if using a headset or a
microphone just for yourself.
Microphone used by multiple people: Select this option if using a single microphone to pick up multiple talkers. This is the default.
Note: The first time you open the Microphone Settings
preferences panel, it may appear that Microphone used by a
single person is the default. This will be the case if you earlier
selected Single Talker in the Audio Setup Wizard; the
Microphone Settings preferences panel inherits this setting
from the Audio Setup Wizard.

n

Transmit all sounds, even when it appears to be silence – Select this option if you
want audio transmission to continue in times of silence. By default, this option is disabled.
For further details, see Microphone Configuration on page 103.

n

Microphone Sample Rate – Select a sample rate from the option menu if your
microphone is being shared with other applications.
For further details, see Microphone Configuration on page 103.

5. Click on OK to save your preferences and close the Preferences dialog, Apply to save
your preferences and leave the Preferences dialog open or Cancel to close the Preference
dialog without saving any of your changes.
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When you configure preferences, Blackboard Collaborate web conferencing will remember the
settings each time you join another session on the same computer.
Note: You can restore your preference settings to the default. For details
on restoring default preferences, see Restoring Default Preference
Settings on page 11.

Setting Level Controls

During a session, a microphone may receive a wide range of signal levels – from very soft to very
loud. For example, the signal gets louder or softer as you move to or away from the microphone.
When sharing a microphone between a number of people in a room, not only will the signal
vary with the distance of each talker from the microphone but also will vary with the volume of
individual talkers.
For optimal clarity, sound must stay within a certain volume range. Read the section below for
your operating system to learn how to maintain the optimal volume range.

Windows and Mac OS X 10.6 and Later

To remain within the optimal volume range, select the option Adjust microphone volume
automatically (up and down). If the microphone level is too low (making the sound inaudible)
or too high (making the sound distorted), this option kicks in and brings the volume within the
optimal range by adjusting the microphone volume slider up or down.
You can set Adjust microphone volume automatically (up and down) in the Preferences dialog.
For details, see Setting Level Controls on page 108.
Note: You may want to turn Adjust microphone volume automatically
(up and down) off if you have a microphone so sensitive that this option
is unable to fully control the signal and manual volume adjustment is
required.

Linux and Mac OS X 10.5 and Earlier

Within that range, if audio signals are too weak (e.g., you are too far from the microphone or are
talking very softly), Amplify quiet sounds from microphone dynamically will automatically
amplify the volume coming from the microphone (without moving the volume slider). It
provides a gain (increase in volume) of up to four times the signal level, which should be
sufficient to handle most circumstances. If it is insufficient, you should probably re-adjust your
microphone level slider.
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If the sound surpasses the optimal range (on either end), the Adjust volume automatically to
limit distortion option kicks in and brings the volume within the optimal range by adjusting the
microphone volume slider. If your microphone level is too high, causing distortion on loud
signals, the Adjust volume automatically to limit distortion option will automatically slide the
microphone level slider to the left until the signal no longer distorts. If you have selected
Microphone shared by multiple people rather than Microphone used by a single person, it also
can move the slider to the right to try to pick up quiet voices.
You can set the level controls Adjust volume automatically to limit distortion and Amplify quiet
sounds from microphone dynamically in the Preferences dialog. For details, see Setting Level
Controls on page 108.
When Not to Use Adjust volume automatically to limit distortion
The only time you may want to turn Adjust volume automatically to limit distortion off is if
you have a microphone so sensitive that Adjust volume automatically to limit distortion is
unable to fully control the signal and manual volume adjustment is required.
When Not to Use Amplify quiet sounds from microphone dynamically
If the ambient room noise is quite loud, Amplify quiet sounds from microphone dynamically
may raise the volume of the noise to a level that becomes bothersome to others. If this occurs,
turn this option off.

Suppressing Transmission of Silence

When the Talk button is pressed, bandwidth is being used. Bandwidth usage increases with
every user that has the Talk button pressed. The more bandwidth that is used for Audio, the less
bandwidth will be available for the other features such as Application Sharing, playing of
Multimedia files, etc. Even if no one is talking while the Talk button is pressed, audio is still
being transmitted.
By default, Blackboard Collaborate web conferencing will detect when no one is talking and will
stop the transmission of audio (suppress the silence), thereby reducing the amount of bandwidth
used.
If your microphone does not generate a sufficiently strong signal, your speech may be
erroneously detected as silence. If this is the case, silence suppression will cause your speech to
cut in and out. When this occurs, you should increase your microphone volume. If the volume is
at maximum, then you should enable Transmit all sound, even when it appears to be silence.
For details, see Suppressing Transmission of Silence on page 109.
Note: When enabled, Transmit all sound, even when it appears to be
silence does not become activated until there are at least three
simultaneous talkers.
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Setting the Sample Rate

Some systems that allow the microphone or speakers to be shared by multiple applications
require all applications to use the same audio sample rate.
If you have such a system, and you wish Blackboard Collaborate web conferencing to share the
microphone or speakers with another application (e.g., an email application that beeps when
you get new mail), you will need to set the Blackboard Collaborate preferred sample rate to the
other application’s sample rate – if the sample rates are different.
To set the sample rate for your microphone, see Setting the Sample Rate on page 110. To set the
sample rate for your speakers, see Speaker Configuration below.

Selecting a Speaker Device
The first time you use Blackboard Collaborate web conferencing, it will use the speaker (audio
output) device that is the system default at the time your session is launched.
If you are on a Windows or Linux system, you can select a different device through the Audio
Setup Wizard or the Speaker Settings Preferences dialog. If you are on Mac OS X, you can select
a different device by changing the system default.
Tip: A headset with microphone works well for most Blackboard
Collaborate users as both their speaker device and microphone device.

Selecting Speakers on Windows or Linux

You can change the speaker device in one of two places:
o

Audio Setup Wizard (see Using the Audio Setup Wizard on page 97)

o

Speaker Settings Preferences dialog (see Speaker Configuration on the facing page)

The device you select will be used in all future sessions (provided it is available when you launch
Blackboard Collaborate web conferencing) until you explicitly select a different device. Changing
your system default speaker device will not affect which device Blackboard Collaborate will use.
Tip: If you join a Blackboard Collaborate session when no speaker device
is connected, you don’t have to the run the Audio Setup Wizard or use the
Speaker Settings Preferences dialog. Just connect your device and, after
the system recognizes the new device, Blackboard Collaborate will
automatically connect to it. You may need to adjust your speaker level.
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Note: If you have been receiving audio before connecting your audio
output device, there will be a backlog of audio transmitted to you in an
accelerated “chipmunk” form until the backlog is cleared. Depending on
the degree of backlog, you may be given the opportunity (through a
confirmation dialog) to discard the backlog.

Selecting Speakers on Mac OS X

Blackboard Collaborate web conferencing uses the system’s current speaker device. To select a
different device, change the system default under System Preferences, Sound panel, Output tab.
Blackboard Collaborate will use that newly selected device the next time you join a session. You
can change your device while Blackboard Collaborate is running.
Tip: If sound is not being transmitted by your speaker, change to a
different device.

Speaker Configuration
Set the speaker configuration preferences as follows.
1. Open the Preferences dialog in one of the following ways:
o

From the Edit menu, select Preferences… (Windows & Linux)
From the Blackboard Collaborate web conferencing menu, select Preferences
(Mac OS X)

o

Enter Ctrl+Comma (Windows & Linux)
Enter Command-Comma (Mac OS X)

2. In the left pane of the Preferences dialog, select Speaker Settings under Audio/Video. The
Speaker Settings preferences panel appears.
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3. (Windows and Linux only) Select your Speaker device from the output devices listed in the
box. For a complete discussion about speaker devices, see Selecting a Speaker Device on
page 110.
Note: The available audio output device options will vary depending
on your sound card.

112

Audio

4. (Mac only) Blackboard Collaborate uses your system's default output device. To change it,
click on the Speaker button to open your System Preferences Sound Output panel and
select your new device there. For a complete discussion about speaker devices, see
Selecting a Speaker Device on page 110.

5. Set your Speaker options:
n

Mute speakers when “Talk” pressed to prevent feedback – Select this option to
mute the speakers when you have the Talk button pressed. By default, this option is
disabled.
For further details, see Muting Speakers When Talking on next page.

n

Speaker Sample Rate – Select a sample rate from the option menu if your speakers
are being shared with other applications.
For further details, see Microphone Configuration on page 103.
Mac Note: For optimal performance, Mac users should set
their speaker sample rate to 8000 Hz.
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6. Click on OK to save your preferences and close the Preferences dialog, Apply to save
your preferences and leave the Preferences dialog open or Cancel to close the Preference
dialog without saving any of your changes.
When you configure preferences, Blackboard Collaborate web conferencing will remember the
settings each time you join another session on the same computer.
Note: You can restore your preference settings to the default. For details
on restoring default preferences, see Restoring Default Preference
Settings on page 11.

Muting Speakers When Talking

If you are using a microphone and speakers rather than a headset, you may wish to mute the
speakers when you have the Talk button pressed so the microphone will not pick up any audio
feedback coming from the speakers. To mute your speakers, enable the preference Mute
speakers when “Talk” is pressed to prevent feedback. For details, see Speaker Configuration on
page 111.
Just be aware that, when this option is enabled and the Moderator has configured the
Blackboard Collaborate session to allow Simultaneous Talkers, when you have your Talk button
pressed, you will not be able to hear others speak until you release your Talk button.
Note: Some systems do not allow the microphone and the speakers to be
active at the same time. In this case, Mute speakers when “Talk” is
pressed to prevent feedback will be enabled and you won’t be able to
disable it.

Troubleshooting Audio Delays
In general, when others are experiencing Audio delays, you can continue to talk. Blackboard
Collaborate web conferencing will buffer the audio for those who have fallen behind and ensure
they are caught up to real-time. As they are catching up, they may hear the Audio in an
accelerated “chipmunk” form until the backlog is cleared.
Note: Depending on the degree of backlog, they may be given the
opportunity (through a confirmation dialog) to discard the backlog.
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Chapter 9
Teleconferencing
The Telephony feature of Blackboard Collaborate web conferencing enables you to conduct your
audio communications with other session attendees via teleconferencing, while continuing to
use your computer for all other Blackboard Collaborate features. As a teleconference user, you
will be fully integrated into the Blackboard Collaborate session: you can communicate with users
not connected via teleconference (the traditional microphone and speaker users) and your
communications will be captured in session recordings. (The visual elements of the Telephony
user interface, such as the icons that let you switch between using your microphone and
speakers to telephone for audio, and vice versa, will not be visible in the recording.)
You can use the Telephony feature for your in-session communications only if your organization
offers teleconferencing with Blackboard Collaborate.
Note: Mobile device users cannot use a teleconference for Audio
communications in a session. For a list of features supported on mobile
devices, see Attending Sessions on Mobile Devices on page 23.
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There are two types of teleconferencing services available in Blackboard Collaborate: one lets
you join a teleconference only if the Moderator has connected the session to the teleconference
and the other lets you join the teleconference at any time. Other than a slight difference in a
couple of dialog boxes, you will not notice any difference between the two types.

Joining a Teleconference
You will know you can join a teleconference by the presence of the
title bar of the Audio & Video panel:

Telephone icon in the

1. Open the Use Telephone for Audio dialog in one of the following ways:
o

From the Tools menu, select Telephony and then Use Telephone for Audio.

o

In the Audio & Video panel Options menu, select Use Telephone for Audio.

o

Click on the
Video panel.

Use Telephone for Audio button in the title bar of the Audio &

The Use Telephone for Audio dialog will open. It will look like the following,
perhaps with different phone numbers and PINs:

2. Using your telephone, dial the teleconference telephone number displayed in the Use Telephone for Audio dialog.
3. Enter the teleconference PIN as instructed by the teleconference (if required). If your teleconference, prompts you to enter your conference number followed by the # key, enter
your PIN as the "conference number".
4. When you’ve successfully connected to the teleconference, click on OK in the Use Telephone for Audio dialog.
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Note: You will know you are connected when you hear (via your
telephone connection) the teleconference announcement, which may be
a recorded message or an audio signature of some sort. With Integrated
Telephony, you will hear a chime and "The web session has joined the
teleconference." For specific details on what announcement you should
expect with Third Party Provider Telephony, contact your teleconference
administrator.
When you are connected to the teleconference, in the Audio & Video panel, the word
Teleconferencing... appears at the bottom and the Use Telephone for Audio button in the title
bar changes to the
Use Microphone and Speakers for Audio button.

You also will see the Teleconference activity indicator
Participants list.

appear next to your name in the

Note: When you are using Telephony mode, your Talk button will be
disabled.

Activity Indicators
You can monitor the state of Audio and Telephony activity and permissions through indicators
displayed in the Participants list of the Participants panel.
The following table describes the icons displayed in the Participant list to indicate Moderator
and Participant permissions and activity while using Telephony or Audio. (For details on Audio,
see Basic Audio Configuration.)
For details about permissions, see Understanding Permissions on page 48.
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Activity
Indicator

Meaning

User has turned on his/her microphone. (Using VoIP for Audio.)
The Teleconference Bridge participant is connected and the teleconference is
available to users.
The Teleconference Bridge participant is connected but has had its Audio permission removed and, therefore, the teleconference is muted.
User is using Telephony mode for audio communications. (Using the phone for
Audio.)
User is using Telephony mode for audio communications (using the phone for
Audio) but the teleconference is muted.

Leaving a Teleconference
To leave a teleconference and once again use your microphone and speakers for Audio, do the
following:
1. Open the Use Microphone & Speakers for Audio dialog in one of the following ways:

118

o

From the Tools menu, select Telephony and then Use Microphone & Speakers for
Audio.

o

In the Audio & Video panel Options menu, select Use Microphone & Speakers for
Audio.

Teleconferencing

o

Click on the
Use Microphone and Speakers for Audio button in the title
bar of the Audio & Video panel.

The Use Microphone & Speakers for Audio dialog will open. It will look like the
following, perhaps with different phone numbers and PINs:

2. Click OK to leave the teleconference.
3. Hang up your phone.
When you have left the teleconference, the word Teleconferencing... is removed from the
bottom of your Audio & Video panel and the Teleconference activity indicator is removed
from next to your name in the Participants list.

Teleconferencing
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Chapter 10
The Whiteboard
The Whiteboard is the most commonly used (and default) mode of the Blackboard Collaborate
web conferencing Content area. It is used for giving presentations (e.g., PowerPoint slides) and
for collaboration between session attendees, who can interact by displaying images, writing, or
drawing.
If you have permission to use the Whiteboard drawing tools, the Tools palette appears in the
Whiteboard Content area.
Note: Mobile device users can only view the Whiteboard, not add content
or navigate through its pages. For a list of features that are supported, see
Attending Sessions on Mobile Devices on page 23.
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The Whiteboard has the following components:

1 Whiteboard Action bar

6 Information menu

2 Collaboration toolbar

7 Whiteboard Page

3 Web Tour Mode button

8 Properties Editor palette

4 Scaling menu

9 Tools palette

5 Page name
When someone is loading content into the Whiteboard or using the Whiteboard tools, the blue
Whiteboard activity indicator ( ) appears next to their name in the Participants list. In the
example below, the Moderator Vivian is loading a presentation into the Whiteboard. (For details
on activity indicators, see Whiteboard Activity and Permission Indicators on page 124.)
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Whiteboard Mode
In order to use the Whiteboard, the Content area must be in the Whiteboard mode. The
Whiteboard mode is the default mode when a session begins.
Only certain users can switch between modes:
n
n

n

Moderators can switch between all modes.
Participants with Application Sharing permission can switch to Application Sharing mode
and back to Whiteboard mode.
Participants with Web Tour permission can switch to Web Tour mode and back to Whiteboard mode.

For details on modes, see The Content Area Modes.
Caution: If you are in a session that has more than one Moderator, be
careful not to inadvertently switch modes on another Moderator who is
presenting content. Everyone in the session will follow you to the new
mode.
If you are not already in Whiteboard mode, you can switch to it in one of the following ways:
o

In the Collaboration toolbar, click the Whiteboard Mode button.

o

In the View menu, select Whiteboard.

o

Enter the keyboard shortcut Ctrl+Alt+W (Command-Option-W on Mac).

Scaling the Whiteboard Page
Whiteboard pages can be many times smaller or larger than the Content area. In order to make
the canvas appear at the size most useful, the page can be scaled using the Scaling menu in the
Whiteboard action bar.
Click the menu and select the desired scale factor. If the
preferred factor is not available by default, click Custom… to
enter type a factor into the dialog.
If Fit Page is selected, the page is automatically scaled as large
or as small as it needs to be in order to fit into the Content area.
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Maximizing the Content Area
Your other option is to resize the Whiteboard Content area.
You can optimize the space available in the Content area in two ways; for maximum space, do
both:
o

Maximize your Blackboard Collaborate web conferencing window.

o

Hide the side bar (Audio & Video, Participants and Chat panels) by unselecting Show Side
Bar in the View menu or by grabbing the border of any one of the panels and dragging it
all the way to the left.

To restore the side bar, reselect Show Side Bar or drag the panel border back to the right.

Whiteboard Activity and Permission Indicators
You can monitor the state of Whiteboard activity and permissions through indicators displayed
in the Participants list of the Participants panel.
The following table describes the icons displayed in the Participant list to indicate Moderator
and Participant permissions and activity while using the Whiteboard.
Activity
Indicator

Meaning

User is loading content into the Whiteboard or using the Whiteboard tools.
Whiteboard permission is set globally to "on" but the Moderator has revoked
Whiteboard permission from this user.
Whiteboard permission is set globally to "off" but the Moderator has granted
Whiteboard permission to this user.

Adding Content to the Whiteboard
A number of different kinds of content can be added to the Whiteboard. Everyone in the session
can add objects using the Tools Palette (see The Tools Palette on page 124) and Moderators can
load image, PowerPoint, OpenOffice and Whiteboard files.

The Tools Palette
The Tools palette contains drawing and text tools you can use to create and manipulate objects
in the Whiteboard workspace. It also has a pointer tool, a tool to place screen captures on the
Whiteboard and a clip art tool to add images from available clip art libraries.
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Tools in the palette with a tabbed lower right corner have additional optional tools that can be
swapped into their spot. Click and hold or double-click (depending on your operating system)
the tool to expand the options.
Participants have access to the Whiteboard tools if they have been granted the Whiteboard tools
permission (see Understanding Permissions).
1

Selector tool

2

Pointer tools

3

Pencil tool

4

Text editor tool

5

Filled shape tools

6

Empty shape tools

7

Line tool

8

Screen capture tool

9

Clip art tool

10

Highlighter tool

11

Simple text tool

The Properties Editor

When you click on any of the text or drawing tools in the Whiteboard's Tools palette, the
Properties Editor palette will appear at the bottom of the Whiteboard. From here you can
format your text or graphic by specifying various properties. The contents of the Properties
Editor palette changes depending on which tool is being used or which objects are selected. For
example, if you are using the Filled Ellipse or Filled Rectangle tool, the Properties Editor will
present color buttons only.

The Properties Editor for the Simple Text and Text Editor tools contains buttons to set color,
font, size and style properties.

Note: If you select two (or more) different kinds of objects, the
Properties Editor palette will display only those attributes common to all
of the objects.

The Whiteboard

125

Tip: When selecting the color of an object through the Properties Editor,
click outside the color palette once to close the palette and then click a
second time to start drawing.

Inserting Text

The Whiteboard has two text tools. The Simple Text tool creates text as an object directly on the
canvas. The text can be manipulated just like a shape or image in a graphic design program. The
Text Editor tool creates a bounding box for text, and the text inside can be edited as in a word
processor or publishing program.
Using the Simple Text Tool

Follow the steps below to enter a single line of text:
1. Click on the

Simple Text tool.

If the Simple Text tool is not in the Tools Palette, click and hold the

Text Editor tool

until it expands to reveal the Simple Text tool icon, the click on the Simple Text tool.
2. Select the font name, color, size, bold, underline and/or italics from the Properties Editor.

3. Click the Whiteboard to place an insertion point, and then type the text.
4. Press Enter when you are done typing the line of text.
Note: The Simple Text Tool lets you type only one line of text at a time.
You cannot insert a line break and the text does not automatically wrap to
the next line when it reaches the edge of the Whiteboard page, as the Text
Editor does.
Using the Text Editor Tool

Follow the steps below to enter multiple lines of wrapping text:
1. Click on the

Text Editor tool.

If the Text Editor tool is not in the Tools Palette, click and hold the

Simple Text tool

until it expands to reveal the Text Editor tool icon, then click on the Text Editor tool.
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2. Single-click on the Whiteboard to create a text box of the default size (250 x 70 pixels).
Alternatively, click and hold down the mouse button as you drag the cursor to create a text
box of the desired size. Either way, the Properties Editor will appear at the bottom of the
Whiteboard.
3. Select the font name, color, size, bold, underline and/or italics from the Properties Editor.
4. Type your text, pressing Enter when you want to create a new line of text within the text
box.
Note: If the amount of text you type exceeds the space available in the
text box, a scroll bar will appear on the right side of the text box. If you
don’t want the scroll bar, resize the text box to display all the text.

Note: The maximum number of characters that can be entered in a Text
Editor object is 10,000.
Inserting External Links

You can insert links into Whiteboard text using either the Simple Text tool or the Text Editor
tool. Anyone viewing your Whiteboard page will be able to click on your links to access an
Internet site or send an email.
Note: To enter a link using the Simple Text tool, do not enter any text
except that contained in the link. If you do, the link will not work.

Link Type

Syntax

Example

HTTP web site

http://

http://www.blackboardcollaborate.com

Secure HTTP web site

https://

https://addons.mozilla.org/

FTP site

ftp://

ftp://ftp.linuxfocus.org/

Email message

mailto:

mailto:docs@blackboard.com

Note: To launch a link, pass over the link with the Selection tool. The
pointer will change to a hand. Single click on the link with the hand
pointer. The application that opens the link will be specific to your
system.

The Whiteboard

127

Inserting Special Symbols and Characters (Windows only)

To type a special symbol or character on the Whiteboard, locate the ANSII numeric code for the
special symbols or character that you want to type (for a list of all available codes, see Appendix
B, 1252 Windows Latin 1 (ANSI)) and follow these steps:
1. Select the Simple Text tool or Text Editor and click on the Whiteboard where you want to
insert the symbol or character.
2. Make sure NUM LOCK is on.
3. Hold down the Alt key and then, using the numeric keypad, type the numeric character
code for the character that you want to type. For example, to place the copyright symbol
on the Whiteboard hold down the Alt key and enter the numeric character code 0169.
Note: Some special characters only can be typed using Bold text. If
the character you want does not appear when you enter the
character code, select the character you typed and choose Bold
from the Properties Editor.
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Inserting Graphics

Use the following tools to insert graphics into the Whiteboard.
Tool

Options

Freehand

Line

Select the color, transparency, and line thickness from
the Properties Editor.

Select the color, transparency, and line thickness from
the Properties Editor.

Filled Shapes
(rectangle and ellipse)

Empty Shapes (rectangle and ellipse)

Select the color and transparency from the Properties
Editor.

Select the color, transparency, and line thickness from
the Properties Editor.

Tip: Holding down the Shift key while drawing the line will result in a
horizontal, vertical or a line at a 45 degree angle depending on the
direction that you draw it. Holding down the Shift key while drawing an
ellipse will result in a circle. Holding down the Shift key while drawing a
rectangle will result in a square.

Tip: When selecting the color of an object through the Properties Editor,
click outside the color palette once to close the palette and then click a
second time to start drawing.
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Inserting Clip Art Images

Clip art images can be loaded from a Clip Art library of presentation and mathematical symbols.
(Refer to Customizing Clip Art Collections on page 164 for details on the default clip art
collections and how to create your own clip art collection.)
Follow the steps below to insert a clip art image on the Whiteboard:
1. Click on the

Insert Clip Art button. The Clip Art dialog opens.

2. Select the tab that contains the clip art you wish to load.
3. Select (single-click on) the desired image.
Tip: As you hover your mouse over an image, a tool tip will provide
a description of the image.
4. Move your cursor to the desired position on the Whiteboard then click on the Whiteboard
to anchor the image into position.
Inserting a Clip Art Background Image

Follow steps 1 to 3 above to add a background to your Whiteboard page from the Clip Art library.
The selected image will be inserted in the background of the Whiteboard page so cannot be
edited or moved.

Tip: To remove the Clip Art background image, use the same process to
select the blank white background image (on the far right).
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Inserting Clip Art Images as Stamps

You can use clip art images as stamps, so you can repeatedly insert the same image over and
over. To do so, double-click on the desired image in the Clip Art dialog.
Your cursor will change to a stamp icon. Click on the Whiteboard in as may places as you
want to leave a stamp. The cursor will remain a stamp tool until you select a different clip
art image or use one of the Whiteboard drawing tools.

Inserting Screen Captures

The Screen Capture tool creates an image of a portion of your desktop, any application, or web
site and loads it into the Whiteboard.
Note: You cannot take a screen capture of the Blackboard Collaborate
application.
Follow the steps below to capture a screen image:
1. Click on the

Insert Screen Capture button. A transparent frame appears with four

buttons in the middle.

2. Click inside the frame and drag it into position on the screen so that the desired area is
completely enclosed by it. Click and drag the edges of the frame to resize it.
Switching between programs or performing certain other tasks under the frame may
cause the frame to stop updating. Click Refresh to manually update the frame if this
occurs.
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3. Do one of the following:
o

Select the option OK to capture exactly what is enclosed in the frame at that
moment.

o

Select With Delay to add a ten second delay before the frame is captured. This
gives some time to position the cursor or other feature of the desktop that must be
maintained with the mouse in order to be captured.

o

Select Cancel to close the frame without capturing an image.

4. The image appears on the Whiteboard. Position the image on the Whiteboard by dragging
it to a new location and click on the Whiteboard region to anchor it in position.

Pointing to Things on the Whiteboard
When you want to draw people's attention to something on the Whiteboard, you can point to it
using one of the Pointer tools.
1. Click and hold the

Pointer tool in the Whiteboard Tools palette until it expands to

reveal all available pointers.

2. Click on the desired pointer and, so others will see it as you move it around the
Whiteboard, do one of the following:
o

Hold down the left or right mouse button as you move the pointer. Release the
mouse button to stamp the pointer image on the Whiteboard.

o

To get the pointer to follow the mouse motion without having to hold down the
mouse button, double-click anywhere on the Whiteboard and then move the
pointer. To release this mode, click with the mouse again or select a different tool.
Note: If you don't do one of the above, the pointer will be visible to
only you.

Setting Whiteboard Preferences
The Whiteboard Content Options preferences panel is used to set content loading options and
Whiteboard page size. To set the options, do the following:
1. Open the Preferences dialog in one of the following ways:
o
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From the Edit menu, select Preferences… (Windows & Linux)
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From the Blackboard Collaborate web conferencing menu, select Preferences
(Mac OS X)
o

Enter Ctrl+Comma (Windows & Linux)
Enter Command-Comma (Mac OS X)

2. In the left pane of the Preferences dialog, select the Content Options preferences panel
under Whiteboard. This opens the Whiteboard Content Options preferences panel.

3. Set the following options as needed:
n

Page Insertion Location: Select where you want newly loaded Whiteboard
content to be placed in relation to existing pages: after the current page,
before the current page or replace the current page.
Tip: Before you load content into the Whiteboard,
remember to move to the appropriate "current" page.
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n

Page Size: You can size your pages for a specific monitor resolution or you
can specify the width and height in pixels.
l

l

If you select Monitor Resolution, use the drop-down menu to choose
the appropriate resolution from the list. The default screen resolution is
1280 x 1024 pixels.
If you select Canvas Size, enter the Width and Height in the text boxes
provided.

Each of the Monitor Resolution options has a corresponding Canvas Size –
they are just two ways of expressing the same thing. These options can be
used interchangeably.
n

n

Presentation Import Options: When selected, the Include Speaker Notes
option will place the presenter notes from your imported PowerPoint or OpenOffice.org presentation into the Notes editor of all session attendees. For
details, see Viewing Presenter Notes Imported with a Presentation on
page 229.
OpenOffice.org Application: The OpenOffice.org executable will be found
automatically on Mac and Windows systems if you select the option Use
default OpenOffice.org installation (this is the default). If you wish to use an
installation other than the default, unselect Use default OpenOffice.org installation and browse to the location of that installation.

4. Click on OK to save your preferences and close the Preferences dialog, Apply to save
your preferences and leave the Preferences dialog open or Cancel to close the Preference
dialog without saving any of your changes.
When you configure preferences, Blackboard Collaborate web conferencing will remember the
settings each time you join another session on the same computer.
Note: You can restore your preference settings to the default. For details
on restoring default preferences, see Restoring Default Preference
Settings on page 11.

134

The Whiteboard

Manipulating Objects and Text
All objects on the Whiteboard are dynamic. The objects can be edited, moved, layered, re-sized,
and grouped.

Using the Object Explorer
The Object Explorer is a window that lists all the objects on your current Whiteboard page,
enabling you to easily take an inventory of the objects and perform operations on them. You can
right-clicking (Control-click on Mac) on objects in the Object Explorer to open a context menu
and perform all of the same operations on an object that you can by opening the context menu
on that object on the Whiteboard canvas.
To open the Object Explorer, do one of the following:
o

From the Tools menu, select Whiteboard followed by Object Explorer…

o

Right-click (Control-click on Mac) on the Whiteboard canvas to open the Whiteboard context menu. In the menu, select Object Explorer…

o

Type Ctrl+Shift+T (Shift-Command-T on Mac).

The Object Explorer window opens, displaying all of the objects on the current page. You can
resize and reposition this window as needed.
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1 An image of the current page

5 An object on the Whiteboard created by a
Participant who has left the session

2 The page background

6 A group of objects

3 An object component of the background

7 A text object, labeled by its contents

4 An image imported to the Whiteboard

8 An object component of a group

Objects are labeled with the icon of the tool used to create them and the name of their creator.
If the creator’s name appears in parentheses, that creator is still in the session. If the name
appears in <angle brackets>, the creator has left the session.
The objects are listed in the order that they appear on the Whiteboard. Objects at the bottom of
the list appear above objects at the top, and new objects are added to the bottom. Grouped
objects appear indented below an expandable Group sub-list. Backgrounds are a special type of
group that automatically drop behind other objects (go to the top of the list in the Object
Explorer).
Note: Clip Art and Screen Capture objects use the same icon as that of
the Image object:

Viewing Page Thumbnails

Pages in the Object Explorer can be displayed as either thumbnails of the page or as icons.
To view thumbnails, open the Tools menu and select Whiteboard, then check Show Thumbnails
in Explorer Windows. To disable thumbnails, uncheck the option.
Note: The Show Thumbnails option affects not only the page viewed in
the Object Explorer but also the page(s) viewed in the Object Explorer and
the Select Page(s) dialog.

Viewing Thumbnails

Moderators can configure pages in the Explorer windows (Page Explorer, Object Explorer and
the Select Page(s) dialog) to be displayed as either thumbnails or as icons. When the Moderator
configures thumbnails, it changes the display for everyone in the session. Thumbnails are turned
on by default.
Note: You cannot turn thumbnails off and on.

136

The Whiteboard

The functionality available in Explorer windows (such as copying, pasting, dragging/dropping,
etc.) is identical in both views.

Selecting Objects
Select objects directly in the Whiteboard or in the Object Explorer.

Selecting Objects in the Object Explorer

Open the Object Explorer in one of the following ways.
o

From the Tools menu, select Whiteboard followed by Object Explorer…

o

Right-click (Control-click on Mac) on the Whiteboard canvas to open the Whiteboard
context menu. In the menu, select Object Explorer…

o

Type Control+Shift+T (Shift-Command-T on Mac).

From within the Object Explorer, click on the objects you wish to select. Use Ctrl+Click
(Control-Click on Mac) to select more than one object. Use shift+Click to select all objects
between two selected objects.

Selecting One Object in the Whiteboard

To select a single object, select the
Selection tool in the Tools Palette and
click on the object. The selected object will appear with a border around it.
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Selecting More Than One Object in the Whiteboard

You can select several objects at the same time or add objects to an existing selection. All objects
must be on the same page.
To select more than one object, hold down the Shift key and use the
Selection tool to click
on each object you wish to select. As each object is selected, a border will appear around it.

Selecting Several Objects Simultaneously in the Whiteboard

To select several objects simultaneously, use the
Selection tool to drag a selection area that touches a part
of each object. As each object is selected, a border will
appear around it.

Selecting All Objects in the Whiteboard or Object Explorer

To select all the objects, do one of the following:
o

Right-click (Control-Click on Mac) anywhere on the Whiteboard. The Whiteboard context
menu appears. Select the option Select All Objects.

o

Right-click (Control-Click on Mac) anywhere in the Object Explorer and select the option
Select All Objects from the context menu.

o

Type Ctrl+A (Command-A on Mac).

Selecting All Objects Created by Participants

To select all objects created by selected Participant(s), do the following:
1. Select an object from the Participant or Participants on either the Whiteboard canvas or
in the Object Explorer.
If a Group is selected, the Participant will be the creator of the Group, not the creator of
the objects within the Group.
2. In the Tools menu, select Whiteboard and then Select All Objects from Participant.
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Identifying the Creator of an Object

To identify the creator of a specific object, right-click (Control-Click on Mac) on the object to
bring up the Whiteboard context menu. The creator’s name appears at the top of the menu (in
gray). If you have selected more than one object created by different Participants, the creator
will be listed as “Multiple Creators.”

Selecting Simple Text and Text Editor Objects Containing Links

To select a Simple Text or Text Editor object that contains a link (see
Inserting External Links on page 127), hold down Shift or Control
(same on Mac) while using the
Selection tool to click on the object.
The selected object will appear with a border around it.
You also can select a Text Editor object with a simple click, as long as you don’t click directly on
the link. Make sure your cursor is an arrow (not a hand) before you click.

Moving Objects
Move objects to other positions on the page with the mouse.
1. Select the object(s) you wish to move (See Selecting Objects.). In Windows, the cursor
changes to a 4-point arrow cursor ( ).
2. Hold the mouse button down and drag the object(s) to a new position on the page.

Restore Offscreen Objects

If you drag an object completely off the Whiteboard, you can retrieve it by opening the Tools
menu, selecting Whiteboard and then choosing Restore Offscreen Objects. The object will be
placed in the center of the Whiteboard.
If you dragged more than one object off the Whiteboard, you may have to separate the objects
once you have moved them back onto the Whiteboard. Refer to Using the Object Explorer on
page 135 to use the Object Explorer to separate these objects if you cannot select them manually.

Aligning and Distributing Objects
When multiple objects on the Whiteboard are selected, they can be aligned and distributed in
various ways using the Align Objects window or Whiteboard context menu.
Note: The order in which the objects are selected is important as the
first one is considered the anchor and all other objects will be aligned
according to the first.
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Using the Align Objects window:

1. Select the objects to be aligned or distributed.
2. Open the Align Objects window in one of the following
ways:
o

Right-click (Control-click on the Mac) on the
Whiteboard canvas to open the context menu.
Select Align Objects, followed by Align Objects…

o

In the Tools menu, select Whiteboard, followed
by Align Objects…

3. Choose one of the alignment or distribution functions
from the window. (See the description of the functions
below.)

Using the Whiteboard context menu:

1. Select the objects to be aligned or distributed.
2. Right-click (Control-click on a Mac) on the Whiteboard
canvas to open the context menu. Select Align Objects.
3. Choose one of the alignment or distribution functions from the menu. (See the
description of the functions below.)
Depending on your selection, only some of the options may be available.

Description of Alignment Functions

Objects may be aligned with each other, or with the Whiteboard. Multiple selected objects will
be aligned using the first-selected object as the anchor. A single selected object will be aligned
using the Whiteboard as the anchor.
n
n

n

n

n

n
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Align Top Edges – aligns the tops of the selected objects to the top of the anchor.
Align Vertical Centers – aligns the vertical center of the selected objects to the vertical
center of the Anchor.
Align Bottom Edges – aligns the bottom of the selected objects to the bottom of the
anchor.
Align Left Edges – aligns the left edges of the selected objects to the left edge of the
anchor.
Align Horizontal Centers – aligns the horizontal center of the selected objects to the horizontal center of the anchor.
Align Right Edges – aligns the right edges of the selected objects to the right edge of the
anchor.
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Description of Distribution Functions

Distribution requires three or more objects to be selected. If fewer than three objects are
selected, the Distribute panel options will be grayed out and will not be accessible. The firstselected and the last-selected objects are used as anchors and the remaining objects will be
distributed between the two anchors in the order selected
n

n

n

n

Distribute Vertical Centers – distributes the objects between the anchors so that the
centers of the objects are all evenly spaced.
Distribute Vertical Spacing – distributes the objects between the anchors so that the
edge-to-edge spacing between the objects is the same.
Distribute Horizontal Centers – distributes the objects between the anchors so that the
centers of the objects are all evenly spaced.
Distribute Horizontal Spacing – distributes the objects between the anchors so that the
edge-to-edge spacing between the objects is the same.

Resizing Objects
You can resize a single object, multiple objects and grouped objects.
1. Select the object(s) you wish to resize. (See Using the Object Explorer.)
2. Place the cursor over the object’s border or corner. The cursor will change to an arrow
shape.
3. Hold the mouse button down while you drag the edge or corner of the object. When
resizing multiple objects, they will all be resized proportionally.
To keep the same proportions when resizing, click and drag a corner of the object or group
while holding shift. Release the mouse button before releasing the shift key.

Note: Text inside cannot be resized by dragging a corner. Instead, you
can resize it by selecting it and changing the font properties. (See
Changing Properties of Text Objects on page 147.)
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Grouping and Ungrouping Objects
Grouped objects retain their size and position relative to each other. The entire group can be
resized, moved around the Whiteboard, or moved forward or backward as a layer.
To group objects:
1. Select the objects on either the Whiteboard or in the Object Explorer (see Selecting
Objects on page 137).
2. Do one of the following:
o

Right-click (Control-click on a Mac) on a selected object on the Whiteboard or in
the Object Explorer to open the context menu. Select Group Objects.

o

Type Ctrl+G (Command-G on a Mac).

A dashed box will appear, containing all of the grouped objects. The group can be selected by
clicking on any of the contained objects with the Selection tool
.
To ungroup one or more groups of objects:
1. Select the objects on either the Whiteboard or in the Object Explorer.
2. Do one of the following:
o

Right-click (Control-click on a Mac) on a selected object on the Whiteboard or in
the Object Explorer to open the context menu. Select Ungroup Object Groups.

o

Type Ctrl+U (Command-U on a Mac).

Adding or Removing Objects from a Group

Add or remove objects to or from a group using the Object Explorer (see Using the Object
Explorer on page 135). To do so, select the object(s) in the Object Explorer and drag it to the
desired position.
Tip: Removing an object from a group is easier if you drop it above the group, rather than below
it. To place the removed object in front of the group, drag it above the group and then hide the
object components by clicking the black arrow , and drag the group above the object.

Moving Objects to the Front/Back
All objects placed on the Whiteboard are layered and hence can be moved forward or backward
in relationship to each other. They also can be moved directly to the front or back of all other
objects.
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Note: Moving objects forwards and backwards is not the same as moving
objects to the background or foreground. All objects you move forwards
or backwards reside in the foreground. You cannot move objects in the
background.
1. Open the Whiteboard context menu by doing one of the following:
o

Select the object(s) to be moved in the Whiteboard and then right-click (ControlClick on Mac) anywhere on the Whiteboard.

o

Right-click (Control-Click on Mac) on the objects to be moved in the Object
Explorer.

2. Select one of the following options:
o

Move to Front — moves the selected object(s) directly to the front of the Whiteboard

o

Move Forward — moves the selected object(s) one layer closer to the front.

o

Move Backward — moves the selected object(s) one layer closer to the back.

o

Move to Back — moves the selected object(s) directly to the back of the Whiteboard.

Cutting, Copying and Pasting Objects in the Whiteboard
Cutting removes the selected objects from the Whiteboard and places them on the clipboard.
Copying retains the selected objects in the Whiteboard and places them in the clipboard. The
clipboard is overwritten whenever you copy or cut another object.
Once an object is cut or copied, you can paste it from the clipboard to the same or a different
Whiteboard page. The last object(s) placed in the clipboard will be the object(s) pasted.
Note: An object can be pasted multiple times. Each paste will be layered
on top of the last.

Copying and Cutting Objects

To copy or cut an object, do one of the following:
o

o

Select the object(s) on the Whiteboard or Object
Explorer and then right-click (Control-Click on Mac) on
a selected object. The Whiteboard context menu appears.
Select either Copy or Cut.
Select the object(s) in the Whiteboard or in the Object
Explorer and then enter one of the following:
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Copy: Ctrl+C (Command-C on Mac)
Cut: Ctrl+X (Command-X on Mac)
Note: Participants can cut only their own objects. Moderators can cut
anyone’s objects.

Pasting Objects

To paste an object from the clipboard, do one of the following:
o

Right-click (Control-Click on Mac) anywhere on the Whiteboard or Object Explorer. The
Whiteboard context menu appears. Select Paste.

o

Click anywhere on the Whiteboard or Object Explorer and then type Ctrl+V (Command-V
on Mac).

Use the

Selection tool to reposition the objects on the Whiteboard, if desired.
Note: Rich or plain text and images from other applications can be pasted
into the Whiteboard. The following image formats are supported: bmp,
.gif, .jpg, .jpeg and .png. See Loading External Content into the
Whiteboard .

Duplicating Whiteboard Objects by Dragging and Dropping

You can copy a Whiteboard object in a single step by dragging and dropping the object to a new
position within the Object Explorer while holding the Control key (Command on a Mac).
Release the mouse before releasing the Control (or Command) key. On Windows, a plus symbol
(+) appears overlaying the mouse when an object will be duplicated instead of moved.

Copying and Pasting Objects from One Page to Multiple Pages

You can copy objects on one Whiteboard page and paste them on a number of other pages at
once using the Page Explorer.
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1. Copy the desired objects on your page.
2. To open the Page Explorer, do one of the following:
o

Select Show Page Explorer from the Options menu in the Whiteboard Navigation
bar in the upper right corner of the Content area.

o

Type Ctrl+Shift+P (Command-Shift-P on a Mac).

3. Select all the pages to which you want to paste the objects (see Using the Page Explorer
on page 150) and right-click (Control-click on a Mac) to open the context menu.
4. From the context menu, select Paste Objects to Pages.

Editing Text
You can edit text in both Simple Text and Text Editor objects, however editing of Simple Text
objects is very limited.
For information on formatting the text, see Changing Properties of Text Objects on page 147.

Text Editor Objects

To put the object in editing mode, select the object and then double-click on the text box.
You can use most standard text editing mouse actions within the text, such as double-clicking to
select a word and dragging to select text. The following standard text editing keyboard shortcuts
can be used to perform functions within the text of individual notes.
Function

Windows & Linux Shortcuts Mac OS X Shortcuts

Select all text in current text box Ctrl+A

Command-A

Copy selected text

Ctrl+C

Command-C

Cut selected text

Ctrl+X

Command-X

Paste copied text

Ctrl+V

Command-V

Delete selected text

Delete, Backspace

Delete

Simple Text Objects

Select the object and then double-click on the text box. To edit a Simple Text object that
contains a link (see Inserting External Links), hold down the Control (Command on Mac) key
while double-clicking on the text box.
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Editing Object Properties
Whether you are working with a single object, multiple objects or a grouped object, an object’s
properties (including line width, line color and transparency, line style, line cap style, fill color
and transparency, and font) can be changed.
There are two places in which you can edit object properties:
n

n

The Properties Editor palette lets you edit all the basic Whiteboard object properties. For
details, see The Properties Editor on page 125
The Object Properties dialog lets you edit all Whiteboard object properties, including some
not commonly used, and not available in the Properties Editor palette.

The properties for each object type that can be edited only in the Object Properties dialog are
listed below:
Object Type

Freehand tools

n

Select rounded or flat line caps.

n

Select broken or solid line.

Text tools

n

None

Filled shapes

n

None

Empty shapes

n

Select rounded or flat caps (for broken strokes).

n

Select broken or solid strokes.

n

Select a fill color.

n

Select fill transparency.

n

Select rounded or flat caps.

n

Select broken or solid line.

n

Select a stroke width.

n

Select a cap style (for broken strokes).

n

Select solid or broken strokes.

n

Select transparency (applies to both stroke and image).

n

Select stroke color.

n

Select show or hide strokes.

Line tool

Images and Clip art
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To edit an object's properties in the Object Properties dialog, do the following:
1. Open the Object Properties window in one of the two following ways:
o

Right-click (Control-Click on Mac) anywhere on the Whiteboard or Object Explorer.
The Whiteboard context menu appears. Select the option Object Properties…

o

From the Tools menu, select Whiteboard, followed by Object Properties.

2. Select an object or objects on the Whiteboard or in the Object Explorer.
3. Edit the desired options.
4. Click OK to make the chosen edits to the Object(s) and close the Object Properties
window.
Click Apply to make the chosen edits and leave the Object Properties window open.
Click Cancel to close the Object Properties window without making any changes. To
cancel the changes without closing the dialog, simply deselect the object(s).
Within the Object Properties dialog box, you can change an object’s properties.
The Object Properties dialog contains tabs related to
each type of content that can be edited directly on the
Whiteboard: Shape, Text, Filled Shape, and Image.
Depending on the object selected, some of the tabs will
be available and others will be grayed out. Click on the
tab for the object you wish to update. The details of
each tab are explained below.

Changing Properties of a Shape

Freehand shapes

, empty shapes

, and

lines , are edited in the Shapes tab. You can change
the line properties (width, cap style, line style and line
color and transparency) of all these shapes and the fill
color and transparency of the Ellipses and Rectangle
shapes.
If the selection consists of more than one shape, each
shape will acquire the settings selected in the dialog box.

Changing Properties of Text Objects

You can change the color and transparency and font properties for all text in a simple text shape
or for selected text in a text box.
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Note: Text formatting will not be retained if you copy and paste
formatted text within the same text box, from one text box to another or
into an external application (e.g., Notepad or Word).

Changing Properties of a Filled Shape

You can change the fill color and transparency for any shape.
If the selection consisted of more than one filled shape, each filled shape will acquire the
settings selected in the dialog box.

Changing Properties of an Image or Clip Art

You can change the image frame style, and the transparency for any image.
If the selection consisted of more than one image, each image will acquire the settings selected
in the dialog box.

Deleting Objects
To delete an object from the Whiteboard, do one of the following:
o

Select the object(s) in the Whiteboard or Object Explorer and press the Delete key.

o

Select the object(s) on the Whiteboard or Object Explorer and then right-click (ControlClick on Mac) anywhere on the Whiteboard or Object Explorer. The Whiteboard context
menu appears. Select Delete.
Note: Participants cannot delete objects created by others – only their
own. Moderators can delete all objects.

Creating a Background
To add interest and function to your Whiteboard pages, you can create background images for
them. This can be done in the following way :
n

148

Insert a Clip Art background image (see Inserting a Clip Art Background Image on page
130). This image cannot be edited or moved like objects.
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Working with Whiteboard Pages
As a Participant with the Whiteboard permission, you can work freely in your private work area
(create new pages, load content, etc.) but have limited page management capabilities in the main
public area (Main Room). You can print the entire Whiteboard or save it to be viewed later, as
long as the Whiteboard is not protected.

Whiteboard Rooms and Groups
The Whiteboard consists of various areas that are visible in the Page Explorer. By default, you
will see the Main room and your own private work area.
Note: You can open the Page Explorer only if you have been granted the
page navigation permission by the Moderator.

1. Breakout Rooms
2. Main Room
3. Page Groups
4. Private Work Area
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The Main Room

When you first join a session, it will have one blank Whiteboard page in the Main Room. This
work area is public and available to all session attendees.
Note: One blank page is the default, however, there may be more pages if
the session was configured with a pre-loaded Whiteboard presentation.

Private Work Area

Each session attendee has their own private work area (Work Area <User Name>) with one
blank page. No one else in the session, including Moderators, can view another's private work
area.
Participants can use their own private work areas only when they have been granted the page
navigation permission by the Moderator.

Page Groups

Moderators can organize pages into distinct topics or presentations by creating page groups.
Page groups can be inside or outside of a room and can be nested within other page groups.

Breakout Rooms

When a Moderator creates a new breakout room, it is created with one blank Whiteboard page.
The breakout room and its pages are accessible to all Moderators and those Participants who
have been moved into the breakout room.

Using the Page Explorer
Note: You can open the Page Explorer only if you have been granted the
page navigation permission by the Moderator.
The Page Explorer is a window that lists all your Whiteboard pages and enables you to easily
navigate through and manage the pages.
Note: Only Moderators can perform page management functions in the
Main room and breakout rooms. Participants can manage pages only in
their own private work areas. They can, however, copy pages from the
Main room or breakout room to their private work areas.
To open the Page Explorer, do one of the following:
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o

Select Show Page Explorer from the Options menu in the Whiteboard Navigation bar in
the upper right corner of the Content area.

o

Type Ctrl+Shift+P (Command-Shift-P on a Mac).
Note: The Page Explorer opens automatically when you load a file into
the Whiteboard.

Page navigation functions are performed through the Navigation bar a the top of the Page
Explorer (see Navigating Between Pages on page 154) and pages can be moved by dragging and
dropping them (see Rearranging and Duplicating Pages on page 153). Page management
functions are done through the Page Explorer context menu.
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You can perform the following functions using the context menu:
Note: You can perform only a subset of these page functions outside of
your private work area (Work Area <Your Name>).
n

Cut, Copy, Paste and Delete pages (see Cutting, Copying, Pasting and Deleting Pages on
page 157) – private work area only, except for Copy

n

Select all pages in a room or page group (see Selecting All Page Peers on page 161)

n

Empty the clipboard (see Emptying Clipboard on page 160)

n

Edit Page Properties (see Editing Page Properties on page 160) – you can edit Page Properties in your private work area and view page properties in other rooms

n

Create new pages (see Creating New Blank Pages on page 155) – private work area only

n

Save the Whiteboard (see Saving Whiteboard Pages on page 162)

n

n

Move to the selected page (see Navigating Between Pages on page 154) – only if the Moderator has given you the page navigation permission
Paste objects copied from one page to mulitple other pages (see Copying and Pasting
Objects from One Page to Multiple Pages on page 144) – only if the Moderator has given
you the page navigation permission

Selecting Pages in the Page Explorer

You can select one or more pages in the Page Explorer. Once you have done so, you can perform
operations on the pages by opening the context menu with a right-click (Control-click on a
Mac), selecting Selected Pages and then selecting the desired function.
Note: You can open the Page Explorer only if you have been granted the
page navigation permission by the Moderator.
To select pages, do the following:
n
n

n
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To select a single page, click on the page.
To select multiple pages, hold down Control (Command on Mac) as you click on
pages, or hold the Shift key to select two pages and all pages between them.
To select all of the pages in a room or page group, right-click (Control-click on a
Mac) on a page in the desired room or page group, select Selected Pages from the context
menu and then choose Select All Page Peers. (For further details, see Selecting All Page
Peers on page 161.)
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Viewing Thumbnails

Moderators can configure pages in the Explorer windows (Page Explorer, Object Explorer and
the Select Page(s) dialog) to be displayed as either thumbnails or as icons. When the Moderator
configures thumbnails, it changes the display for everyone in the session. Thumbnails are turned
on by default.
Note: You cannot turn thumbnails off and on.

The functionality available in Explorer windows (such as copying, pasting, dragging/dropping,
etc.) is identical in both views.

Rearranging and Duplicating Pages

Pages can be rearranged and copied using the Page Explorer. Participants can rearrange pages
only in their own private work areas. Moderators can rearrange any pages.
Note: You can open the Page Explorer only if you have been granted the
page navigation permission by the Moderator.
To move a page, simply select and drag the page(s) to the desired position.
To duplicate a page, hold down the Control key (Option on Mac), click on the page which you
want to copy, and drag it to the position where you would like place the duplicate. Release the
mouse before releasing the Control key. (If you release Control first, you will end up moving the
original page rather than copying it.) A plus (+) symbol overlaying the mouse cursor indicates
that the page will be copied instead of moved.
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Dragging/Dropping Pages to Other Applications

You can copy an entire Whiteboard page into another application by dragging the page from the
Page Explorer. The page will be inserted as a single image into the other application.

Navigating Between Pages
To navigate between pages, you can use the Whiteboard navigation bar, the Tools menu, the
Page Explorer (see Using the Page Explorer on page 150) or the Page Up and Page Down keys
on your keyboard.
By default, you need the Moderator's permission to navigate between pages in the Main room or
to move to your private work area. By default, in breakout rooms, you can freely navigate
between pages but this permission can be turned off by a Moderator. You will know you are free
to move between Main room and breakout room pages when you see a red border around your
Whiteboard content area.
Note: If the Whiteboard is protected, you will not see the Navigation bar
and will not be able to navigate between any pages anywhere.
n

n

n
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To move to the next page:
o

In the Whiteboard Navigation bar or Page Explorer, click the
button.

Next Page

o

In the Tools menu, select Whiteboard followed by Go to Next Page.

o

Enter Alt + Page Down (Option-Page Down on Mac).

o

If focus is on the Go to Page menu of the Navigation bar, press the Down Arrow.

To move to the previous page:
o

In the Whiteboard Navigation bar or Page Explorer, click the
button.

Previous Page

o

In the Tools menu, select Whiteboard followed by Go to Previous Page.

o

Enter Alt + Page Up (Option-Page Up on Mac).

o

If focus is on the Go to Page menu of the Navigation bar, press the Up Arrow.

To move to any page that is not adjacent to another, in the Page Explorer, double-click on
the desired page or right-click (Control-click on a Mac) on the page and select Go to Page
from the context menu.
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Using the Whiteboard Navigation Bar

The Whiteboard Navigation bar is a toolbar containing controls that enable you to move
between rooms and pages within those rooms. It is located in the upper right corner of the
Content area whenever the Page Explorer is not open.
Note: You can use this feature only if you have been granted the page
navigation permission by the Moderator.

1 Previous Page button

3 Go to Page menu

2 Next Page button

4 Navigation Options menu

When the Page Explorer is open, the Navigation bar is located at the top of the Page Explorer
window.

n

n
n

Use the
Next Page button and
Previous Page button to move within the
current room or page group. To go to a different room or group, double-click on the page
or navigate to it using the Go to Page menu.
Use the Go to Page menu to select and move to a particular page.
The Page Counter reflects the position of the current page within its page group. By
default, you will not be able to see the Page Counter but the Moderator can turn it on for
you.

Creating New Blank Pages
All new Blackboard Collaborate web conferencing sessions contain at least one Main room page
and one private work area page for each session attendee. (Additional pages may also have been
preloaded by the session creator.) You can add more pages using the New Page button in the
Whiteboard Action Bar or in the Create New Pages dialog, where you can set further page
options.
Note: You can perform this function only in your private work area and
you can move to your private work area only if you have been granted the
page navigation permission by the Moderator.
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To create a single new blank page, click New Page on the Whiteboard Action bar. This
creates a single new blank page after the page you are currently on and directly takes you to that
page.

To create multiple pages or pages with more options, follow the steps below:
1. Open the Create New Pages dialog in one of the following ways:
o

In the File menu, select New, followed by Whiteboard Page.

o

In the Page Explorer, right-click (Control-click on the Mac) on a page or page
group. Select New from the context menu, followed by Whiteboard Page…

o

Enter Ctrl+N (Command-N on the Mac) and select Whiteboard Page in the New
dialog.

2. Under Page Location, select a position for the new page(s) relative to the current page.
Note: If the dialog was opened through the Page Explorer, current page refers
to the selected page in the Page Explorer rather than the currently viewed
page.
3. Under Page Size, select or specify a canvas size. You
can size your pages for a specific monitor
resolution or you can specify the width and height
in pixels.
n

n

If you select Monitor Resolution, use the
drop-down menu to choose the appropriate
resolution from the list. The default screen
resolution is 1280 x 1024 pixels.
If you select Canvas Size, enter the Width
and Height in the text boxes provided.

Each of the Monitor Resolution options has a
corresponding Canvas Size – they are just two ways
of expressing the same thing. These options can be
used interchangeably.
4. Under Page Number and Names, enter a number
(up to a maximum of 99) in the Number of new
pages text box. Click in the list of pages (below the
text box) to see the new ones added. Each page will
have a number along with a default Page Name, for
example Private Page 2.
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5. Optionally, edit the name of each page by double-clicking on the default name in the Page
Name column and typing a new name.
6. Click OK. The pages are added sequentially in the position selected in Step 2.
Note: If multiple pages from multiple rooms or page groups were selected
in the Page Explorer, pages will be added in the selected position in
relation to each of them. For example, if you had two page groups selected
and entered 1 for Number of new pages, two pages are created, one in
each group. If the Number of new pages was 2, four pages would be
created, etc.

How New Pages are Named

The default names of new pages added to your
private work area will be “Private Page X”.
As you add more pages, the page numbers in the
page names are incremented by 1. The numbers
document the order the page was added, not the
position in which it was added.
If you delete a page (for example Private Page 3)
and then added another new page, the number of
the newest page will still be incremented by 1
including the deleted page (will be Private Page 4,
not Private Page 3), as depicted in the example on
the right.

Cutting, Copying, Pasting and Deleting Pages
You can cut, copy, paste, and delete pages from the Whiteboard. In the Page Explorer, you also
can duplicate pages (see Rearranging and Duplicating Pages on page 153).

Cutting Pages

Cutting a Whiteboard page removes the page from its room or group and places it in the
clipboard. The clipboard is overwritten whenever you cut or copy another page.

The Whiteboard

157

Note: You can perform this function only in your private work area and
you can move to your private work area only if you have been granted the
page navigation permission by the Moderator.
To cut a Whiteboard page, do one of the following:
o

With the Navigation toolbar, navigate to the page you wish to cut and then right-click
(Control-Click on Mac) on the Whiteboard canvas to open the context menu. Select Current Page followed by Cut.

o

In the Page Explorer, select the page(s) you wish to cut and right click (Control-Click on
Mac) to open the context menu. Select Selected Pages and then select Cut.

o

In the Page Explorer, select a page or pages and enter Ctrl+X (Command-X on a Mac).

You can now paste the cut page(s).

Copying Pages

Copy Page places a duplicate of the selected page in the clipboard. The clipboard is overwritten
whenever you copy or cut another page.
To copy a page, do one of the following:
o

Using the Navigation toolbar, navigate to the page you wish to copy and then right-click
(Control-Click on Mac) on the Whiteboard canvas to open the context menu. Select Current Page and then choose Copy.

o

In the Page Explorer, select the page(s) you wish to copy and then right-click (ControlClick on Mac) to open the context menu. Select Selected Pages and then select Copy.

o

In the Page Explorer, select the page(s) you wish to copy and enter Ctrl+C (Command-C
on a Mac).

You can now paste the copied page(s).

Pasting Pages

You must have previously cut or copied a page to have placed it in the clipboard. The last page(s)
placed in the clipboard will be the page(s) that will be pasted. When pasting, you must identify
one or more "target" pages in relation to which you want to paste the copied or cut page(s). If
you identify more than one target page (e.g., three), the page(s) in the clipboard will be pasted
once for each target page (e.g., in three places).
Note: You can perform this function only in your private work area and
you can move to your private work area only if you have been granted the
page navigation permission by the Moderator.

158

The Whiteboard

To paste a page, do one of the following:
o

Using the Navigation toolbar, navigate to the target page and then right-click (ControlClick on Mac) on the Whiteboard canvas to open the context menu. Select Current Page,
followed by Paste and then select a position for the page. The options are After, Before
and At End.

o

In the Page Explorer, select one or more target pages or groups and then right-click (Control-Click on Mac) to open the context menu. Select Selected Pages, select Paste, and then
select a position for the pages. The options are After, Before and At End. If the pages in
multiple page groups are selected, the page(s) in the clipboard will be pasted once to each
room or group.

o

In the Page Explorer, select one or more target pages or groups and enter Ctrl+V (Command-V on a Mac). The page(s) appear after the currently selected page(s) or at the end of
the selected groups. If multiple pages or groups are selected, the page(s) in the clipboard
will be pasted once to each room or group.

The page(s) appears in the selected position.

Deleting Pages

To delete a page permanently, do one of the following:
Note: You can perform this function only in your private work area and
you can move to your private work area only if you have been granted the
page navigation permission by the Moderator.
o

Using the Whiteboard Action bar, navigate to the page you wish to delete and click Delete
Page in the Whiteboard Action bar.

o

Using the Navigation toolbar, navigate to the page you wish to delete and right-click (Control-Click on Mac) on the Whiteboard to open the context menu. Select Current Page and
then Delete.

o

In the Page Explorer, select the page(s) you wish to delete and press the Delete key.

o

In the Page Explorer, select the page(s) you wish to delete and then right-click (ControlClick on Mac) to open the context menu. Select Selected Pages and then Delete.

You will be prompted to confirm whether or not you want to delete the page and its contents.
Click Yes to complete the deletion.
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Emptying Clipboard
The Empty Clipboard feature removes the last copied page from the clipboard.
Note: You can use this feature only if you have been granted the page
navigation permission by the Moderator.

Note: You do not need to use this command to clear your clipboard when
copying or cutting another page since the clipboard is automatically
overwritten.
To empty the page clipboard, do one of the following:
o

Right-click (Control-Click on Mac) on the Whiteboard canvas to open the context menu.
Select Current Page followed by Empty Page Clipboard.

o

In the Page Explorer, select Selected Pages and then select Empty Clipboard.

Editing Page Properties
You can edit the properties of your current page in the Edit Page Properties dialog.
Note: You cannot edit properties of pages within the Main room (public
work area) – only those in your own private work area (for which you
need the page navigation permission from the Moderator). However, you
can view page properties of pages in the Main room.
To open the Page Properties dialog, do one of the following:
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o

With the Navigation toolbar, navigate to the desired page and then right-click (ControlClick on Mac) on the Whiteboard canvas to open the context menu. Select Current Page
followed by Page Properties…

o

In the Whiteboard, navigate to the page you wish to edit. From the Tools menu, select
Whiteboard and then choose Page Properties…

o

In the Page Explorer, select the page you wish to edit and right click (Control-Click on
Mac) to open the context menu. Select Selected Pages and then select Page Properties…
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From the Page Properties dialog you are able to change the following:
n

Page Size: You can size your pages for a specific monitor resolution or you can specify the
width and height in pixels.
l

l

If you select Monitor Resolution, use the drop-down menu to choose the appropriate resolution from the list. The default screen resolution is 1280 x 1024 pixels.
If you select Canvas Size, enter the Width and Height in the text boxes provided.

Each of the Monitor Resolution options has a corresponding Canvas Size – they are just
two ways of expressing the same thing. These options can be used interchangeably.
n

Page Names: Double click on the page name in the Page Names list to enable editing, type
your new name and click OK.

Selecting All Page Peers
The command Select All Peers will select all the pages in the current room or group.
Note: You can perform this function only in your private work area and
you can move to your private work area only if you have been granted the
page navigation permission by the Moderator.
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This function is useful if you want to perform operations on all pages in a room or group at
once. It is different from selecting the room or group because the operations performed on the
pages will not affect the room or group (e.g., if you delete all the pages in a group, the group will
remain).
1. Select one or more pages in the Page Explorer and then right-click (Control-Click on Mac)
on a selected page. The context menu appears.
Note: If you select pages in two or more rooms or groups, Select All
Peers will select all pages in those rooms and groups.
2. Select Selected Pages and then select the command Select All Peers.
In the Page Explorer, all page peers will be selected. You can now do operations like copy and
paste all the pages or delete all the pages.

Saving Whiteboard Pages
You can save the Whiteboard pages in Blackboard Collaborate web conferencing in the following
formats:
l

l

l

l

WBD File – When Whiteboard pages are saved as a Whiteboard file (.wbd), they are
saved as one file that can only be imported and reviewed in a Blackboard Collaborate session.
WBP File – When Whiteboard pages are saved as a Protected Whiteboard file (.wbp),
they are saved as one file that can only be imported and reviewed in a Blackboard Collaborate session. These files are protected and cannot be printed, saved, or edited unless
the Moderator removes the protection flag (by selecting Tools, then Whiteboard, and deselecting the command Protect Whiteboard).
PDF File – When Whiteboard pages are saved as a PDF file (.pdf), they are saved as one
file and can be reviewed outside of the Blackboard Collaborate environment.
PNG File – When Whiteboard pages are saved as PNG files (.png), each page is saved as a
separate image and can be loaded individually onto the Whiteboard as an image or used in
an graphics editor application.

To save all or part of the Whiteboard, do the following:
1. If you want to save all pages in a room or group, navigate to that room or group. If you
want to save a single page, navigate to that page. (See Navigating Between Pages on
page 154.)
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2. Open the Select Pages dialog by doing one of the following:
o

From the File menu, select Save followed by Whiteboard…

o

In the Page Explorer, select the page(s) and/or Group(s) you wish to save and then
right-click (Control-Click on Mac) to open the context menu. Select Save…

o

Type Ctrl+S (Command-S on Mac). The Save dialog appears. Select Whiteboard and
click on Save.

3. Choose whether you want to save All
Pages in your current room or group, only
the Current Page or Selected Pages. If
you choose Selected Pages, a list of pages in
the Whiteboard appears. Select the page(s)
you wish to save. Use Shift or Control (same
on Mac) to select multiple pages. Then click
OK.
4. From the Save Whiteboard dialog, navigate
to and open the file folder in which you
want to save the Whiteboard.
5. Type a file name in the File name text box.
6. Scroll through the Files of type drop-down
menu and choose the file format.
7. Click Save to save the file and close the
Save Whiteboard dialog box.

Printing Whiteboard Pages
You can print individual pages, multiple selected
pages and all the pages in a room orgroups.
1. If you want to print all pages in a room or
group, navigate to that room or group. If
you want to print a single page, navigate to that page. (See Navigating Between Pages on
page 154.)
2. Open the Select Pages dialog by doing one of the following:
o

From the File menu, select Print and then choose Whiteboard…

o

Enter Ctrl+P (Command-P on Mac). The Print dialog appears. Select Whiteboard
and click on Print.

3. Choose whether you want to print All Pages in your current room or group, only the
Current Page or Selected Pages. If you choose Selected Pages, a list of pages in the
Whiteboard appears. Select the page(s) you wish to print. Use Shift or Control (same on
Mac) to select multiple pages. Then click OK.
4. The Page Set-up dialog box opens. Specify your preferences and click OK.
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Note: If the Whiteboard is protected, no one, including the Moderator,
can print any pages.

Customizing Clip Art Collections
Blackboard Collaborate web conferencing offers you the ability to customize and add images to
those available in the Clip Art library from the
Clip Art tool in the Whiteboard toolbar. A
set of images can be saved as a collection and any number of clip art collections can be created
and can be loaded each time you join Blackboard Collaborate web conferencing
The Clip Art Collections dialog lists all the clip art collections that are available.

Organizing the Clip Art Library
The clip art collections that are available to use with
the Whiteboard must be loaded into the Clip Art
library and then selected to appear.
To view and/or modify the collections that have
already been added to the library, do the following:
1. From the Tools menu, select Whiteboard,
followed by Manage Clip Art Collections…
The Clip Art Collections dialog box appears.
2. Place a check mark in the box to the left of
the collections that you want to appear in the
Clip Art library.
3. Click Done to close the dialog.
Clip Art collections selected in this window will be
loaded each time you join a Blackboard Collaborate
web conferencing session from this computer.
Collections without a checkmark are disabled.
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Creating New Clip Art Collections
To create a new clip art collection, do the following:
1. Open the Create/Edit Clip Art Collections dialog by doing one of the following:
o

From the Tools menu, select Whiteboard, followed by Create/Edit Clipboard Collections…

o

From the Manage Clip Art collections dialog, click the
button.

Create/Edit Collection

The Create/Edit Clip Art Collections dialog opens.
2. Click on the
New Collection button in the Create/Edit Clip Art Collections dialog to
display a blank collection file template.
3. Enter the title of the collection in the Collection Title: text box (highlighted in pink).
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4. Click on the

Add Image to Collection button to load a new image into the

collection. Use the operating system's dialog to select the files to load.
When loading multiple images, they can be loaded in the order that they are selected, in
alphabetical or in alphanumeric order. Alphanumeric sorts first by number (1, 2, 3, etc.)
and then by text (a, b, c, etc.).
The images appear in the list.

5. For every image, the Tool Tip Text to display for file column will show the name of the
image. You may edit the names by double-clicking in the text box and entering the name.
6. Re-order the images by clicking on either the up
button to move the image up or
clicking on the down
button to move the image down. You can also delete the image by
clicking on the
Delete Image button.
7. You can add an existing collection into the current collection by clicking on the

Add

Collection button. This will add the collection to the existing set and will appear as a new
tab in the current collection.
8. Once you have entered the images, click on the

Save Collection button to save the

collection(s) to a new file.
9. Click Close to exit this window. The new collection will now appear on the Clip Art
Collections dialog box.
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Adding a Clip Art Collection to the Library
To add a specified Clip Art collection to the Clip Art Library, do the following:
1. From the Clip Art Collections dialog box, click on the

Add Collection button in the

tool bar. The “Browse for Collections Files to Use” dialog box appears.
2. Navigate to the folder containing the clip art collection file and select the file from the list.
3. Click Open to load the collection and dismiss the dialog box.
The Clip Art collection is loaded into the Clip Art library and appears in the Clip Art Collections
dialog box.

Removing Clip Art Collections from the Library
1. To remove a customized Clip Art collection from the Clip Art Library, do the following:
2. From the Clip Art Collections dialog box, select the collection to be deleted and then click
on the
Delete Collection button. This button is deactivated if there are no userimported clip art collections available. The Remove User Collections Confirmation dialog
box appears.
3. Click OK to remove the Clip Art collection from the library.
Note: You cannot remove the default Collections, only turn them off.

Editing, Deleting, and Merging Customized Clip Art Collections
To edit a customized Clip Art collection file (you can't edit the default collection), load the file in
one of the following methods:
1. From the Tools menu, select Whiteboard, followed by Manage Clip Art Collections… The
Clip Art Collections dialog box opens.
2. Select the Collection file to be edited.
3. Click the
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Edit Collection button. The Create/Edit Clip Art Collections dialog opens.
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1 New collections button. Click to create a
new collection in the current file.

9 The title of the current collection. Click to
edit.

2 Load collection file button. Click to load a
collection from the computer.

10 The type of the images in the current collection. Choose Clip Art Images or Background Images. Background images are
placed as backgrounds on the Whiteboard. clip art images are placed as objects
in the foreground.

3 Save collections button. Click to save a
collection
4 Save to specified file button. Click to save
the currently open collections as a new
file.

11 Tool tip text that appears over each image
when the clip art is hovered over with the
mouse cursor. Double click to edit.

5 Delete collection button. Click to delete
the current collection from the file.

12 Arrows. Click to move the currently
selected image up or down on the list.

6 Add collections button. Click to add collections from another collections file to
this collection file.

13 Add new image button. Click to add
another image to the current collection.

7 The name and location of the current collections file.

14 Delete image file. Click to remove the currently selected file from the collection.

8 Currently open collections. Each is represented by a tab with its title. Click the
tabs to move to a different collection.

15 Preview area.
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Chapter 11
Application Sharing
Application Sharing enables session participants to share their applications or entire desktops
with others in the session. Application Sharing is a type of content that, like the Whiteboard and
Web Tour, appears in the Content area.
Note: Mobile device users cannot host or remotely control Application
Sharing sessions, only view them. If you want to host an Application
Sharing session, log in to the session from a desktop or laptop computer.
For a list of features supported on mobile devices, see Attending Sessions
on Mobile Devices on page 23.
You will know someone is hosting an Application Sharing session when the blue Application
Sharing activity indicator ( ) appears next to their name in the Participants list. (For details on
activity indicators, see Application Sharing Activity, Permission and Status Indicators on next
page.) In the example below, Vivian is sharing an application or her desktop.
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There are two conditions that need to be met before you can host an Application Sharing
session: you must have been granted the Application Sharing permission and a Moderator must
have switched to Application Sharing mode in the Content Area.

Application Sharing Activity, Permission and Status
Indicators
You can monitor the state of Application Sharing activity and permissions through indicators
displayed in the Participants list of the Participants panel.

Activity and Permission Indicators
The following table describes the icons displayed in the Participant list to indicate Moderator
and Participant permissions and activity while using Application Sharing.

Activity
Indicator

Meaning

User is conducting an Application Sharing session.
Application Sharing permission is set globally to "on" but the Moderator has
revoked Application Sharing permission from this user.
Application Sharing permission is set globally to "off" but the Moderator has
granted Application Sharing permission to this user.

Status Indicators
Status indicators appear on the Application Sharing activity indicator icons of people in the
Participants list if they are experiencing delays in the receipt of Application Sharing content.
l

l

Amber Indicator: Appears when receipt of Application Sharing content is moderately
delayed.
Red Indicator: Appears when receipt of Application Sharing content is significantly
delayed. This may indicate a problem with the network connection and often will be followed by the user getting disconnected from the session.
Note: Only the person currently hosting an Application Sharing session
can see status indicators. Viewers do not see them.
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In the example to the right,
l
l

l

l

Lucy is sharing an application,
Vivian is experiencing a moderate delay in
receiving the Application Sharing content,
Lisa is experiencing a significant delay in
receiving the Application Sharing content,
and
Charlie is not having any problems receiving the Application Sharing content.

Viewing a Shared Application
Application Sharing is displayed in the Content area, which contains an Application Sharing
Action bar in the upper left corner. For Participants without the Application Sharing
permission, the bar contains the Scale to Fit option only (see Scaling the Shared Content
below).

Participants who have the Application Sharing permission have the additional option Request
Cursor Control. For information on this feature refer to Requesting Control of Another's
Application or Desktop on page 180

Scaling the Shared Content
The application or desktop area shared by the Host can be scaled to fit the Content area (the
default) or viewed at its native size (same size as the Host).
To view the content at the same size as the Host, do one of the following:
o

Uncheck Scale To Fit in the Action bar.

o

From the Tools menu, select Application Sharing and then uncheck Scale to Fit.

To restore scaling, recheck Scale To Fit.
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Maximizing the Content Area
Another option you have for viewing an Application Share is to resize the Content area.
You can optimize the space available in the Content area in two ways; for maximum space, do
both:
o

Maximize your Blackboard Collaborate web conferencing window.

o

Hide the side bar (Audio & Video, Participants and Chat panels) by unselecting Show Side
Bar in the View menu or by grabbing the border of any one of the panels and dragging it
all the way to the left.

To restore the side bar, reselect Show Side Bar or drag the panel border back to the right.

Emphasized Cursor
If the application host has turned on the option Emphasize Cursor, you will see their cursor
surrounded with a circle (the default color is yellow), making it easier for you to follow.

Hosting an Application Sharing Session
Application Sharing Mode
Before you can conduct an Application Sharing session, you must have been granted the
Application Sharing permission and must switch to Application Sharing mode in the Content
area. (For details on modes, see The Content Area Modes on page 28.)
Caution: Be careful not to inadvertently switch modes on someone else
who is presenting content. Everyone in the session will follow you to the
new mode.
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Switch to Application Sharing Mode in one of the following ways:
o

In the Collaboration toolbar, click the Application Sharing Mode button.

o

In the View menu, select Application Sharing.

o

Enter the keyboard shortcut Control+Alt+A (Command-Option-A on Mac).

o

In the Tools menu, select Application Sharing followed by Start Sharing….

o

From the Tools menu, select Application Sharing followed by Share Entire Desktop. This
will start Application Sharing immediately without opening the Available Sharing Selections dialog.

When in Application Sharing mode, the Available Sharing Selections dialog will open.

Starting an Application Share
Before you can start an Application Sharing session, you must be in Application Sharing mode.
For details, see Application Sharing Mode on previous page.
Note: If you are on Windows 7 or Vista, administrator privileges may be
required to host an Application Sharing session. For details, see Requesting
Elevated Privileges on Windows 7 or Vista on page 193.

To start Application Sharing, do the following:
1. Open the Available Sharing Selections dialog by clicking on the Start Sharing button in
the Action bar. (If you have the Hosting preference Hide content area turned on, the
Action bar will not be visible.)
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2. Click on Share Desktop or an available program window to select it. For programs with
multiple available windows, click the arrow icon
to expand the list if you wish to share
only one window from the program.
You can share multiple applications or windows by selecting them using Shift or Control.
Note: Minimized (Windows) or docked (Mac) program windows
will not be available to share.

3. Click Share to begin sharing, or Cancel to close the menu without starting a share.
If you wish to begin a new share after canceling, click the Start Sharing button in the
Action bar. (If you have the Hosting preference Hide content area turned on, the Action
bar will not be visible.)
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4. Move the window you wish to share to the front of the desktop. Obscured windows or
portions of windows will not be visible to remote Participants.
Tip: One helpful approach is to resize the window you intend to
share so that it matches the dimensions and position of the Content
area. That way you will be sure to have access to all of the
Blackboard Collaborate web conferencing tools even while you are
sharing.
The Application Share persists until it is closed or the host leaves the session. If a
Moderator switches to Whiteboard or Web Tour mode, the share will still be active, but
not visible until a Moderator switches back to Application Sharing mode. For more
information refer to Stopping an Application Share on page 180.

The Host's View of Application Sharing

When you are the host of an Application Sharing session, by default your shared application or
desktop will have a yellow border around it, making it easy to identify on your screen. (For this
feature to work, some requirements must be met. For details, see the Highlight Shared Region
option under Hosting Options on page 183.)
Attached to the border will be a controller (normally at the top but may move to the bottom, left
side or right side if there is no room for it on the top) with buttons for stopping and
pausing/resuming the application share and a button for sending a snapshot of the Application
Sharing window to the Whiteboard. If the entire desktop is shared, the controller appears in the
top right corner of the screen.

1 Host's Action bar

4 Pause/Resume button

2 Stop Sharing button

5 Send Snapshot to Whiteboard button

3 Host's controller
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Controlling an Application Share
While running an Application Sharing session, a host can, for the most part, continue to use the
program or desktop as usual. However, the Application Share itself can be stopped, paused,
previewed, or captured.
Caution: If you are sharing an application that has a keyboard shortcut
identical to one in Blackboard Collaborate, and focus is on Application
Sharing, the shortcut will activate its associated command in the shared
application, not in Blackboard Collaborate.

Pausing and Resuming an Application Share

A paused Application Share can be easily restarted later. To pause Application Sharing, do one of
the following:
o

In the Action bar, click Pause Sharing. (If you have the Hosting preference Hide
content area turned on, the Action bar will not be visible.)

o

From the Tools menu, select Application Sharing and then Pause Application Sharing.

o

In the Host's controller, click the

o

Switch to either Whiteboard mode or Web Tour mode. (For details, see The Content Area
Modes on page 28.)

Pause button.

To resume Application Sharing, do one of the following:
o

In the Action bar, click Resume Sharing. (If you have the Hosting preference Hide
content area turned on, the Action bar will not be visible.)

o

From the Tools menu, select Application Sharing and uncheck Pause Application
Sharing.

o

In the Host's controller, re-click the

Pause button.

Previewing an Application Share

Hosts can activate a small preview window to see how the shared application or desktop appears
to others. This helps hosts know if part of a shared window is obscured or if the application
share becomes frozen or lost.
To open the preview window, from the Tools menu select Application Sharing and then Show
Preview.
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Taking a Snapshot

Hosts can send a Snapshot of what is being shared to the Whiteboard. To capture an image and
send it to the Whiteboard, do one of the following:
o

Enter the keyboard shortcut, Control+Print Screen (Control-F13 on Mac).
Tip: The keyboard shortcut is a "hot key", meaning you can
redefine it. For details, see Configuring Hot Keys on page 41.

o

In the Host's controller, click the

Send Snapshot to Whiteboard button.

o

From the Tools menu, select Application Sharing and then
Send Snapshot to Whiteboard, to send an image of the current application share
exactly as it is at that moment; or
Send Snapshot to Whiteboard with Delay, to take the Snapshot after a ten second
delay.

Blackboard Collaborate web conferencing switches automatically to Whiteboard mode and
pauses the Share until the host resumes it. The snapshot will be placed as the background image
of a new Whiteboard slide, immediately after the current Whiteboard page. The title of the new
page will be Application Sharing Image x, where x is an incremental number.

Giving Control of an Application Share to Another
Application Sharing hosts can let others in the session remotely control their (the host's) shared
applications or desktops. When remotely controlling another's application or desktop, you can
move the mouse cursor, click, and type. The host of the application share also retains control at
all times, and can revoke control from the remote controller at any time. Only the host and one
other person can share control at once.
There are two ways for a person to remotely control your shared application or desktop:
n

You can delegate control to them.

n

They can request control from you, which you can reject or approve.
Note: Participants do not need the Application Sharing permission to
take control if you delegate control to them. They do, however, require
the Application Sharing permission to request control. (See Requesting
Control of Another's Application or Desktop on page 180.)

When sharing an application window or a program, the remote participant's control is limited
only to that application. The participant has no access to other areas of the host's desktop.
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Caution: Be very careful when giving remote control access to your
desktop as the remote controller has full user control over your computer.
Do not leave your remotely controlled session unattended.

Delegating Remote Control

To pass control of an Application Share that you are hosting to another person, do one of the
following:
l

l

l

Right-click (Control-click on Mac) on the desired person in the Participants list and, from
the context menu, select Give Control of Shared Applications.
Open the Participant Options menu of the desired person in the Participants list and
select Give Control of Shared Applications.
Select the desired person in the Participants list. From the Tools menu select Application
Sharing followed by Give Control of Shared Applications.

The person remotely controlling your Application Share will have joint control over your cursor
until you revoke it (see Revoking Control on the facing page) or they voluntarily end their
control (see Giving Control of an Application Share to Another on previous page).

Granting a Request for Control of an Application Share

Moderators and Participants with the Application Sharing permission can initiate a request for
control of your shared application or desktop (see Requesting Control of Another's Application
or Desktop on page 180). When someone requests control, the host's experience depends on the
settings found in the Remote Control preferences (see Permitting Remote Control of Your
Desktop on page 185). By default, you will see the Remote Control Requested dialog appear on
your screen:
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n
n

To allow a participant access to the desktop one time, click Yes.
To allow future requests for control from any participant with the appropriate permissions
without requiring approval, check Allow all other requests until I quit. This setting
lasts until the host exits the session.
To require a password from Participants who request control, enter the password in the
field below. Participants who request control will be prompted for this password without
notifying the host.

n

To deny the Participant access to the desktop one time, click No.

Caution: Be very careful when giving remote control access to your
desktop as the remote controller has full user control over your computer.
Do not leave your remotely controlled session unattended.

Revoking Control

To revoke a person's ability to remotely control your Application Share (whether you delegated
control or the person requested it), do one of the following:
o

Type the keyboard shortcut for revoking control. The default is Control+Space
(Command-Space on Mac).
Tip: The keyboard shortcut is a "hot key", meaning you can
redefine it. For details, see Configuring Hot Keys on page 41.

l

l

o

Right-click (Control-click on Mac) on the desired person in the Participants list and, from
the context menu, select Take Away Control of Shared Applications.
Open the Participant Options menu of the desired person in the Participants list and
select Take Away Control of Shared Applications.
From the Tools menu, select Application Sharing followed by Take Away Control of
Shared Applications.
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Stopping an Application Share
To stop an Application Sharing session, do one of the following:
o

Enter the keyboard shortcut, Control+Shift+S (Control-Shift-S on Mac).
Tip: The keyboard shortcut is a "hot key", meaning you can
redefine it. For details, see Configuring Hot Keys on page 41.

o

In the Action bar, click Stop Sharing. (If you have the Hosting preference Hide content
area turned on, the Action bar will not be visible.)

o

From Tools menu, select Application Sharing followed by Stop Sharing.

Requesting Control of Another's Application or Desktop
Application Sharing privileges are required to request control of someone else's desktop or
shared application.
Note: If you are on Windows 7 or Vista, administrator privileges may be
required to control another's shared application or desktop. For details, see
Requesting Elevated Privileges on Windows 7 or Vista on page 193.

Requesting Control of Someone Else's Desktop
Moderators and Participants with the Application Sharing permission can request control of
another person's desktop at any time – even when the session is not in Application Sharing
mode.
When you receive permission to remotely control someone else’s desktop, that person retains
the ability to control their desktop as well – control is shared.
Note: If a different user already has control of the desktop you want to
control, or the desktop owner is already sharing their own desktop, you
will not be able to request control (Request Desktop Control will be
disabled).
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To request control of another Participant’s desktop, do the following:
1. Select the person in the Participants list from whom you wish to request desktop control.
2. In the Tools menu, open the Application Sharing menu and select Request Desktop
Control. The desktop owner will receive a notification that you are requesting control of
their desktop. They may grant or refuse your request.
3. Depending on the Host's settings, you may be prompted for a password. For more
information on these settings, refer to Permitting Remote Control of Your Desktop on
page 185.

Requesting Control of an Application Share from the Host
Moderators and Participants with the Application Sharing permission can request cursor control
from the Host of a current Application Share.
1. Send a request to the Host through one of the following methods:
o

In the Action Bar at the top left of the Content area, click Request Cursor
Control.

This option does not appear if the viewer does not have Application Sharing
permission.
o

In the Tools menu, select Application Sharing and click Request Control of Shared
Applications.

The desktop owner will receive a notification that you are requesting control of their
shared application. They may grant or refuse your request.
2. Depending on the Host's settings, you may be prompted for a password. For more
information on these settings, refer to Permitting Remote Control of Your Desktop on
page 185.

Simulated Keystrokes
Simulated keystrokes can be sent to an Application Sharing host's system when remote
controlling it from a computer running a different operating system. For example, you may want
to remotely control a Mac from your Windows system. Since Windows does not have a
Command key, you can simulate Mac accelerator keys, such as Command-C, by defining them
using the Simulated Keys list in the Preferences dialog.
Also, some key combinations may be intercepted by the local operating system before they can
be sent to the remote Share. One common example is Alt+Tab (Windows) or Command-Tab
(Mac).
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Note: You can create, modify and delete simulated keystrokes in the
Preferences dialog. For details, see Configuring Simulated Keystrokes on
page 190.

Sending Simulated Keystrokes

To send a keystroke that can't be sent from the keyboard, do the following:
1. In the Tools menu, select Application Sharing and then Send Key. If the key combination
you need appears on the submenu, click it to send it. Otherwise, click Other…
2. If you clicked Other…, the Define Keystroke dialog appears.

Place your cursor in the text field and type a key to enter keystrokes directly.
Click the arrow
to open a menu containing several common keys that are not on
all keyboards or are likely to be intercepted by the operating system.
Check one or more of the toggle boxes to add that modifier key to your keystroke.
(These are the most common keystrokes that cannot be entered manually.)
3. Click OK to send the keystroke. Click Cancel to return to the Share without sending a
keystroke.
Note: The list of available simulated keystrokes can be changed by
defining simulated keys in the Preferences dialog. To add or modify a
simulated key, refer to Configuring Simulated Keystrokes on page 190.

Releasing Remote Control
You can relinquish control of a remotely controlled desktop or Application Share at any time. To
do so, open the Tools menu and select Application Sharing followed by Release Control of
Shared Applications. This menu item does not appear unless you are remotely controlling
another's desktop of Application Share.
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Advanced Application Sharing Options
Prior to hosting an Application Sharing session, you can define the following options through
the Preferences dialog box:
l
l

Filtered Keys
Hosting Options (to set the appearance of the Application Sharing window when you are
hosting an Application Sharing session)

l

Remote Control

l

Simulated Keys
Mac Note: Mac users also can set the option to use Open GL. See Using
OpenGL Option (Mac only) on page 193.

Hosting Options
The Hosting Options dialog box allows you to define how to display the Blackboard Collaborate
web conferencing Application Sharing window while you are hosting an Application Sharing
session.
To change the Hosting Options in the Preferences dialog, do the following:
1. Open the Preferences dialog in one of the following ways:
o

From the Edit menu, select Preferences… (Windows & Linux)
From the Blackboard Collaborate web conferencing menu, select Preferences
(Mac OS X)

o

Enter Ctrl+Comma (Windows & Linux)
Enter Command-Comma (Mac OS X)
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2. In the left pane of the Preferences dialog, select Hosting Options under Application
Sharing. The Hosting Options preferences panel appears.

3. Change any options:
Hide content area – Select this option to collapse the Content area of the Blackboard Collaborate interface, leaving only the sidebar visible.
Shared region highlight color – Use this option to set the color of the border surrounding your shared application. The border identifies what is being shared so you
will always know what the viewers of your application share are seeing
Raise shared applications to front – Select this option if you want the application
that is being shared to be brought to the front of all other windows. If the option is
not selected, the application may be hidden behind other windows on your monitor
and the Application Sharing window will be black.
Linux Note: This option does not work on Linux using KDE
or Gnome.
Emphasize cursor – Select this option if you would like the cursor in your shared
application to stand out so it is easier for viewers of the shared application to follow
its movements. If set, the viewer’s cursor will be surrounded by a colored circle. (As
host, your view of the cursor is not emphasized.) Click the colored box to the right
to change the highlighter color.
Show a notification – Select this option if you want a Notification window to appear
on your monitor every time you start hosting an Application Sharing session. If you
wish not to have this window appear, de-select this option.
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4. Click on OK to save your preferences and close the Preferences dialog, Apply to save
your preferences and leave the Preferences dialog open or Cancel to close the Preference
dialog without saving any of your changes.
When you configure preferences, Blackboard Collaborate web conferencing will remember the
settings each time you join another session on the same computer.
Note: You can restore your preference settings to the default. For details
on restoring default preferences, see Restoring Default Preference
Settings on page 11.

Permitting Remote Control of Your Desktop
You can grant permission to anyone with Application Sharing permissions to take control of
your desktop at anytime during the session. There are three choices for granting permission to
others to control your desktop: Ask me for permission, Require password and Allow without
asking.
1. Open the Preferences dialog in one of the following ways:
o

From the Edit menu, select Preferences… (Windows & Linux)
From the Blackboard Collaborate web conferencing menu, select Preferences
(Mac OS X)

o

Enter Ctrl+Comma (Windows & Linux)
Enter Command-Comma (Mac OS X)

2. In the left pane of the Preferences dialog, expand the Application Sharing list and select
Remote Control. The Remote Control preferences panel appears.
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3. Select the desired Remote Control option:
Ask me for permission – See Ask me for permission below for details.
Require password – See Require password on the facing page.
Allow without asking. – See Allow without asking on the facing page.
4. Click on OK to save your preferences and close the Preferences dialog, Apply to save
your preferences and leave the Preferences dialog open or Cancel to close the Preference
dialog without saving any of your changes.
When you configure preferences, Blackboard Collaborate web conferencing will remember the
settings each time you join another session on the same computer.
Note: You can restore your preference settings to the default. For details
on restoring default preferences, see Restoring Default Preference
Settings on page 11.

Ask me for permission

If you want other users to request permission from you to remotely control your desktop, set the
Remote Control option to Ask me for permission. Any time a user with Application Sharing
permissions requests control of your desktop, the Remote Control Requested dialog box will
appear on your monitor.
Select the option Allow all other requests until I quit, and leave the password field blank, if you
want to allow other users to be able to control your desktop without asking permission for this
session only. (This is equivalent to the Allow without asking option except that it resets at the
end of the session instead of being saved with other preferences.)
1. Select the option Allow all other requests
until I quit, and enter a password, if you
want to allow other users to be able to
control your desktop only if they enter a
password. (This is equivalent to the Require
password option.)
2. Click on Yes to grant the user permission to
remotely control your desktop.
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3. If you click on No (or the window expires before you acknowledge the message),
permission to remotely control your desktop will be denied. A message, indicating that the
request was denied, will appear to the user requesting access.

Require password

If you want to require other users to enter a password prior to being able to remotely control
your desktop, set the Remote Control option to Require password. Only those who enter the
correct password will have access to your desktop.
1. Any time a user with Application Sharing permissions requests control of your desktop,
the Password Required dialog box appears on their monitor.
2. They must enter the correct password and click on
OK before your desktop will appear in their
Application Sharing window. You do not have to
acknowledge the request.

Allow without asking

If you want anyone with Application Sharing permissions to be able to control of your desktop
without asking, set the Remote Control option to Allow without asking.
Warning: This option lets anyone in the session take control of your
computer remotely. This preference will be saved with your computer and
will be the selected option in any future sessions until it is changed.
At anytime during the session, when anyone with Application Sharing permissions requests
control of your desktop, your desktop will automatically appear in their Application Sharing
window. You do not have to acknowledge the request.
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Filtered Keys
When you allow others to remotely control your Application Sharing session, there are some
keystrokes that you may not want them to be able to enter on your computer. For example,
Windows users probably don't want remote controllers to issue the Ctrl+Alt+Delete command,
which can be used to lock or log out of your computer. To protect your computer, prevent a
remote controller's keystrokes from reaching your computer by adding them to the Filtered Keys
list in the Preferences dialog.
Note: The default set of filtered keystrokes is defined on a per-platform
basis.
Within the Filtered Keys panel of the Preferences dialog, you can add new keystrokes, modify
the existing keystrokes or remove the keystrokes from the list.
1. Open the Preferences dialog in one of the following ways:
o

From the Edit menu, select Preferences… (Windows & Linux)
From the Blackboard Collaborate web conferencing menu, select Preferences
(Mac OS X)

o

Enter Ctrl+Comma (Windows & Linux)
Enter Command-Comma (Mac OS X)

188

Application Sharing

2. In the left pane of the Preferences dialog, under Application Sharing select Filtered Keys.
The Filtered Keys preferences panel appears.

3. Add (See Adding Filtered Keys on next page), modify (Modifying a Keystroke on next
page), or remove keystrokes (Removing a Keystroke on next page).
4. Click on OK to save your preferences and close the Preferences dialog, Apply to save
your preferences and leave the Preferences dialog open or Cancel to close the Preference
dialog without saving any of your changes.
When you configure preferences, Blackboard Collaborate web conferencing will remember the
settings each time you join another session on the same computer.
Note: You can restore your preference settings to the default. For details
on restoring default preferences, see Restoring Default Preference
Settings on page 11.
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Adding Filtered Keys

1. In the Filtered Keys preferences panel, click on the
Add button. The Configure Filtered Keystroke
dialog opens.
2. Enter new keystrokes in one of two ways:
o

Click the arrow
to select a key from the list
and then select the desired modifier keys by
clicking their check boxes. For example, the
keystroke to the right is Ctrl+Alt+Insert.

o

Place your cursor in the text field and enter
the keystrokes directly. The boxes for the
modifier keys you typed will automatically be
checked.
There are certain keys that cannot be entered as keystrokes (such as Tab,
which will cause your focus to move to the next field) and must be
selected from the menu.

Modifying a Keystroke

1. In the Filtered Keys preferences panel, select the keystroke you wish to modify.
2. Click on the Modify button. The Configure Filtered Keystroke dialog box opens.
3. Make your modifications. (For instructions, see Adding Filtered Keys on page 190.)

Removing a Keystroke

1. In the Filtered Keys preferences panel, select the keystroke you wish to remove.
2. Click on the Remove button. The keystroke will be removed from the list.

Configuring Simulated Keystrokes
Simulated keystrokes can be sent to an Application Sharing host's system when remote
controlling it from a computer running a different operating system. For example, you may want
to remotely control a Mac from your Windows system. Since Windows does not have a
Command key, you can simulate Mac accelerator keys, such as Command-C, by defining them
using the Simulated Keys list in the Preferences dialog.
Within the Simulated Keys panel of the Preferences dialog, you can add new keystrokes, modify
the existing keystrokes or remove the keystrokes from the list.
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Note: The default set of simulated keystrokes that may be sent is defined
on a per-platform basis.
Change the Simulated Keys in the Preferences dialog.
1. Open the Preferences dialog in one of the following ways:
o

From the Edit menu, select Preferences… (Windows & Linux)
From the Blackboard Collaborate web conferencing menu, select Preferences
(Mac OS X)

o

Enter Ctrl+Comma (Windows & Linux)
Enter Command-Comma (Mac OS X)

2. In the left pane of the Preferences dialog, under Application Sharing select Simulated
Keys. The Simulated Keys preferences panel appears.

3. Add (see Adding Simulated Keys on next page), modify (see Modifying Simulated Keys on
page 193), or remove (Removing Simulated Keys on page 193) keystrokes.
4. Click on OK to save your preferences and close the Preferences dialog, Apply to save
your preferences and leave the Preferences dialog open or Cancel to close the Preference
dialog without saving any of your changes.
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When you configure preferences, Blackboard Collaborate web conferencing will remember the
settings each time you join another session on the same computer.
Note: You can restore your preference settings to the default. For details
on restoring default preferences, see Restoring Default Preference
Settings on page 11.

Adding Simulated Keys

1. In the Simulated Keys preferences panel, click
on the Add button. The Configure Keystroke
dialog opens.
2. Enter new keystrokes in one of two ways:
o

Click the arrow
to select a key from
the list and then select the desired modifier keys by clicking their check boxes.
For example, the keystroke to the right
is Ctrl+Alt+Insert.

o

Place your cursor in the text field and
enter the keystrokes directly. The boxes
for the modifier keys you typed will automatically be checked.

3. Enter a trigger keystroke (optional). Sending
the triggered keystroke in the Application
Sharing window will not send the typed
triggered keystroke, but the associated simulated keystroke.
4. You may further define the keystroke to be applicable only on a specified host client. The
choices here are Windows, Mac OS and Linux.
5. Click on OK.
Example Definition

Since you cannot type the ⌘ Command key from a Windows system, you could define a
simulated keystroke as follows:
l

Keystroke to send: Meta+X (On Windows, the Meta key is labeled “Windows”.)

l

Trigger on: Ctrl+X

l

Only when host is: Mac

This will then automatically translate the Windows Ctrl+X (Cut command) gesture to the
appropriate Mac gesture and only do it when remote controlling an application on a Mac.
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Modifying Simulated Keys

1. In the Simulated Keys preferences panel, select the keystroke you wish to modify.
2. Click on the Modify button. The Configure Keystroke dialog box opens.
3. Make your modifications. (For instructions, see Configuring Simulated Keystrokes on
page 190.)

Removing Simulated Keys

1. In the Simulated Keys preferences panel, select the keystroke you wish to remove.
2. Click on the Remove button. The keystroke will be removed from the list.

Using OpenGL Option (Mac only)
OpenGL is a 3D imaging system used by many Mac programs (e.g., Keynote) for performing 3D
graphics effects directly on the video card (i.e., not rendered by the system CPU). OpenGL is the
preferred screen capture mechanism on a Mac as it will capture screen images from virtually all
applications correctly.
To get the best screen captures in Application Sharing, select the Use OpenGL option: from the
Tools menu, select Application Sharing followed by Use OpenGLs.
Caution: Turning on the Use OpenGL option will slow Application
Sharing. If you are experiencing delays, turn the option off.

Requesting Elevated Privileges on Windows 7 or Vista
If you are using Windows 7, Vista or Windows 8, any actions taken in a shared application that
bring up User Account Control (UAC) security dialogs will cause Application Sharing to
terminate. By requesting Elevated Privileges in Blackboard Collaborate, you will be able to
circumvent the UAC dialogs and host your Application Sharing session, or remotely control
another's session or desktop, without incident.
For full details on User Account Control, refer to the Knowledge Base
article How to use User Account Control and Application Sharing on
Vista and later:
http://support.blackboardcollaborate.com/ics/support/default.asp?
deptID=8336&task=knowledge&questionID=1700
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To request elevated privileges, follow the steps below.
Tip: If you are logged on to Vista/Windows 7/Windows 8 as a standard
user, you will need an administrator password (and possibly user name) in
order to request elevated privileges. Please obtain this information from
your system administrator.
1. From the Tools menu, select Application Sharing and then Request Elevated Privileges.
2. Respond to the UAC dialog presented to you:
n

n
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If you are logged on to Vista/Windows 7/Window 8 as a standard user, enter an
administrator password (and possibly user name) for your computer.

If you are logged on to Vista/Windows 7/Windows 8 as an administrator, click on
Allow.
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Chapter 12
Web Tour
The Web Tour feature enables session participants to share web pages with others in the session.
Web Tour is a type of content that, like the Whiteboard and Application Sharing, appears in the
Content area.
Note: This feature is not supported on mobile devices. For a list of
features that are supported, see Attending Sessions on Mobile Devices on
page 23.
A Web Tour also can be opened up in an external browser; this is called a Web Push. For details
on the differences between Web Tours and Web Pushes, see Web Tour vs. Web Push on page
201.
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The Web Tour interface has the following components:

1 Collaboration toolbar

5 Address text box

2 Navigation bar

6 Follow Me option

3 Back button

7 Options menu

4 Forward button
You will know someone is hosting a Web Tour when the blue Web Tour activity indicator ( )
appears next to their name in the Participants list. (For details on activity indicators, see Web
Tour Activity and Permission Indicators on the facing page.) In the example below, Vivian is
hosting a Web Tour.

There are two conditions that need to be met before you can host a Web Tour: you must have
been granted the Web Tour permission and a Moderator must have switched to Web Tour mode
in the Content Area.

Web Tour Mode
Before you can conduct a Web Tour, you must have been granted the Web Tour permission and
must switch to Web Tour mode in the Content area. (For details on modes, see The Content
Area Modes on page 28.)
Caution: Be careful not to inadvertently switch modes on someone else
who is presenting content. Everyone in the session will follow you to the
new mode.
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Switch to Web Tour Mode in one of the following ways:
o

In the Collaboration toolbar, click the Web Tour Mode button.

o

In the View menu select Web Tour.

o

Enter the keyboard shortcut Ctrl+Alt+U (Command-Option-U on Mac).

Web Tour Activity and Permission Indicators
You can monitor the state of Web Tour activity and permissions through indicators displayed in
the Participants list of the Participants panel. These indicators are described in the following
table.
For details about permissions, see Understanding Permissions on page 48.

Activity
Indicator

Meaning

User is conducting a Web Tour (or Web Push).
Web Tour permission is set globally to "on" but the Moderator has revoked
Web Tour permission from this user.
Web Tour permission is set globally to "off" but the Moderator has granted
Web Tour permission to this user.

Starting a Web Tour
Before you can start a Web Tour, you must be in Web Tour mode. For details, see Web Tour
Mode on previous page.
To start a Web Tour, do the following:
1. Select the Follow Me option if you want others to see the web pages to which you will be
browsing. (For details, see The Follow Me Option on next page.)
2. Enter the URL of the desired web site in the Address text box of the Web Tour navigation
bar.

3. Press Enter.

Web Tour

197

Conducting a Web Tour
Within the Web Tour, you can navigate through the current web site by clicking on links or can
move to a different web site by entering a new URL in the Address text box. As you move
between web pages, Web Tour maintains a history of where you have been. You can use the
Back and Forward buttons to move between the pages kept in the history.
Note: Do not use Web Tour for password-protected web sites. Viewers of
the web tour will not be able to follow you past the login screen. To share
password-protected sites, use Application Sharing to share your desktop or
web browser.

The Follow Me Option
By default, your Follow Me option is not selected and you will need to select it if you want
others to view the web pages to which you will be browsing. With Follow Me selected, session
attendees will be able to freely browse to other pages in the Web Tour, independent of the pages
to which you, the tour guide, browses. However, when you move to a new page, they will be
redirected to your new page.
Note: There is one exception: users cannot follow you to web pages
protected by login credentials. They will see an error such as "The web
page cannot be found."
If you don't want to push them to your new pages, unselect the Follow Me option.
When you start a Web Tour, you are automatically the "tour guide". However, a Moderator, or
Participant with the Web Tour permission, can take control of the Web Tour by selecting their
Follow Me option. Your Follow Me option will be unselected. You can take back control by
selecting it again.

Publishing URL to Chat Panel
Moderators, and Participants with the Web Tour permission, can publish the URL of the current
web page to the Chat Conversation pane so it is accessible to (clickable by) everyone. To do so,
select Publish URL to Chat from the Web Tour Options menu.
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Stopping the Web Tour
To stop the Web Tour, do one of the following:
o

Unselect the Follow Me option.

o

Switch to Whiteboard mode. (For details, see The Content Area Modes on page 28.)

Viewing a Web Tour
A Web Tour is a type of content, and appears in the Content area like the Whiteboard and
Application Sharing.
Once someone starts a Web Tour, you can freely navigate to other pages within the website by
clicking on links or using the Back and Forward buttons. However, if the Host of the Web Tour
has selected the Follow Me option, you will be redirected to the Host's current page whenever
the Host moves to a new page.
Note: There is one exception: you cannot follow the Host to web pages
protected by login credentials. You will see an error such as "The web page
cannot be found."
For more information on Follow Me, see The Follow Me Option on previous page.

Optimizing the Content Area
The Web Tour content often may not fit into your Content area so you will have to use the scroll
bars to view web pages.
You can optimize the space available in the Content area in two ways; for maximum space, do
both:
o

Maximize your Blackboard Collaborate web conferencing window.

o

Hide the side bar (Audio & Video, Participants and Chat panels) by unselecting Show Side
Bar in the View menu or by grabbing the border of any one of the panels and dragging it
all the way to the left.

To restore the side bar, reselect Show Side Bar or drag the panel border back to the right.

Enabling Pop-ups in a Web Tour (Windows only)
The web browser embedded in the Blackboard Collaborate web conferencing Content area is, by
default, configured to block popup windows during web tours. When you are connected to
Blackboard Collaborate through a proxy server that requires you to enter authentication
information, the Popup Blocker will prevent the authentication dialog from “popping up” and
you will not be able to provide authentication credentials to the proxy server. (You will get an
Web Tour
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error something like, “This program cannot display the web page.”) In this case, you need to
disable the Popup Blocker the Preferences dialog.
Note: This preference setting is available on Windows systems only.
1. Open the Preferences dialog in one of the following ways:
o

From the Edit menu, select Preferences… (Windows & Linux)
From the Blackboard Collaborate web conferencing menu, select Preferences
(Mac OS X)

o

Enter Ctrl+Comma (Windows & Linux)
Enter Command-Comma (Mac OS X)

2. In the left pane of the Preferences dialog, select Popup Blocker under Web Tour. The
Popup Blocker preferences panel appears.

3. Unselect Block Popups.
4. Click on OK to save your preferences and close the Preferences dialog, Apply to save
your preferences and leave the Preferences dialog open or Cancel to close the Preference
dialog without saving any of your changes.
When you configure preferences, Blackboard Collaborate web conferencing will remember the
settings each time you join another session on the same computer.
Note: You can restore your preference settings to the default. For details
on restoring default preferences, see Restoring Default Preference
Settings on page 11.
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Web Tour vs. Web Push
There are two ways for you to show session attendees web sites: in a Web Tour or a Web Push.
Web Tours are displayed in the Content area of Blackboard Collaborate web conferencing. As
the tour guide, you can control what others see by selecting the Follow Me option (see The
Follow Me Option on page 198). Although session attendees will be able to browse within the
web site you opened in the Web Tour, as soon as you move to a new page, they will be redirected
to your new page.
To start or view a Web Tour, you must be one of the following systems:
n

any supported Windows system

n

any Mac OS X 10.5 or higher running a 32-bit or 64-bit JVM

A Web Push is a type of Web Tour in which the specified web page opens up in the default web
browser of each session attendee (including the host's) – outside of the Blackboard Collaborate
application. Session attendees will see the web page to which they are initially directed (pushed)
and after that are free to browse to other pages, work with bookmarks, close the window, etc.
When you move to another web page, it will have no affect on what others see in their web
browsers.
Linux Note: If you are on a Linux (Ubuntu) system, you will be able to
perform or view a Web Push only. Therefore, when a Moderator starts a
Web Tour, you will see the specified web page open in your default web
browsers (a Web Push).

Mac Note: In Elluminate Live! 8.5 recordings, Mac OS X users will see
Web Tours as Web Pushes, where each page of a Web Tour will open in a
new external web browser window.

Web Tour
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Starting a Web Push
Before you can start a Web Push, you must be in Web Tour mode. For details, see Web Tour
Mode on page 196.
To start a Web Push, do the following:
1. Select Open URL in Browser… from the Options menu of the Web Tour navigation bar.

The Open URL in Browser dialog opens.

2. Enter the desired URL and click OK.
The web page will open up in everyone's default web browser.
There is no way to stop a Web Push (since it exists outside of Blackboard Collaborate). However,
when you are done presenting a web site in a Web Push, you may want to ask the session
attendees to close their web browsers and redirect their attention back to Blackboard
Collaborate.
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Chapter 13
Breakout Rooms
To facilitate small group collaboration, a Moderator can create rooms separate from the
Blackboard Collaborate Main room and place session attendees into these "breakout" rooms.
Breakout rooms have their own private Audio, Video, Whiteboard, Application Sharing, etc., so
the collaboration that takes place in a breakout room is independent of the Main room (and
other breakout rooms).
Even if there is no Moderator in a breakout room, when anyone in the breakout room raises
their hand or sends a private message to Moderators, Moderators in other rooms will be
notified.
Note: Mobile device users will not see multiple rooms in the Participants
list since they can see only the room they are currently in. For a list of
features supported on mobile devices, see Attending Sessions on Mobile
Devices on page 23.
When the Moderator moves someone into a breakout room, the Participants list is updated,
displaying the name of the room and the names of the people in the room. In the example
below, Lisa and Lucy have been moved to the breakout room called Lab 1.
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1 Name of breakout room you are in
2 Breakout rooms

Moving Yourself into Existing Rooms
If the Moderator allows it, you can move yourself between rooms. You will know you have the
ability to do so when if the Room menu appears in your Participants panel toolbar.

You can send yourself from the Main room to an existing breakout room, a breakout room to
the Main room or from one breakout room to another.
Do one of the following:
o
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From the Room menu in the Participants panel toolbar, select the desired room from the
list of available rooms.

Breakout Rooms

o

From the Options menu of the breakout room to which you want to move, select Enter
Breakout Room.

o

From the Tools menu, select Breakout Rooms, then Send Self to Breakout Room and
finally select the desired room from the list of available rooms.

o

Drag and drop yourself into the desired room in the Participants list. You can drop
yourself on a breakout room's tab or on a person already in that room.

Breakout Rooms
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Chapter 14
Interactive Recordings
While watching a recording of a Blackboard Collaborate web conferencing session, you may
have opportunities to interact with the recording. You may receive a file from the session
Moderator through the File Transfer facility, be prompted to take a Quiz, or be able to navigate
to web pages in Web Tour.
Note: Interactive recordings are not available in Blackboard Collaborate
vRoom™.
Moderators can record sessions and provide you with a link to the recording so you can play the
recording. This is useful for those who have missed a session or to those who attended but
would like to review the session.
Note: Interactive recordings cannot be watched on mobile devices,
however, recordings can be converted to MP3 and MP4 formats, which
can be viewed on mobile devices. However, not all institutions support
conversion of recordings to MP3 and MP4 formats, so consult your
system administrator for details.
All activity that occurs in the Main room of the session will be recorded, except for private Chat
messages, the Timer and personal Notes. (Only the activity in the main Blackboard Collaborate
web conferencing room will be recorded. Anything that occurs in a breakout room will not be
recorded.)
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As the recording progresses, Blackboard Collaborate inserts index entries to mark significant
events within the session (see Using the Recording Index on page 213 for further details).
Anyone viewing the recording can navigate through the recording to points marked with index
entries.
You can tell that a session is being recorded in two ways:
o

A red Recording icon appears in the Collaboration toolbar.

o

The audible notification “Recording started” is played. (If you are using the telephone for
audio communications, you will not hear it.)
Note: If you join the session after recording has already resumed, you will
hear the audible notification “Recording in progress.”

Tip: You can turn audible notifications off. For details, see Setting
Notification Preferences.

Playing a Recording
A recording is played by clicking on a recording link. Access to recordings will be dependent on
your organization’s administrative interface. Please contact your administrator for more
information on accessing recording links.
To open the recording, click on the recording link. A Blackboard Collaborate web conferencing
window will open. Use the Playback Controller panel at the bottom the window to start, stop,
pause/resume and navigate through the recording.
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1 Play/Pause button

5 Show Index Entry Menu button

2 Index Entry marks

6 Playback Time indicator

3 Playback Slider indicator

7 Playback slider

4 Current Index Entry

8 Total Recording Time
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To play a recording or resume a paused a recording:
o

Click the

Play button (to play at normal speed).

o

From the Playback menu, select Player and then Play (to play at normal speed).

o

From the Playback menu, select Player and then Fast Forward (to play at an accelerated
speed).
Note: Video, Multimedia, Web Tour and File Transfer are not displayed
when you fast-forward through a recording. Also, Audio is muted when
fast-forwarding.

As the recording advances, the Playback Time indicator, the Current Index Entry Mark and the
Playback slider will show your progress through the recording.
To pause the recording:
o

Click the

Pause button to stop playing the recording and maintain your current place

in the recording.
o

From the Playback menu, select Player and then Pause.

To stop the recording:
From the Playback menu, select Player and then Stop. When you stop a recording, you will not
maintain your current place in the recording – the recording goes back to the beginning.

Names Hidden in Recordings
If, when viewing a recording, you see session attendee names replaced by the generic
“Participant” (such as in the Chat panel and Participants list), this means that the session creator
configured the session to hide attendee names. This is done to protect the identity of session
attendees.

Interactive Recordings
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Multi-Camera Video in Recordings
If a session with multiple simultaneous cameras is recorded, you cannot choose who’s video
stream to display in the primary video display as you would in a live session. By default, the video
stream of the current speaker is displayed in the primary video display unless, in the live session,
a Moderator had turned on the option Make Video Follow Moderator Focus, in which case the
video stream of the Moderator is displayed in the primary video display.

Navigating Within a Recording
When you play a recording, you are not required to play it from start to finish. You can skip
ahead or move back to areas of particular interest by navigating through a list of index entries.
When Blackboard Collaborate web conferencing is recording a session, it automatically creates
index entries for the following events:
n

Change page in the Whiteboard

n

Change topic in the Whiteboard

n

Start a Web Tour

n

Start an Application Sharing session

n

Stop an Application Sharing session

n

Start playing a Multimedia file

n

Load a file for transfer

n

Start a Quiz

n

Show the Graphing Calculator

n

Hide the Graphing Calculator

n

Connect session to teleconference

n

Disconnect session from teleconference

Moderators also can manually enter custom index entries.
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There are four ways to navigate within a recording:
To...

Do...

Move to a general area within the
recording, not associated with an index
entry
Move to the previous or next index entry

n

n

n

n

Move to any index entry

n

n

Move to any index entry by selecting it
from, or searching for it in, the Recording
Index

n

use the Playback slider (see Using the Playback Slider on next page)
use the Playback slider (see Using the Playback Slider on next page)
use the Index Entry menu (see Using the
Index Entry Menu on next page)
from the Playback menu (in main toolbar),
select Skip Back and Skip to Next menu
options
use the Playback slider (see Using the Playback Slider on next page)
use the Index Entry menu (see Using the
Index Entry Menu on next page)
use the Recording Index (see Using the
Recording Index on page 213)

Note: Regardless of which method you use, it may take several seconds
for the recording to reach the specified location – especially if moving
backward in the recording.

Knowing Where You Are
There are two ways you can determine your current position in a recording:
n

Playback Slider: When you move your cursor over the slider you will see a tool tip
containing the name of the index entry over which you are hovering and the associated
time in the recording. If you are not hovering over an index entry, the tool tip will display
the text “Drag indictor to move within the recording” followed by the time.
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n

Current Index Entry and Time: The Current Index Entry and Current Time are
displayed in the Playback Controller panel. The Current Index Entry displays the icon and
name of the closest index entry within a +/- 30 second range. (The index entry normally
is the same as the text in the Details column of the Recording Index. If there is no
“Details” text, the text will be the same as that in the Kind column of the Recording
Index.) If there is no index entry within that range, there will be no Current Index Entry
displayed. In the example below, the recording is currently at or near the point where the
whiteboard page "Keys to Speaking" is being displayed and 2 minutes and 39 seconds into
the recording.

Using the Playback Slider
You can move to a specific index entry or just move randomly backward or forward in the
recording using the Playback Slider. Grab the Playback Slider Indicator with your cursor and
drag it to the left or right to the desired location in the recording.

Using the Index Entry Menu
If you want to move to a specific index entry, you can select it from the Index Entry menu.
1. Click on the Show Index Entry Menu button in the Playback Controller panel. The
Index Entry menu will open.
2. From the Index Entry menu, scroll to and click on the desired index entry.
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Using the Recording Index
The Recording Index window displays a complete list of all index entries in your recording. You
can navigate to any index entry in the list.

Opening the Recording Index

To open the Recording Index window, select Show Recording Index… from the Playback menu
(in the main toolbar).

1 Seek button

5 Sort icon

2 Suppress option

6 Column headers

3 Play icon

7 Search box

4 Time mark

8 Done button

Tip: You can resize the Recording Index window by grabbing a side or
corner and dragging it. The columns will automatically adjust themselves.
The Recording Index has five columns:
n

n

Play icon column: is the left-most column (it has no text in the column header). It is
used to hold the Play icon, which indicates the current playback position in the recording.
Time column: lists the times in the recording that index entries were created, either
automatically by Blackboard Collaborate web conferencing or manually by you.
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n

n
n

Source column: shows the icon of the Blackboard Collaborate module being used when
the index entry was created. For manually created index entries, the column will show the
Recording icon.
Kind column: gives a description of the event that triggered the index entry.
Details column: describes the specific screen, file, application or web address associated
with the event that triggered the index entry.

The Source, Kind and Details columns can be
resized. Move your cursor over a column divider
between two column headers. The cursor will
change to a double arrow. Drag the column
divider to the desired position.

Moving to an Index Entry

From the Recording Index, you can move to any place in the recording that is marked by an
index entry. You can do so in one of two ways:
o

Double-click on the desired index entry.

o

Select the desired index entry (by clicking on it or using the Up and Down Arrow keys)
and click on the Seek button.

The recording will begin playing at the point you specified. (If the recording was in a paused
state when you selected an index entry, you will have to click on Play to resume playback.)
Note: It may take a few seconds for the recording to reach the specified
location.

Note: The Whiteboard, Video and Multimedia may not be displayed when
you are navigating to an index entry. The Whiteboard will go black, the
Video window will be blank and the Multimedia file window will not open
– unless you are specifically moving to the index for the Multimedia file,
in which case it will open and start playing.

Sorting the Recording Index

The Recording Index can be sorted by the Time, Source, Kind and Details columns.
l
l
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Time: sorts numerically by time mark
Source: sorts by grouping all entries related to the same modules (with the same Source
icon) together

l

Kind: sorts alphabetically

l

Details: sorts alphabetically

Interactive Recordings

Note: You can sort by one column only – there is no secondary sorting
on a second column.
The sort direction is indicated in the column header by the ascending and descending Sort
icons. To sort by a column, click on the column header. Each successive click on the same
header advances the sorting status through a sequence of ascending, descending and unsorted.
The default sort order is by Time, in ascending
order – chronologically from the beginning of the
recording to the end.
Click on the Kind column header to sort by Kind in
ascending alphabetical order.
Click on the Kind column header again to sort by
Kind in descending alphabetical order.
Click on the Kind column header again to stop
sorting by Kind and return to the default sorting
order (Time in ascending order).

Filtering the Recording Index

Sometimes in a session you might rapidly repeat
events, such as quickly skipping through
presentation screens in the Whiteboard. You have
the option of filtering from view any consecutive
duplicate index entries (entries of the same Kind
and from the same Source) that occur within a
couple of seconds of each other. Filtering can help
you eliminate “noise” from your Recording Index.

Interactive Recordings

215

In the example below, a number of index entries were triggered by slide changes in the
Whiteboard. The duplicates are highlighted in yellow.

To filter out the duplicate index entries in the Recording Index, select the option Suppress
duplicate entries. In the example below, the index entries that were highlighted in yellow above
are no longer shown.

Note: Suppressing duplicate entries does not remove them, but just hides
them. To see them again, simply de-select Suppress duplicate entries.
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Searching for an Index Entry

If you have a large recording, it may not be easy to find a particular index entry by scrolling
through the list in the Recording Index. You can quickly find index entries by searching for
specified text in the Kind and Details fields of the index entry.
To search for an index entry, type your search term in the Search box. For example, if you want
to search for index entries containing the term “reaction”, start typing the word in the Search
box.
Note that the search begins almost
immediately as you type, so you will
start getting matching index entries
before you have finished typing the
word. (Note the highlight areas in
the example to the right.) Keep
typing until you get the results you
desire.

Tip: To search immediately, without the one or two second delay, enter
your text and immediately press Enter.

Mac Note: Mac users will see a standard Mac search field rather than
the Blackboard Collaborate search field.
To clear the Search box and end your search, do one of the following:
o

Click the

Cancel button.

o

Press Escape.

Interactive Recordings
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Chapter 15
Notes
The Notes window lets you easily take personal notes during a live Blackboard Collaborate web
conferencing session, edit them and later share them with others. (During the session, only you
will see your own notes.) As you write notes about what is being presented in a session,
Blackboard Collaborate synchronizes the notes to the session timeline. This is very useful when
reviewing recorded sessions later. When playing a recording, the Notes window tracks the
progress of the session and displays the notes that were taken at every point during the session.
(For information on recording sessions, see Chapter 14, Interactive Recordings.)
Note: This feature is not supported on mobile devices. For a list of
features that are supported, see Attending Sessions on Mobile Devices on
page 23.
A new Notes document is created each time you enter a new session and take notes. (If you reenter the same session multiple times, there will be only one Notes document created for that
session for that particular day. If you attend a session that spans multiple days, you will get a
new Notes document for each day.) These documents are saved locally on your computer.
Beyond simple note-taking, the Blackboard Collaborate Notes facility has a number of useful
features:
n

n

You can edit, format or reorganize notes at any time, either during a live session or when
playing a recorded session.
You can share your notes with others.
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n
n

n

You can manage your notes library by importing, exporting and deleting Notes documents.
You can search within your list of Notes documents to easily locate notes taken during a
specific session.
You can view presentation notes imported with a loaded presentation.

The Notes window has the following components:

1 Thumb
2 Notes editor
3 Note Documents list
4 Manage Notes button
5 Export Notes button
6 Import Notes button
7 Text Size menu
8 Search field
9 Close button
10 Delete Notes button
11 Divider

Opening and Closing the Notes Window
Opening and closing the Notes window is quick and simple so, at any time, you can enter a note
without your attention being diverted away from the session in progress.
You can move, resize or close the Notes window so it is not obtrusive. If you close it, you can
reopen it later and continue where you left off. The window remembers where you were when
you closed the window so you can continue entering notes without worrying if your cursor is in
the right position. It also remembers its size and position, so it will appear exactly the same as
the last time you opened it.
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Note: The Notes window always remains in front of the Blackboard
Collaborate web conferencing main window.
The following table describes how to open and close the Notes window:
You want to

Precondition

Use Keyboard Shortcuts

Use menus or other

Open the Notes
window

Notes window is
closed

Ctrl+E (Windows &
Linux)

From Windows menu,
select Show Notes

Command-E (Mac)
Activate the
Notes window
(bring it to the
front)

Notes window is
open but inactive (or
hidden in the back)

Ctrl+E (Windows &
Linux)

From Windows menu,
select Show Notes

Close the Notes
window

Notes window is
open and active

Ctrl+W or ALT+F4
(Windows & Linux)

Click Close button in
Notes window

Command-W (Mac)

From Windows menu,
unselect Show Notes

Command-E (Mac)

Note: You can also open the Notes window by importing a Notes file
through the Collaboration toolbar. For details, see Loading Content
through the Collaboration Toolbar.

Taking Notes
To start taking Notes, do the following:
1. Open the Notes window (as described Opening and Closing the Notes Window on previous page).
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2. Start typing. The cursor is positioned at the top of the Notes editor – presumably that is
where you want to enter your first note. As you enter a note, the text will wrap to fit the
Notes window.
3. Press Enter to end the note and start a new one. A note is similar to a paragraph (in a
word processor) in that pressing Enter ends a note and creates a new one immediately
below it. (To enter a new note somewhere other than directly below the existing note, see
Inserting Notes on page 226.)
Tip: If you want to enter a line break without creating a new note, press
Alt-Enter (Option-Enter on Mac).

Creating Lists
The Notes window provides basic support for creating lists. You simply enter designated list
characters at the beginning of a line. When you press Enter, those characters are examined to
determine if this line is part of a list. All list items will remain grouped together in the same
note.
1. Type the desired special list character (refer to
the following table) followed by the text for
the first list item.
2. Press Enter to create the next line in the list.
3. Manually preface each list item with the special list character – it is not done automatically like in a word processor.
4. Press Enter twice to end the list. A new note
will be created below.

222

Notes

Use the following special list characters to create your list:
Character(s)

Description

-

Create a hyphenated list

•

Create a bulleted list
Alt-0149 using numeric keypad on Windows
Option- 8 on Mac OS X

1.

Create a numbered list where numbers are followed by periods

2-

Create a numbered list where numbers are followed by hyphens

3)

Create a numbered list where numbers are followed by parentheses

a. or A.

Create a lettered list where letters are followed by periods

a- or A-

Create a lettered list where letters are followed by hyphens

a) or A)

Create a lettered list where letters are followed by parentheses

Formatting Notes Text
To enhance the readability of your notes, Notes lets you change font size and apply basic text
styles to your notes.

1. Select the text you want to format.
2. Enter the desired keyboard shortcut to format the text (see the following table).
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Note: You can use most standard text editing mouse actions within the
text of notes, such as double-clicking to select a word and dragging to
select text.
The following standard text editing keyboard shortcuts can be used to perform functions within
the text of individual notes.
Function

Windows & Linux Shortcuts

Mac OS X Shortcuts

Make selected text Bold

Ctrl+B

Command-B

Make selected text Italics

Ctrl+I

Command-I

Underline selected text

Ctrl+U

Command-U

Decrease font

Ctrl+[

Command-[

Ctrl+-

Command-Minus Sign

Ctrl+]

Command-]

Ctrl+=

Command-=

Select all text in current note

Ctrl+A

Command-A

Copy selected text

Ctrl+C

Command-C

Cut selected text

Ctrl+X

Command-X

Paste copied text

Ctrl+V

Command-V

Delete selected text

Delete

Delete

size of selected text

Increase font size of selected text

Backspace
Insert a line break within a note

Alt+Enter

Option-Enter

Note: Text formatting will not be retained if you copy and paste
formatted text from one note to another, or to an external text editing
application.

Changing the Text Size in the Notes Editor
You can change the size of the text displayed in the Notes editor to make it more readable for
you. The font size of the entire document will change and any changes that were made using the
Decrease and Increase keyboard shortcuts will be overridden.
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The available text sizes are 8, 9, 10, 11, 12, 13, 14, 15, 16, 18, 20, 22, 24, 28, 32 and 36 points. To
change the font size of the text, do one of the following:
o

Select the font size from the Text Size menu in the tool bar of the Notes window.

o

Right click (Control-Click on Mac) anywhere in the Notes
editor and select one of the options from the context
menu.
Make Text Bigger – increase the text size to the
next larger size. For example, if the text was set to
12, selecting Make Text Bigger will increase the size
to 13.
Make Text Smaller –decrease the text size to the
next smaller size. For example, if the text was set to
36, selecting Make Text Smaller will decrease the
size to 32.
Default Size –set the text size back to the default
setting of 12. (This value may be different for nonEnglish implementations of Blackboard Collaborate
web conferencing.)
Text Size – change the text size to that selected
from the submenu.

Working with Notes
Once you have entered your notes, you can work with them in a number of ways:
l

Select them (see Selecting Notes on next page)

l

Insert them (see Inserting Notes on next page)

l

Move them (see Moving Notes on page 228)

l

Delete them (see Deleting Notes on page 228)

l

Print them (see Printing Notes on page 228)

l

Save them (see Saving Notes on page 229)
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Selecting Notes
You need to select notes to perform operations on them, such as moving and deleting them.
To select a note, you need to select the thumb associated
with the note. When a note is selected, its thumb is
highlighted. You can do so in one of two ways:
o

Click directly on the thumb. Note that the mouse
pointer changes from an arrow to a hand. This
means you can drag the note to another location.

o

Press Escape. The thumb of the note that was currently being edited will be highlighted, indicating
the note is selected.

There are also keyboard shortcuts you can use to select notes:
Windows & Linux
Shortcuts

Mac OS X Shortcuts

Initial note is selected

press Up Arrow
twice

press Up Arrow
twice

Cursor is within text of
note

press Enter twice

press
EnterorReturn
twice

Initial note is selected

press Down
Arrow twice

press Down
Arrow twice

Cursor is within text of
note

press Escape

press Escape

Function

Precondition

Select the previous note
Select the next note

Select the note you are
currently entering or
editing

Inserting Notes
Typically, when you are first entering your notes, you will simply press Enter to create a new
note beneath the existing note. However, you can insert new notes anywhere in the Notes editor
– when initially entering them or editing them later. The existing notes will re-flow
automatically to make room for the new note.
Other than inserting a note below the existing note, you can insert new notes
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l

before the existing note,

l

between existing notes, or

l

anywhere in the Notes editor.
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Use keyboard shortcuts to insert notes:
Windows & Linux
Shortcuts

Function

Precondition

Insert a new note
immediately below the
existing note

Cursor is within text Enter
of note

Enter or Return

Initial note is
selected

Enter or
Down Arrow

Enter or Return or
Down Arrow

Initial note is
selected

Up Arrow

Up Arrow

Insert a new note
immediately above the
existing note

Mac OS X Shortcuts

Use a click of the mouse to insert new notes:
To insert a new note between two existing To insert a new note anywhere in the
notes, click between the two notes (either Notes editor, click any blank area in the
between text or thumbs).
Notes editor. (For example, you may want
to leave blank areas to remind you to go
back and fill in further details later on.)

Note: Each note has an internal timestamp (not visible to you) that keeps
it synchronized with its associated activity within the session. When you
enter a new note between two existing notes, the timestamp of the new
note will be a relative time between the time stamps of the two existing
notes.

Notes

227

Moving Notes
Notes can be moved up and down and reorganized freely
using the mouse. Other notes will automatically re-flow if
needed to make room for moved notes.
1. Click on the thumb of the note you want to move.
When the mouse is hovering over the thumb, the
cursor changes to a hand to indicate it can be
grabbed.
2. Hold down the mouse and drag the note vertically
to the desired location.
3. Release the mouse to drop the note.

You can also use keyboard shortcuts to move notes:

Function

Precondition

Windows & Linux
Shortcuts

Mac OS X Shortcuts

Move the selected note Note is selected Alt + Up Arrow
above the previous note

Option-Up Arrow

Move the selected note
below the next note

Option-Down Arrow

Note is selected Alt + Down Arrow

Note: Each note has an internal timestamp (not visible to you) that keeps
it synchronized with its associated activity within the session. When you
move a note between two other notes, the timestamp of the moved note
will be a relative time between the time stamps of the two other notes.

Deleting Notes
To delete a note, select it (click on its thumb) and press Delete or Backspace.

Printing Notes
To print notes, you must export the Notes document as a .txt file (see Exporting Notes
Documents on page 232), open it in a text editor and use the text editor’s print facility.
Note: Exported .txt files do not retain time stamp and formatting
information.
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Saving Notes
You never have to save individual notes because Notes documents are saved automatically to
your local hard drive.
For information on saving a Notes file, see Exporting Notes Documents on page 232.

Viewing Presenter Notes Imported with a Presentation
Sometimes Moderators include a presentation’s
presenter notes when they load a presentation
into the Whiteboard. These notes will appear in
your Notes editor, where each presenter note
becomes a separate entry and is prefaced with
the name of the associated slide (as shown in
the screen capture to the right).
If you already have notes within your Notes
editor, the presenter notes will be appended to
the end.
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Managing Notes Documents
In addition to working with individual notes in the Notes Editor, you can manage Note
Documents in the following ways:
l

Open them (see Opening the Notes Documents List below)

l

Search for them (see Searching for Notes Documents on the facing page)

l

l

Export and import them (see Exporting and Importing Notes Documents on the facing
page)
Delete them (see Deleting Notes Documents on page 236)

Opening the Notes Documents List
The Notes Documents list displays a list of the sessions for which you took notes. It is always
closed when the Notes window is first opened in a Blackboard Collaborate web conferencing
session, as the primary purpose of the Notes window is to take notes for the present session.
There are two ways to open the Notes Documents
list:
o

Click on the

Manage Notes button.

o

Drag the divider down using the mouse.

The Notes Documents list displays the date and
name of each session that has notes associated with
it. Sessions are always listed in reverse chronological
order; this order cannot be changed.
Selecting any Notes document in the list displays its
notes in the Notes editor below.
The Notes document for the current session is
highlighted in bold.
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You can select multiple Notes documents. (Select the
first Notes document and hold down Control (Command
on the Mac) as you select the remaining notes.) When
they are for different sessions then nothing is displayed
in the Notes editor. When they are for the same session,
the multiple Notes documents will be compounded
(merged) and displayed as one. See Using Compound
Notes on page 237 for details.
When no Notes documents are selected, the Notes editor
is blank.

Searching for Notes Documents
Over time, your list of Notes documents will grow and locating a specific session document by
scrolling the list may become increasingly challenging. The Search Notes Documents feature can
be used to filter the Notes Documents list by allowing you to display only those Notes
Documents whose session name contains your specified search string.
Tip: To display the Search field, you must first open the Notes
Documents list by clicking on the
Manage Notes button.
Session dates are not searchable. Sessions are
listed in reverse chronological order and it is
easy for you to scroll to the desired date.
The list of Notes documents is updated
dynamically as you type.
Note: The Search field cannot be
used to search the text within
notes in the Notes editor.
Therefore, it is hidden when the
Notes Documents list is closed.

Exporting and Importing Notes Documents
You can share your notes with someone else by exporting and importing Notes documents.
Perhaps someone could not attend a session and would like to review your notes while playing a
recording of the session. Or maybe two of you (who both attended a session) would like to
compare notes.
You may also want to export notes to open them in another application to edit or print them.
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n

For details on exporting Notes documents, see Exporting Notes Documents below.

n

For details on importing Notes documents, see Importing Notes Documents on page 234.

Exporting Notes Documents

Notes can be exported in one of two formats.
l

l

For sharing notes with others to use within a Blackboard Collaborate web conferencing
session, export them as Notes documents (.eln files).
For importing notes into other applications, export them as text files (.txt files).

Notes Document (.eln file): An .eln document is the format used within Blackboard Collaborate

It is not suitable for importing into other applications as other applications cannot interpret
them (making them unreadable). However, as .eln files retain all timestamp and formatting
information, they are the format required to share notes with others. When imported back into
Blackboard Collaborate, they are perfectly readable.
Text File (.txt file): A .txt file can be opened by any application that reads text files. Because .txt

files do not retain time stamp and formatting information, they cannot be used to share notes
with others in Blackboard Collaborate However, if you want to edit or print a Notes document in
another application, export them as .txt files as the notes will be in a readable format (as in the
sample to the right).

Tip: Another way to export notes is simply to copy and paste them into
another application. As with exporting via a .txt file, the text formatting
(bold, italics, etc.) will not be retained.
It is possible to export either one or multiple Notes documents at once.
Note: If the multiple documents pertain to the same session (same
name and date), they are automatically compounded into a single file
during export. See Using Compound Notes on page 237 for more
information.

232

Notes

To export Notes documents, follow the steps below:
1. From the Notes Documents list, select the Notes
document(s) you want to export.
2. Click on the

Export Notes button at the

top of the Notes window. The Save file dialog will
open.
3. Browse to the directory in which you want to
save your Notes documents. (Blackboard Collaborate will remember this location the next
time you export Notes documents.)

4. Select the file format in which you want to save your Notes documents.
5. Enter a name for your Notes document. (See Notes Document Filenames on page 233for
further information.)
6. If you are exporting multiple documents, and you want them all to be saved in the same
format and in the same location, check the Apply to All checkbox.
7. Click on Save. If you are saving multiple notes files at once, you will be required to click
on Save for each one.
Notes Document Filenames

By default, the file name of an exported Notes document is named as follows:
<Date>-<Session Name>.eln
where
<Date> is the date the notes were taken and <Session Name> is the name of the session for
which the notes were taken. The format of the date is determined by your system preferences.
However, you can name an exported document whatever you like.
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Note: If you change the name of a Notes document during export, and
import the renamed document back into Blackboard Collaborate, the
name within the Notes Documents list will be the same as it
was before export – it will be listed using the name and date of the
session for which the notes were taken.

Importing Notes Documents

Imported Notes document behave the same way as notes that were created locally. They can be
viewed, edited, deleted and reorganized just like local Notes documents.
You can import Notes documents in two ways:
o

Through the Collaboration Toolbar. (For details, see Loading Content through the Collaboration Toolbar .)

o

Through the Notes window.

To import Notes documents through the Notes window, follow the steps below:

1. Click on the

Import Notes button at the top of the Notes window. The Open file

dialog will open.
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Note: Only .eln files can be
imported as only they contain
the information required by
Blackboard Collaborate – such
as time stamps and formatting
information.

2. Select the document(s) you wish to import.

3. Click on Open. The imported Notes document(s) will appear in the Notes Documents list.
(If the Notes Documents list was previously closed, it will be opened to display your
imported Notes document.)
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If you import notes from someone else for a
session for which you already have your
own notes, or if you import more than one
set of notes for the same session,
Blackboard Collaborate will distinguish the
Notes documents by appending the authors’
names to the session name (as in the
example to the right).
Note: Imported Notes
documents are copied to the
Notes storage directory.
Therefore, the original notes
files you imported are no longer
required and, if you like, you can
delete them.

Deleting Notes Documents
When you delete a Notes document, it is removed from the Notes Documents list and deleted
from the Notes storage directory.
Warning: Be careful when
deleting Notes documents –
deletion is permanent.
To delete Notes documents, follow the steps below:
1. From the Notes Documents list, select the
Notes document(s) you want to delete. (To
select more than one Notes document, select
the first document and hold down Control
(Command on the Mac) as you select the remaining documents.) Click on the

Delete

Notes button. A message dialog will appear, asking you to confirm the delete operation.

2. Click on Yes to complete the deletion.
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Deleting the Notes Document for the Current Session

If you try to delete the Notes document for the current session, it will remain listed in the Notes
Documents list since the current session must always have a Notes document open into which
you can enter notes. However, the contents of the Notes document (the actual notes) will be
deleted. If you do not enter new notes before the session ends, no notes will be saved for the
current session.

Using Compound Notes
Blackboard Collaborate web conferencing lets you view multiple Notes documents
simultaneously by compounding (merging) the documents together as one in the Notes editor. If
you have imported notes written by someone else for the same session, this is a great way to
compare your notes with theirs.
When you have multiple Notes documents for a particular session, they appear as separate items
in the Notes Documents list. The name of each author is appended to the session name.
In the Notes editor, each note is prefaced by the name
of its author. The notes are sorted by time stamps (not
visible to you), just as they are in a single Notes
document.
A compound Notes document behaves like a “normal”
document. You can add, move, edit or delete notes.
The changes you make are saved to their respective
underlying Notes documents. In the example to the
right, if you edited the first note, it would be saved to
Ricky’s Notes document.
When you add new notes, if you are the author of one
of the underlying Notes documents, the new notes
will be added to your Notes document. However, if
you didn’t author any of the underlying documents,
the new notes will be added to the first underlying
document (the first one listed in the Notes Documents
list). In the example to the right, Vivian’s note will be
added to Ricky’s Notes document.
If you want to save the compound notes, you can
merge them into a single document by exporting
them. (See Exporting Notes Documents on page 232.)
Once exported, it can be managed like any other
Notes document (e.g., searched, deleted, compounded
with yet another Notes document, etc.).
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Viewing Notes in Recordings
Notes are tied to events in a session via an internal clock. When viewing a recorded session, the
Notes window automatically moves a marker (arrow) through the notes to point to the notes
that were entered at specific times during the session.
The Notes window does not automatically
open when you begin playing a recording.
You must open it manually (see Opening
and Closing the Notes Window).
If you pause, rewind or forward the
recording, the marker will move in the
Notes document in accordance with the
current time of the recorded session.
If the current note is out of view, the editor
will scroll to it automatically. The arrow
marker is always aligned with the top of the
note. However if the note is significantly
taller than the arrow, a vertical tail will
cover the entire height of the note to make
sure the indicator is always visible.
Note: If no notes were taken
for the recorded session, a new
blank Notes document will be
created, allowing you to enter
notes about the recording.

Editing Notes in a Recording
Other than the arrow marker, there is
basically no difference between notes in a
recording and notes in a live session. Notes
can be edited, inserted and deleted while
you play a recording in the same way as can
be done during a live session. (Refer to
Taking Notes and Working with Notes.)
Just like notes in a live session, they are
automatically saved and any changes will
over-write the original notes file.

238

Notes

When you select a note, and it is the current
note at this point of the recording, the
arrow marker changes from gray to the
highlight color for your operating system.
While you edit the text of a note, the
recorded session continues and the arrow
marker moves to the next notes in the order
they were taken. Subsequently, as the Notes
editor scrolls down, you may lose sight of
the note you are editing.
Tip: Pause the recording to keep
the note you are editing in focus –
displayed within the visible
portion of the Notes editor.
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Chapter 16
Miscellaneous Windows
Besides the basic panels that appear in the Main window (Participants, Chat, Audio & Video and
the main Content area) you may have access to additional windows.
Some of the windows described in this chapter are launched by the Moderator and will appear
in front of the Main window.

The Timer
The Timer is a clock that Moderators can use to effectively manage Blackboard Collaborate
sessions. It can be useful in helping you pace yourself and stay on track with your assignments.
The Timer appears in the Collaboration toolbar, showing the time counting either up or down,
depending on how the Moderator has set the Timer.

Note: This feature is not supported on mobile devices. For a list of
features that are supported, see Attending Sessions on Mobile Devices on
page 23.
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When the Timer has expired, you may be notified by an audible tone and/or visual notification
(such as the one below), depending on how the Timer was configured. Anyone in the session
can turn their own audible and visual notifications off. For details, see Setting Notification
Preferences on page 17.

The Quiz Manager
The Moderator is able to administer multiple choice and short answer quizzes during the session
using the Quiz Manager feature. Quiz results can be published by the Moderator for everyone in
the session to see.
Note: This feature is not supported on mobile devices. For a list of
features that are supported, see Attending Sessions on Mobile Devices on
page 23.

Responding to Quiz Questions
When a Moderator administers a quiz, the Quiz Manager window will appear in front of your
main Blackboard Collaborate web conferencing window, displaying the first question. If the
Moderator set a time limit for the quiz, the time remaining will be displayed in the lower right
corner of the Quiz Manager window.

Answer the quiz questions in the Quiz Manager window.
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1. Select a response for multiple choice questions or enter your answer into the text box provided for short-answer questions.
2. Use the
questions.

arrow buttons or drop-down menu (shown below) to navigate between

3. Once you have completed the quiz, click the

Hand In button.

You will receive a message querying whether you wish to hand your quiz in. The message will
also inform you if you have not answered all of the questions. Click Yes to submit the quiz. Click
No to return to the quiz.

Viewing Quiz Results
Once the quiz has been completed the Moderator may show the results. You will be able to view
each question along with your response and the correct response (identified with a green
checkmark). A summary of the responses from all of the Participants will be displayed
graphically. Use the
arrow buttons or drop-down menu (shown below) to navigate
between questions.
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Multimedia Window
The Multimedia feature enables a Moderator to play a multimedia file or a multimedia URL in
your Blackboard Collaborate session.
Note: This feature is not supported on mobile devices. For a list of
features that are supported, see Attending Sessions on Mobile Devices on
page 23.

Note: The appropriate players must be installed to view these files. The
Multimedia feature will first attempt to play the file in the Multimedia
window and if this is not possible, it will then attempt to open the file up
in your machine’s default media player.
If the Multimedia player window is open on your screen, when the Moderator closes their
Multimedia player window, your window will close on your screen.

The File Transfer Library
The File Transfer Library permits Moderators to upload files into the session in order to share
them with everyone. To open the File Transfer Library, select Show File Transfer Library under
the Window menu.
The File Transfer Library displays a list of all the preloaded files and files currently being loaded
into the library.

Each file or URL displayed in the list contains the following information:
n
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Name of the File — the name of the file is derived from where the file was loaded. If the
file was loaded from a user's file system, then this is the name of the original file. If it was
loaded from a URL, this is the last component of the URL path.
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n

n

n

n

Owner of the File — this is the name of the person who loaded the file. If the file was preloaded by the server, then the owner will be listed as a dashed line (---).
Size – the size of the file and what progress has been made downloading the file to your
machine.
Server — indicates the status of loading the file onto the server. If the file has been fully
loaded onto the server the status will read Complete. If the file is uploading, it will indicate
the status as Loading and the percentage of completion. If the file has not been completely uploaded to the server and the user who was uploading the file has left the session
or been disconnected, the status will read Partial and the percentage of completion.
Progress — the Progress bar is a status indicator showing the progress of loading the file
into the library. It shows a graph with red, orange, yellow, cyan, and green bars, where
red indicates less than half the file is loaded and green indicates it is completely loaded.
Note: If you had saved the file locally, you can find out where by
hovering your mouse over the filename in the library. A tool tip will
display the full path name.

Saving a File
A Moderator may prompt you to save a file. If so, the Save File dialog will appear.

1. Click on Yes. The Save dialog will open.
2. Navigate to the folder to which you wish to save the file and click Save.
You also can save the file without being prompted to do so.
1. Open the File Transfer Library by selecting Show File Transfer Library from the Window
menu.
2. In the File Transfer Library, select the file you would like to save.
3. Click on the

Save button in the toolbar. The Save dialog will open.

4. Navigate to the folder to which you wish to save the file and click Save.
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Closing the File Transfer Library
Closing the File Transfer Library will not affect the files already loaded into the library – it just
closes the window. To close the window, do one of the following:
o

Click on the window’s Close button in the title bar of the window.

o

Enter Ctrl+W (Command-W on Mac)

o

Enter Alt+F4 (Windows and Linux only)

Session Plans
A Moderator may use a session plan to conduct a session and may (or may not) show that plan
to you. A session plan is essentially a session outline that automates various session activities,
helping the Moderator run the session. As a Participant, you cannot interact with the session
plan, only view it, save it or print it – and only if permitted by the Moderator. (Session plans are
created in a standalone desktop application called Blackboard Collaborate Plan.)
Note: Session plans are not supported on mobile devices. For a list of
features supported on mobile devices, see Attending Sessions on Mobile
Devices on page 23.
If a Moderator selects the option to show session plans to Participants, your Session Plan
window will open automatically, displaying the Plan Outline.
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The Plan Outline has the following components:

1 Progress marker

5 Print button

2 Covered indicators

6 Close window button

3 Tool bar

7 Scroll bar

4 Save button

Closing and Reopening the Session Plan Window
To close the window, do one of the following:
o

In the Window menu, unselect Show Session Plan.

o

Enter the keyboard shortcut Ctrl+W (Command-W on Mac).

o

Enter the keyboard shortcut ALT+F4 (no Mac equivalent).

o

Click on the Close Window button in the title bar of the window.

To reopen the window, in the Window menu, select Show Session Plan.
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Printing Session Plans
When you print a session plan, the printout will include only the text that is displayed by the
session plan for Topics, Actions and Text Items, indented appropriately to reflect the Plan
Outline.
1. Open the Print dialog by doing one of the following:
o

From the File menu, select Print and then Session Plan.

o

Enter the keyboard shortcut Ctrl+P (Command-S on Macintosh).
Note: If you have the main Blackboard Collaborate window
in focus (rather than the Session Plan window), when you
enter the keyboard shortcut, you will be presented with a
dialog from which you need to select Session Plan from a list
of printable files (others are Participants list and Whiteboard)

o

Click on the Print button in the Session Plan toolbar.

2. Select your print options and click OK.

Saving Session Plans
Participants can save session plans only as plain text – not as fully functioning session plan files.
The plain text version contains only the text that is displayed by the session plan for Topics,
Actions and Text Items, indented appropriately to reflect the Plan Outline.
Tip: A plain text outline can be useful as a basis for taking class notes.
1. Open the Save Session Plan dialog by doing one of the following:
o

From the File menu, select Save and then Session Plan.

o

Enter the keyboard shortcut Ctrl+S (Command-S on Macintosh).
Note: If you have the main Blackboard Collaborate window
in focus (rather than the Session Plan window), when you
enter the keyboard shortcut, you will be presented with a
dialog from which you need to select Session Plan from a list
of files that can be saved (others are Chat, Participants list
and Whiteboard).

o

Click on the Save button in the Session Plan toolbar.

2. Enter a name for your saved file and click Save.
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Chapter 17
The Graphing Calculator
The Graphing Calculator is a mathematical calculator used to solve mathematical formulae and
represent them as graphs. To display the calculator, select Graphing Calculator from the
Window menu. The calculator is displayed in front of the other windows. Resize or re-position
the Graphing Calculator window as desired.
Note: This feature is not supported on mobile devices. For a list of
features that are supported, see Attending Sessions on Mobile Devices on
page 23.
To display the calculator, select Graphing Calculator from the Window menu. The calculator is
displayed in front of the other windows. Resize or re-position the Graphing Calculator window
as desired.
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1 Y-axis
2 X-axis
3 Select point button
4 Shift view area button
5 Zoom out button
6 Zoom in button
7 Function boxes
8 Set display region boxes
9 Minimum X value
10 Maximum X value
11 Minimum Y value
12 Maximum Y value
13 History menu
14 Evaluate buttons
15 Restore defaults button
16 Privacy menu
17 Grid spacing menu

Opening and Closing Graphing Calculator Window
To open the window, in the Window menu, select Graphing Calculator.
Closing the Graphing Calculator window will not affect any of the work you have already done –
it just closes the window. To close the window, do one of the following:
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o

Click on the window’s Close button in the title bar of the window.

o

Enter Ctrl+W (Command-W on Mac)

o

Enter Alt+F4 (Windows and Linux only)

The Graphing Calculator

Private and Shared Calculators
The Graphing Calculator feature supplies everyone with two calculators: a private and a shared
calculator.
Anyone can open and use their private calculator, which is visible only to them. Participants do
not need any permissions to use the private calculator, however, they can access it only if the
Follow Moderator option is turned off (which it is by default).
The shared calculator resides on the Moderator’s application. Only Moderators can use the
shared calculator. No permission is required to view the shared calculator.
Both Graphing Calculators function identically.

Switching between the Private and Shared Graphing Calculator
You can switch back and forth between calculators when 1) the Follow Moderator option is
turned off and 2) you have been granted the calculator permission by the Moderator (so you can
access the shared calculator). To switch between the two calculators, select Shared or Private
from the drop down menu in the Graphing Calculator window.
The information on your private calculator does not change or get deleted
when you switch between private and shared calculators.

Using the Shared Graphing Calculator
If the Moderator selected the Follow Moderator option for the calculator, your shared
calculator displays exactly what the Moderator has displayed on his or her shared calculator. You
may use the shared calculator only if the Moderator has given you permission. You will not be
able to close or switch to your private calculator when the Moderator has Follow Moderator
selected.
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Graphing Functions Using the Calculator
You can enter only explicit functions in the Graphing Calculator. The calculator allows you to
plot two functions on the same grid. If your function contains a variable, it must be represented
by an x.
1. Type your function in the Function box and
press Enter to graph it.
2. Optionally, you can enter a second function in
the second function box. Your first function is
graphed in blue, the second in red.

Entering Mathematical Operators and
Functions
The following table lists the allowable mathematical
operators.
Type

To perform this operation…

+

Add

-

Subtract

*

Multiply

/

Divide

^

Exponent

()

Parenthesis (to indicate order of
operation)
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Use the following abbreviations for these functions and numbers.
Type

To represent this function or number…

sqrt

Square Root

abs

Absolute Value

log

Logarithm (base 10)

ln

Natural Logarithm

sin

Sine

cos

Cosine

tan

Tangent

csc

Cosecant

sec

Secant

cot

Cotangent

asin

Arcsine

acos

Arccosine

atan

Arctangent

pi

pi

e

e
Note: Trigonometric functions are graphed in radians.
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Displaying the Function History
Both function entry fields maintain a history of the ten most recent functions that you graphed.
When you exit the session, all the functions are erased.
Click the drop down arrow button next to the function field to display the history of graphed
functions for that field.

Evaluating Functions
1. Enter a value or expression for X in the Y= text box.

2. Click the

button to evaluate Y for the given value of X. The Solve Function dialog

box appears.

3. Select the option Mark the resulting point on the graph if you want the coordinates of the
result plotted on your graph.
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4. Click OK to accept your changes and dismiss the dialog box. Your result is displayed in the
Solve Function information box.

5. Click OK to dismiss the information box and view the coordinates on your graph. The
coordinates are displayed and plotted on the graph. You can zoom out or move the display
region to view the plotted coordinates on your graph.

Selecting and Displaying Points on the Graph
Select the

button on the calculator and then click a point on the grid. The point is identified

with a green X and the x- and y-coordinates for the point are displayed to four decimal places.

To display an x- or y-intercept or a point of intersection

1. Select the

button on the calculator.

2. Drag a selection box over a region that contains an x- or y-intercept or a point of intersection of two functions to display the coordinates for a point.

If you select a region that has more than one point of interest, the point will be identified in the
following order of preference:
1. Point of intersection
2. x-intercept
3. y-intercept
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If you select a region that has more than one point of equal priority, only the point with the
lowest x-value will be plotted. Alternatively, you can re-select a region with only one point of
interest.
Note: The calculator displays the coordinates of only one point at a time.

Changing the Calculator Display Region
Setting the Display Region and Grid Spacing
The display region of the graph is defined by the X range and Y range values. The Grid Spacing
draws visible lines that correspond to tick points on the x- and y-axis. By default, the display
region is set at –5 to 5 for the X range, –5 to 5 for the Y range and the Grid Spacing is set to 1.
To display a different region of the graph, enter values for the X range and Y range and set the
Grid Spacing.

Zooming In and Out
To zoom in, click the

button and then click the region of the graph you want to zoom in on.

You can zoom in as many times as you need until you see the level of detail that you require.
To zoom out, click the

button and then click the display region. Click the display region

again to zoom out to see more of the display.
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Moving the Graph in the Display Region
Click the

button and then click and drag the display region to move the graph with your

mouse.

You can also re-position the display region by selecting the options on the Restore Defaults
menu:

l

l

Center Graph: This option is dependent on your current X and Y range and centers the
graph in the display region based on those values. If you had changed the grid size, this
option will not restore the grid defaults.
Default Graph Area: Centers the graph and resets the maximum and minimum Display
Region values back to the defaults (-5, 5 for both X and Y axes). If you had changed the
grid size, this option will not restore the grid defaults.
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Chapter 18
Glossary
The important terms used in this guide are defined in the table below.
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Term

Meaning

Action bar

A secondary toolbar containing user actions and navigation controls
specific to the feature currently being used. The Whiteboard, Application Sharing and Web Tour each have their own unique action
bars.

Activity indicators

The Participants list presents information about user activity
through activity indicators. These indicators display information
about what feature a user is currently using, show if a user is using
the Audio Setup Wizard or indicate if a user has stepped away from
the session.

Activity Window

The Activity Window is an accessibility feature of Blackboard Collaborate web conferencing that can be useful to both hard of hearing/deaf and low vision/blind users. It is a stand-alone window that
reports various events that take place in Blackboard Collaborate
throughout the duration of a session. The window has a simple
design so you can use a screen reader to navigate through the user
interface and read the events as they occur. The Activity Window
also enables you to perform simple functions through a command
line interface.

Application Sharing

Application Sharing enables session participants to share their applications or entire desktops with others in the session. Application
Sharing is a type of content that, like the Whiteboard and Web
Tour, appears in the Content area.

Audible notifications

Audible notifications are system messages sent by Blackboard Collaborate web conferencing to notify users when certain important
events occur within the session. These notifications are presented as
sounds.

Audio & Video panel

The Audio & Video panel enables you to participate in conversations
using either a microphone and speakers (or headset) or via a teleconference. You also can transmit and receive Video during the session and preview your video before transmitting it.

Audio Setup Wizard

The Audio Setup Wizard is a tool you can use to verify that your
Audio is set up correctly. It is comprised of a series of panels that
guide you through selecting Audio input (microphone) and output
(speaker) devices and setting your speaker and microphone volumes.
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Term

Meaning

Breakout rooms

To facilitate small group collaboration, a Moderator can create
rooms separate from the Blackboard Collaborate Main room and
place session attendees into these "breakout" rooms. Breakout
rooms have their own private Audio, Video, Whiteboard, Application Sharing, etc., so the collaboration that takes place in a breakout room is independent of the Main room (and other breakout
rooms).

Chat panel

The Chat panel enables you to send Chat messages to everyone in
the room or to Moderators only. By selecting names in the Participants list, you can send private Chat messages to individuals. Messages can be printed and saved to track session communication.

Clip Art library

The Clip Art library is a set of collections of images and symbols
(such as background images, mathematical operators and Greek
letters) that can be added to your Whiteboard pages. You can create
your own collections and add them to the library and remove existing collections.

Closed Captioning

Closed-Captioning is an accessibility feature of Blackboard Collaborate that enables session attendees to transcribe audio information for deaf and hard of hearing attendees while a session is in
progress. The transcribed text can be viewed by other session attendees in the live session and in a recording of the session. It can also
be saved to a text file.

Collaboration toolbar

The Collaboration toolbar (at the top of the Content area) contains
three buttons for switching between the three content modes
(Whiteboard, Application Sharing and Web Tour) in the Content
area; an Information menu for obtaining session information (e.g.,
connection type) and starting the Timer; a Load Content button for
loading content into the session; and the Record button.

Compound Notes

Blackboard Collaborate web conferencing lets you view multiple
Notes documents simultaneously by compounding (merging) the
documents together as one in the Notes editor. If you have imported
notes written by someone else for the same session, this is a great
way to compare your notes with theirs.

Content area

The Content area is the large area on the right side of your Blackboard Collaborate window. It enables you to exchange information
and ideas with others through three different content modes: 1) the
Whiteboard, for sharing presentations and drawings; 2) Application
Sharing, for sharing individual applications or your entire desktop;
and 3) Web Tour, for sharing web pages.

Content modes

See Content area.
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Term

Meaning

Conversation pane

The area in the Chat panel that displays the chat messages.

Conversation tabs

When chatting in Blackboard Collaborate, you can participate in
more than one Chat conversation at a time. These conversations
take place in conversation tabs at the bottom of the Chat panel.

Echo

Echoes occur in Audio transmissions when the sound from your
speakers is being picked up by your microphone and retransmitted
back into the session. People then hear again what has just come
out your speaker, giving an echoing effect.

Elevated Privileges

If you are using Windows 7, Vista or Windows 8, any actions taken
in a shared application that bring up User Account Control (UAC)
security dialogs will cause Application Sharing to terminate. By
requesting Elevated Privileges in Blackboard Collaborate, you will be
able to circumvent the UAC dialogs and host your Application Sharing session, or remotely control another's session or desktop, without incident.

Emoticon menu

A menu in the Chat panel from which you can select emoticons to
include in your chat messages.

Event messages

Information displayed in the Chat conversation pane about who has
entered or left the Main room and breakout rooms.

Filtered Keys

When you allow others to remotely control your Application Sharing session, there are some keystrokes that you may not want them
to be able to enter on your computer. For example, Windows users
probably don't want remote controllers to issue the Ctrl+Alt+Delete
command, which can be used to lock or log out of your computer.
To protect your computer, prevent a remote controller's keystrokes
from reaching your computer by adding them to the Filtered Keys
list in the Preferences dialog.

Follow Me option

Follow Me is an option in Web Tour. With Follow Me selected, session attendees will be able to freely browse to other pages in the
Web Tour, independent of the pages to which you, the tour guide,
browses. However, when you move to a new page, they will be redirected to your new page.

Frame rate

The frame rate is the number of video frames per second being
transmitted or received. The default rate is 10 frames per second.
The higher the frame rate, the higher the bandwidth being used.

Graphing Calculator

The Graphing Calculator is a mathematical calculator used to solve
mathematical formulae and represent them as graphs.
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Host (Application Sharing)

The host is the person who initiated the Application Sharing session
(i.e., the person whose application or desktop is being shared).

Host (Web Tour)

The host is the person who initiated the Web Tour.

Hot keys

Hot keys are a type of keyboard shortcut but differ from standard
keyboard shortcuts in two ways: 1) you can modify the definition of
these keys and 2) you do not need to have input focus on the Blackboard Collaborate web conferencing window to use them (they are
available system-wide).

Information menu

A menu in the Collaboration toolbar that provides information on
connection speed, signal strength, encryption and session time. It
also gives you access to the Timer dialog.

In-Session Invitation

The In-Session Invitation feature enables Moderators, from within a
live session, to invite people into the session by sending them an
email invitation containing a link they can use to join the session.
This feature is enabled or disabled by the session creator, so may not
be available in all sessions.

Interactive Recordings

While watching a recording of a Blackboard Collaborate web conferencing session, you may have opportunities to interact with the
recording. You may receive a file from the session Moderator
through the File Transfer facility, be prompted to take a Quiz, or be
able to navigate to web pages in Web Tour.

Invitee

Anyone invited to the session (both Moderators and Participants).

Keyboard shortcuts

Keyboard shortcuts are one or more keys you press in combination
to perform a function within Blackboard Collaborate web conferencing.

Message text box

The area in the Chat panel in which you enter your chat messages.

Microphone level indicator

The microphone level indicator, above the Talk button in the Audio
& Video panel, shows the volume levels when you are speaking. You
can move the slider on the indicator to adjust the volume.

Mnemonic

A mnemonic is an underlined letter or number that appears in a
menu title or menu option that, when pressed in conjunction with
the ALT key, activates a command or navigates to an element in the
user interface.
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Term

Meaning

Mobile device indicators Mobile device indicators are icons next to a session attendees'
names in the Participants list that indicate the attendees have joined
the session from mobile devices. The
phone icon indicates someone is using a mobile phone and the tablet icon indicates someone is using a tablet.
Moderator

Moderators have access to all Blackboard Collaborate features,
including the ability to grant Moderator status to Participants. The
person conducting a session, such as a teacher, is a Moderator. (See
note above this table.)

Navigation bar

The Whiteboard Navigation bar is a toolbar containing controls that
enable you to move between rooms and pages within those rooms.
It is located in the upper right corner of the Content area whenever
the Page Explorer is not open.
Note: You can use this feature only if you
have been granted the page navigation
permission by the Moderator.

New message indicator

A bubble displayed in the conversation tab of the Chat panel, indicating that a new message has arrived in that conversation.

Notes

The Notes window lets you easily take personal notes during a live
Blackboard Collaborate web conferencing session, edit them and
later share them with others. (During the session, only you will see
your own notes.) As you write notes about what is being presented
in a session, Blackboard Collaborate synchronizes the notes to the
session timeline. This is very useful when reviewing recorded sessions later

Object Explorer

The Object Explorer is a window that lists all the objects on your current Whiteboard page, enabling you to easily take an inventory of
the objects and perform operations on them.

Object Properties dialog

The Object Properties dialog lets you edit all Whiteboard object properties, including some not commonly used, and not available in the
Properties Editor palette.

Options menu

Most of the main modules in the interface have their own
Options menus to give you quick access to commands specific to
those modules. (These commands also can be found in the main
menus.)
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Page Explorer

The Page Explorer is a window that lists all your Whiteboard pages
and enables you to easily navigate through and manage the pages.

Panel

A panel is a distinct area in the user interface. Panels can be collapsed, expanded, detached and reattached, resized and, in their
detached state, can be moved. The side panels (Audio & Video, Participants and Chat) also can be hidden.

Participant

Participants have restricted access to Blackboard Collaborate features. Students are typically Participants, although Moderators can
grant Participants Moderator status. (See note above this table.)

Participant interaction
drop-down menus

There are two drop-down menus in the Participants panel that enable you to enter your feedback and responses in the Participants
list: the Feedback menu containing emoticons (see Entering Feedback on page 55) and the Polling Response menu (seePolling on
page 58).

Participants list

The area in the Participants panel that displays a list of all session
attendees and information about their profile, permissions and current activity.

Participants panel

The Participants panel provides a list of all Participants and Moderators in the session and information about their current activities,
such as talking (Audio), transmitting Video, sending a Chat message,
using the Whiteboard drawing tools and conducting an Application
Sharing session. Above the Participants list is a small toolbar containing buttons for raising your hand and stepping away from the
session and menus for selecting polling responses and feedback
options.

Permissions

A permission gives a person the ability to use a feature in
Blackboard Collaborate. Global permissions can be used to quickly
change the permissions of all Participants in the session, including
those in breakout rooms. By default, all Participants have
permission to use all features except Application Sharing, Web Tour
and Closed Captioning. (Moderators have permission to use all
features.)
A Moderator can change the Individual permissions of Participants
so their permissions vary from the global permissions.

PIN

Glossary

Personal Identification Number that may need to be entered by
people joining a teleconference.
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Meaning

Polling

A way for Moderators to elicit responses from session attendees
who select their responses to questions from the Polling Response
menu in the Participants panel. When the Moderator selects a different type of poll (e.g., Yes/No or multiple choice), the available
response buttons will change accordingly.

Primary Video display

The display area in the Audio & Video panel that typically (by
default) displays the video transmission or profile picture (or avatar)
of the person currently speaking or, if no one is speaking, the last
person who spoke.

Private Chat messages

You can send private Chat messages to a specific person or group of
people by selecting their names in the Participants list. These messages will appear to only yourself and those you selected from the
Participants list. There is one notable exception: when a session is
supervised, Moderators will be able to see the private messages of
everyone.

Properties Editor palette When you click on any of the text or drawing tools in the Whiteboard's Tools palette, the Properties Editor palette will appear at the
bottom of the Whiteboard. From here you can format your text or
graphic by specifying various properties. The contents of the Properties Editor palette changes depending on which tool is being used
or which objects are selected.
Quiz Manager

The Moderator is able to administer multiple choice and short
answer quizzes during the session using the Quiz Manager feature.
Quiz results can be published by the Moderator for everyone in the
session to see.

Remote Control

Application Sharing hosts can let others in the session remotely control their (the host's) shared applications or desktops. When
remotely controlling another's application or desktop, you can move
the mouse cursor, click, and type. The host of the application share
also retains control at all times, and can revoke control from the
remote controller at any time.

Session

An online meeting conducted in Blackboard Collaborate web conferencing. (See note above this table.)

Session attendee

Anyone attending the session (both Moderators and Participants).
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Session plan

A Moderator may use a session plan to conduct a session and may
(or may not) show that plan to you. A session plan is essentially a
session outline that automates various session activities, helping the
Moderator run the session. As a Participant, you cannot interact
with the session plan, only view it, save it or print it – and only if
permitted by the Moderator.

Simulated Keystrokes

Simulated keystrokes can be sent to an Application Sharing host's
system when remote controlling it from a computer running a different operating system. For example, you may want to remotely
control a Mac from your Windows system. Since Windows does not
have a Command key, you can simulate Mac accelerator keys, such
as Command-C, by defining them using the Simulated Keys list in
the Preferences dialog.

Simultaneous cameras

The Moderator can enable multiple people (up to six) to transmit
video simultaneously in each room (Main and breakout): one transmission is displayed in the primary Video display and up to five are
displayed in thumbnails below it.

Simultaneous talkers

The Moderator can enable multiple people (up to six) in each room
(Main and breakout) to have their Talk buttons on at once. This feature lets people converse more naturally, without having to turn
their Talk buttons on and off.

Speaker level indicator

The speaker level indicator, above the Video button in the Audio &
Video panel, shows the volume levels when someone else is speaking. You can move the slider on the indicator to adjust the volume.

Status indicators

Status indicators are amber and red lights that appear on the activity
indicators in the Participants list when there is a delay in the
sending and/or receipt of Audio, Video and Application Sharing
data. An amber status indicator denotes a moderate delay whereas a
red status indicator denotes a significant delay.

Telephony

The Telephony feature of Blackboard Collaborate web conferencing
enables you to conduct your audio communications with other session attendees via teleconferencing, while continuing to use your
computer for all other Blackboard Collaborate features.

Timer

The Timer is a clock that Moderators can use to effectively manage
Blackboard Collaborate sessions. It can be useful in helping you pace
yourself and stay on track with your assignments. The Timer
appears in the Collaboration toolbar, showing the time counting
either up or down, depending on how the Moderator has set the
Timer.
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Tools palette

The Tools palette contains drawing and text tools you can use to
create and manipulate objects in the Whiteboard workspace. It also
has a pointer tool, a tool to place screen captures on the Whiteboard
and a clip art tool to add images from available clip art libraries.

User profile

A user profile is a means by which session attendees can share information about themselves with others in the session: their profile picture or avatar, name, title, contact information, etc. To view
someone's profile, hover your mouse over their name in the Participants list.

Video broadcast

A video broadcast is video you send live via a video camera (e.g., web
cam) – not to be confused with a pre-recorded video (movie) that
Moderators can play using the Multimedia feature.

Video thumbnails

When there is more than one simultaneous camera enabled, the
video stream of one person will appear in the primary video display.
Everyone else's transmission will appear below the primary display
in thumbnails, up to a maximum of five thumbnails.

Visual notifications

Visual notifications are system messages sent by Blackboard Collaborate web conferencing to alert users when certain important
events occur within a session. These notifications are presented in a
floating window.

Web Push

A Web Push is a type of Web Tour in which the specified web page
opens up in the default web browser of each session attendee
(including the host's) – outside of the Blackboard Collaborate application. Session attendees will see the web page to which they are initially directed (pushed) and after that are free to browse to other
pages, work with bookmarks, close the window, etc.

Web Tour

The Web Tour feature enables session participants to share web
pages with others in the session. Web Tour is a type of content that,
like the Whiteboard and Application Sharing, appears in the Content area.

Whiteboard

The Whiteboard is the most commonly used (and default) mode of
the Blackboard Collaborate web conferencing Content area. It is
used for giving presentations (e.g., PowerPoint slides) and for collaboration between session attendees, who can interact by displaying images, writing, or drawing.

Window

A window is a self-contained box in the user interface. The main
application window can be minimized, maximized, moved, resized
and closed. Other windows can be opened, moved, resized and
closed.
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Appendix A:
Chat Emoticon Text Strings
The following table shows the text strings that can be used to enter emoticons. The emoticon
text strings are not case sensitive, so you can use either upper case or lower case letters to enter
your emoticons.
Emotions

Icons

Text strings

Smiley

:) or :-)

Wink

;) or ;-)

Sad

:( or :-(

Eye roll

(re)

Cool (shades)

B) or B-)

Tongue (sticking
out)

:P or :-P

Surprised

:O or :-O

Crying

:'(

Confused

:/ or :-/
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Icons

Text strings

Grin

:D or :-D

Angry

:@ or :-@

Evil grin

(6)

Kiss (lips)

:* or :-*

Heart

<3

Broken heart

</3

Lightening

(shazam)

Report

(p)

Email (envelope)

(e)

Open book

(s)

Book

(ns)

Chart

(#)

Clock

(+)

Coffee

(c)

Birthday cake

(hb)

Telephone

(t)

Television

(tv)

Music (notes)

(m)

Computer

(01)

iPod

(i)

Game (controller)

(g)

Webcam

(w)

Bat

:[

Man

(z)

Woman

(x)

Group (of people)

(f)

Chat Emoticon Text Strings

Emotions

Icons

Text strings

Credit card

(cc)

Money (dollar bill)

($)

Alert (caution sign)

(!)

Eye

(eye)

Car

(a)

Male (symbol)

(xy)

Female (symbol)

(xx)

Soccer ball

(1)

Football

(2)

Basketball

(3)

8 Ball

(8)

House

(h)

Sleep (ZZZs)

(zz)

Thumbs down

(n)

Thumbs up

(y)

Sun

(su)

Cloud

(ts)

Rain

(rn)

Snow

(sn)

Rainbow

(r)

Star

(*)

Chat Emoticon Text Strings
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20
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0

@

P

`

p

€

032

048

064

080

096

0112

0128

!

1

A

Q

a

q

033

049

065

081

097

0113

“

2

B

R

b

034

050

066

082

#

3

C

035

051

$

0

1

2

3

4

5

6

90

A0

B0

C0

D0

E0

F0

°

À

Ð

à

ð

0144

0160

0176

0192

0208

0224

0240

‘

¡

±

Á

Ñ

á

ñ

0129

0145

0161

0177

0193

0209

0225

0241

r

‘

‘

¢

²

Â

Ò

â

ò

098

0114

0130

0146

0162

0178

0194

0210

0226

0242

S

c

s

ƒ

“

£

³

Ã

Ó

ã

ó

067

083

099

0115

0131

0147

0163

0179

0195

0211

0227

0243

4

D

T

d

t

„

”

¤

´

Ä

Ô

ä

ô

036

052

068

084

0100

0116

0132

0148

0164

0180

0196

0212

0228

0244

%

5

E

U

e

u

…

•

¥

µ

Å

Õ

å

õ

037

053

069

085

0101

0117

0133

0149

0165

0181

0197

0213

0229

0245

&

6

F

V

f

v

†

–

¦

¶

Æ

Ö

æ

ö

038

054

070

086

0102

0118

0134

0150

0166

0182

0198

0214

0230

0246
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7

8

9

20

30

40

50

60

70

80

90

A0

B0

C0

D0

E0

F0

‘

7

G

W

g

w

‡

—

§

·

Ç

×

ç

÷

039

055

071

087

0103

0119

0135

0151

0167

0183

0199

0215

0231

0247

(

8

H

X

h

x

ˆ

˜

¨

¸

È

Ø

è

ø

040

056

072

088

0104

0120

0136

0152

0168

0184

0200

0216

0232

0248

)

9

I

Y

i

y

‰

™

©

¹

É

Ù

é

ù

041

057

073

089

0105

0121

0137

0153

0169

0185

0201

0217

0233

0249

:

J

Z

j

z

Š

š

ª

º

Ê

Ú

ê

ú

058

074

090

0106

0122

0138

0154

0170

0186

0202

0218

0234

0250

;

K

[

k

{

‹

›

«

»

Ë

Û

ë

û

0107

0123

0139

0155

0171

0187

0203

0219

0235

0251

l

|

Œ

œ

¬

¼

Ì

Ü

ì

ü

0140

0156

0172

0188

0204

0220

0236

0252

-

½

Í

Ý

í

ý

A *
042

B +

043 059 075 091
C ,
044

D 045

E .
046

F /
047
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<

L

\

060

076

092 0108

0124

=

M

]

m

}

061

077

093

0109

0125

0141

0157

0173

0189

0205

0221

0237

0253

>

N

^

n

~

Ž

ž

®

¾

Î

Þ

î

þ

062

078

094

0110

0126

0142

0158

0174

0190

0206

0222

0238

0254

?

O

_

o

Ÿ

¯

¿

Ï

ß

ï

ÿ

063

079

095

0111

0159

0175

0191

0207

0223

0239

0255

0127

0143
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